Information and Communication Technology

for Rwandan Schools

Secondary 1

Students’ Book
# Contents

## Unit 1: Information and Communication Technology Foundation

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Key Unit Competency</td>
<td>1</td>
</tr>
<tr>
<td>Keywords in the Unit</td>
<td>1</td>
</tr>
<tr>
<td>1.1 Definition of Data</td>
<td>1</td>
</tr>
<tr>
<td>1.1.1 Types of data</td>
<td>1</td>
</tr>
<tr>
<td>1.1.2 Data gathering</td>
<td>3</td>
</tr>
<tr>
<td>1.2 Information</td>
<td>3</td>
</tr>
<tr>
<td>1.2.1 Factors affecting the quality of information</td>
<td>3</td>
</tr>
<tr>
<td>1.3.1. Elements of Communication</td>
<td>4</td>
</tr>
<tr>
<td>Types /Ways of Communicating</td>
<td>5</td>
</tr>
<tr>
<td>1.4 Technology</td>
<td>6</td>
</tr>
<tr>
<td>1.4.1 Types of Technology</td>
<td>6</td>
</tr>
<tr>
<td>1.5 ICT (Information and Communication Technology)</td>
<td>8</td>
</tr>
<tr>
<td>1.5.1 Definition of ICT</td>
<td>8</td>
</tr>
<tr>
<td>1.5.2 ICT Equipment, Its use, and Interaction</td>
<td>8</td>
</tr>
<tr>
<td>1.6 Importance of ICT</td>
<td>14</td>
</tr>
<tr>
<td>1.6.1 General Use of ICT</td>
<td>14</td>
</tr>
<tr>
<td>1.6.2 Advantages and Disadvantages of ICT</td>
<td>17</td>
</tr>
<tr>
<td>1.6.3 Current use of ICT in Rwanda</td>
<td>18</td>
</tr>
</tbody>
</table>

Revision Exercise 1 .......................................................... 21

## Unit 2: Computer Systems

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Key Unit Competency</td>
<td>22</td>
</tr>
<tr>
<td>Keywords in the Unit</td>
<td>22</td>
</tr>
<tr>
<td>2.1 Definition of a Computer</td>
<td>22</td>
</tr>
<tr>
<td>2.1.1 Definition of a Computer</td>
<td>22</td>
</tr>
<tr>
<td>2.1.2 Functions of Computers</td>
<td>22</td>
</tr>
<tr>
<td>2.1.3 Characteristics of a Computer</td>
<td>23</td>
</tr>
<tr>
<td>2.2 Computer Components</td>
<td>24</td>
</tr>
<tr>
<td>2.2.1 Hardware</td>
<td>24</td>
</tr>
<tr>
<td>2.2.2 Software</td>
<td>50</td>
</tr>
</tbody>
</table>
2.3 Computer Family .................................................................52
2.4 History (Evolution) of Computers ............................................55
2.5 Generations of Computers .....................................................57
2.6 Advantages and Disadvantages of Computers .........................62
2.7 Areas Where Computers are used ..........................................62
Revision Exercise 2 ....................................................................68

Unit 3: Computer Navigation

Key Unit Competencies ....................................................................70
Keywords in the Unit ........................................................................70
3.1 Desktop .....................................................................................70
3.1.1 Definitions .............................................................................70
3.1.2 Explore and customise the start menu .....................................74
3.1.3 Recycle bin ............................................................................75
3.2 The Control Panel ......................................................................77
3.2.1 Desktop Background & Theme, Window colour and Screen saver 78
3.2.2 Mouse pointer .........................................................................79
3.2.3 Desktop Icons and Gadgets .....................................................79
3.2.4 Screen Resolution .....................................................................81
3.2.5 Changing Date and Time ........................................................81
3.2.6 Keyboard Layout .....................................................................82
3.3 Windows ...................................................................................83
3.3.1 Definition ...............................................................................83
3.3.2 Types of windows ....................................................................83
3.3.3 Window control buttons .........................................................83
3.3.4 Common Windows Accessories ..............................................83
3.3.4 Files and Folders .....................................................................85
Revision Exercise 3 .........................................................................93

Unit 4: Safe, Secure and Ethical Use of Computers

Key Unit Competency .......................................................................94
Keywords in the Unit .......................................................................94
4.1 Safe Lab Procedure ....................................................................94
4.1.1 Safety Precautions and Practices in a Computer Laboratory .... 94
4.2 Proper use of cleaning tools and fire extinguishers ............................................97
4.3 Maintaining your Computer ..................................................................................99
Revision Exercise 4..................................................................................................101

Unit 5: Word Processing Basics I

Key Unit Competency ..................................................................................................102
Key words in the Unit.....................................................................................................102
5.1 Word Processing ........................................................................................................102
  5.1.1 Introduction ........................................................................................................102
  5.1.2 Definition of word processing application ..........................................................102
  5.1.3 Role of word processing applications .................................................................102
  5.1.4 Starting word processing applications .................................................................102
5.2 Word Processing Environment ................................................................................103
5.3 Working with Documents .........................................................................................107
5.4 Text Selection ..........................................................................................................110
5.5 Basic Text Formatting ..............................................................................................111
Proofing Features .........................................................................................................122
Revision Exercise 5.....................................................................................................130

Unit 6: Word Processing Basics II

Key Competencies .........................................................................................................131
Key words in the Unit .....................................................................................................131
6.1 Manipulating a document .........................................................................................131
  6.1.1 Page Setup Group ..............................................................................................131
6.2 Proofing features ......................................................................................................137
6.3 Columns and Breaks ...............................................................................................141
6.4 Formatting Text .........................................................................................................145
  6.4.1 Styles ..................................................................................................................145
  6.4.2 Nested lists .........................................................................................................147
  6.4.3 Drop caps ..........................................................................................................149
  6.4.4 Headers and footers ...........................................................................................150
Revision Exercise 6.....................................................................................................151
Unit 7: GIS and Maps

Key Unit Competencies
Keywords in the Unit
7.1 Components of ArcGIS
7.2 Defining Terms and Concepts of GIS
7.2.1 Different Kinds of Vector Data
7.3 The Interface of ArcMap
7.3.1 Table of Contents (TOC)
7.3.2 The Menu Bar
7.4 Navigation Tools
7.4.1 The Basic Toolbar
7.4.2 Query Methods
Revision Exercise 7

Unit 8: Network and Internet Fundamentals

Key Unit Competency
Keywords in the Unit
8.1 Computer Network Concepts
8.1.1 Definition of Network
8.1.2 Definition of Computer Network
8.1.3 Characteristics of a Computer Network
8.1.4 Role of a Computer Network
8.1.5 Advantages and Disadvantages of a Computer Network
8.1.6 Classification of computer network by geographical areas
8.2 Internet Concepts
8.2.1 Definitions
8.3 History of the Internet
8.3.1 Development of the Internet
8.3.2 Internet Uses in Daily life
8.3.3 Methods/Ways of connecting to the Internet
8.3.4 Getting online
8.4 Search Engines
8.4.1 Definition of Search Engine
8.4.2 Advantages and Disadvantages of Search Engines
Introduction

*In this age of Technology, Information is Power! Stay Safe!*

**What is Peer Pressure?**

- Now that you have joined Senior One, it will be natural to want to be part of a group of friends. You will also want to feel that your friends appreciate you.
- Peer pressure is when friends persuade you to do something that you would not want to do.
- In other cases, they may make you do something that you would want to do; you may lack the courage to say NO.

**How will peer Pressure affect you?**

- Peer pressure will compel you to change your attitude, behaviour, and morals in order to fit in the group of friends that you have.
- There is good and bad peer pressure.
- Good Peer pressure will make you grow. It will challenge or motivate you to do your best in school.
- Bad peer pressure will make you do things that may have negative effects on your health, and your academic performance. Peer pressure will affect your taste of fashion, and your ability to make responsible choices in life. Do not be pressured to use alcohol, cigarettes, and other harmful drugs. Do not be pressured to get into relationships that you may not be ready for.

**What can you do about peer pressure?**

- You have a whole future ahead of you. You aspire to join a certain career when you complete college. The chances of your
dream becoming a reality will be affected by the decisions you will make today.
You must, therefore, take charge of your life. You must take responsibility for
what you do and how you think. You must choose to resist bad peer pressure. It
will not be easy, but you can do it.

• To deal with bad peer pressure you must be prepared to say “NO!” to some friends.
If you let them manage your life, they may
not have your best interests at heart.
• Suppose one of your friends were to
offer you a cigarette. This is the time
to stand up for yourself. You must say,
“No, that is a cancer stick, and I do not
wish to die young.” If this friend keeps
asking you to take a puff, this is when you
must give yourself a talk. You may whisper
to yourself, “I make a decision today not
to ever try a cigarette, or any other harmful
drug for that matter. I truly know that the
decision I have made is the perfect one for
me.” You should then be able to tell your
“friend, the cigarette slave” exactly what
you have decided. Believe it, they will
respect you for standing up for yourself
and not giving in. This may sound easier
said than done, doesn’t it? It will take a great amount of will power and ability to
love and respect yourself to stand by your grounds.
• Information is Power! Search for information that will help you make informed and
wise decisions. Arm yourself with wisdom and knowledge and some decision-
making skills. In this way, you will be able to live your own life successfully.
• Know your friends and “friends”. Deciding who to listen to and who to avoid is the
biggest favour you can do to yourself. It will help you to resist unwanted negative
peer pressure. Remember, You must live your life. No one else can do that for
you. It is your life; build or break it. It is your full responsibility to determine
what you want in life!
Key Unit Competency

By the end of this unit, you should be able to explain the foundation of Information and Communication Technology (ICT).

Keywords in the Unit

- Hardware
- e-Business
- Analog Data
- Software
- Telecommuting
- Distance Learning
- Data gathering
- Signals
- Digital data

1.1 Definition of Data

Data can be defined as raw facts that have been entered into a computer but have not been processed. It refers to statistics, symbols, basic facts, figures, numbers or simply records. Note that the term data is the plural form of datum. However in modern usage, the term data is used both as a singular and plural term. Examples of data include:

- Number of students in a class
- Number of ICT textbooks for Senior One ordered by a school
- Number of computers in a school computer laboratory

1.1.1 Types of data

Two main types of data in a computer are:

(i) **Analog data** is that which is in continuous form.

(ii) **Digital data** is data which is in discrete form.

**Analog data and Digital data**

**Analog data** is in continuous form. It is processed using computers which process the continuously changing variable quantities. Analog data can be represented as a wave form. Examples of analog data include temperature, pressure and humidity.

**Digital data**, unlike analog data, does not vary continuously with time. Digital data are discrete; that is, their values have only two possible states: that is, 0 or 1; on or off; and true or false. Example of digital data is data held in a computer.
Fig. 1.1: Analog and digital waves

Fig. 1.2(a): Examples of devices that measure analog data

Fig. 1.2(b): Examples of devices that measure digital data

Learning Activity 1.1

1. You have been asked by your teacher to prepare a short presentation on types of data. Using examples, explain the difference between analog and digital data.
2. Examples of analog data are ____________ and ____________.
3. Two examples of devices that measure analog data are ____________ and ____________.
4. Three examples of devices that measure digital data are ____________ and ____________.
1.1.2 Data gathering

This is the systematic collection of data from various sources for a specific purpose.

Methods of data gathering

Examples of data collection methods are: observation, interviews, questionnaires, data logging, direct data capture, studying existing documents, and use of other technologies.

• **Observation**: This is the careful study and recording of data as it occurs in the environment.

• **Interviews**: This is gathering of data by asking questions orally. The person asking the questions is the *interviewer*. The respondent is the *interviewee*.

• **Questionnaires**: This involves the use of a set of written questions.

• **Data logging**: This is the automatic collection of data over a period of time using sensors connected to a computer.

• **Direct data capture**: This involves the use of devices such as Optical Mark Recognition Reader (OMR), Optical Card Recognition Reader (OCR) and Optical Bar Recognition Reader (OBR) among others.

• **Study of existing documents**: This involves going through documents such as reports, journals, articles, and records of previous interviews.

1.2 Information

Information can be defined as processed facts or data that is meaningful and useful to the user.

1.2.1 Factors affecting the quality of information

1. **Accuracy**: This is the measure of how close information is to the original data. For example, take the number 5.263 as the original data. If this number is recorded as 5.26, it will be more accurate than if it is rounded off and recorded as 5.3.

2. **Relevance**: Information is considered to be relevant if it can be used for what it was intended. Information that is not accurate or timely is therefore not relevant. Relevant information should therefore be appropriate to the user needs. For example, an academic assignment that is received late may not be relevant because it may not be used to process the average mark for the student.

3. **Timeliness/Age**: Information changes over time. This means that out-of-date information can be irrelevant; therefore information needs to be up-to-date to avoid cases of misleading or giving the wrong picture of what is happening.

4. **Completeness**: Information should be comprehensive. Partial information may only represent a small part of the whole picture. If part of the information is missing, then one will not be able to make use of it, or make accurate decisions.
5. **Presentation**: Information should be presented in an organized manner to make it more useful. Presenting information using the best method, possibly by sorting or organizing it makes it much easier to understand and to be more useful.

![Diagram showing factors affecting the quality of information: Age, Accuracy, Relevance, Completeness, and Presentation.]

*Fig. 1.3 (a): Factors affecting the quality of information*

<table>
<thead>
<tr>
<th>Learning Activity 1.2</th>
</tr>
</thead>
<tbody>
<tr>
<td>You are a member of a Community Based Organisation committee. The members are planning to collect data from the community on how men, women, and the youth use mobile phones.</td>
</tr>
<tr>
<td>(a) Give examples of data collection methods you are likely to use.</td>
</tr>
<tr>
<td>(b) For each method, state briefly how the process will be conducted.</td>
</tr>
<tr>
<td>(c) Outline some factors that are likely to affect the quality of your information.</td>
</tr>
</tbody>
</table>

## 1.3 Communication

Communication refers to the exchange of information. In computing, it refers to the process of transmitting information or data signals from the source (*sender*) to the destination (*receiver*) through a transmission channel that use various technologies.

### 1.3.1 Elements of Communication

Communication involves the following elements.

(i) **Source /Sender**: This refers to the communicator or originator of the message. Sometimes, the sender becomes the receiver of the message.

(ii) **Content**: This refers to the message being communicated. It may be an attitude, opinion, views, orders, or suggestions.

(iii) **Communication Channel**: This refers to the medium of transmission used to deliver the message.
(iv) **Receiver**: This is the person who receives the message.
(v) **Feedback**: This is the reaction given after the message is received. It is the output from the receiver in order to improve performance by providing self-corrective action. Feedback gives the communication progress. It can be negative or positive.

The figure below shows how communication takes place between the message sender and the message receiver.

![Diagram of Communication Elements](image)

**Fig. 1.3(b): The elements of communication**

![Example of Message and Feedback](image)

**Fig. 1.3(c): An example: Message and feedback**

**Types/Ways of Communicating**

There are two basic types of communication which include:

- **Verbal**
- **Non-verbal**

**Verbal communication**: This is the use of spoken words to send a message. It can also be oral or written. It involves both speaking and listening.

**Non-verbal Communication**: It includes the use of body language, facial expressions, gestures, and posture. Non-verbal responses can sometimes contradict verbal communication. This changes the effectiveness of the message.
Learning Activity 1.3

Communication refers to the exchange of information. Take the example of your classroom situation when the teacher is giving a lesson.

1. Identify the elements of communication at play during interaction between the teacher and the students.
2. Using examples, give the types of communication at play during the lesson.
3. In the examples given below, state whether the type of communication given is verbal or non-verbal:

<table>
<thead>
<tr>
<th>Way of communicating</th>
<th>Type of communication (verbal or non-verbal)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Calling someone on telephone</td>
<td></td>
</tr>
<tr>
<td>Writing a letter</td>
<td></td>
</tr>
<tr>
<td>Giving a speech</td>
<td></td>
</tr>
<tr>
<td>Nodding the head</td>
<td></td>
</tr>
</tbody>
</table>

1.4 Technology

1.4.1 Types of Technology

Technology refers to the application of scientific knowledge to the practical purposes in the human environment.

Technology is used in industries and learning institutions among others. Technology includes the use of materials, tools, techniques, and sources of power. Technology is applied in many areas.

Some types of technology are given below:

1. Technology of Teaching

This refers to instructional approaches that are systematically designed and applied in specific ways. It includes the following:

- The use of well-defined objectives.
- Specific instructional procedures based upon the tasks that learners are required to study.
- Small units of instruction that are carefully arranged.
- A high degree of teacher activity.
- High levels of student participation.
- Careful monitoring of student performance.
2. **Assistive Technology**

Assistive technology applies various types of services and devices designed to help people with disabilities to function within an environment. It includes electronic, microprocessor-based equipment, mechanical, non-mechanical, and specialized instructional materials and strategies.

Assistive technology enhances the lives of people with disabilities in the following ways:

(a) Helps them in learning.
(b) Improves their quality of life.
(c) Makes the environment more user-friendly.
(d) Improves their independence.
(e) Allows them to compete in the workplace.

3. **Medical Technology**

It is the use of scientific knowledge in healthcare to diagnose, monitor and treat diseases or medical conditions. For example, artificial limbs, knee and hip implants can help people to function.

4. **Information Technology (IT)**

Information technology (IT) is the use of computers, storage devices, networking devices, and other electronic devices to create, process, store, secure, and exchange all forms of data. Electronic gadgets such as a washing machine and a microwave oven, among other examples, use information technology to operate.

5. **Other Types of Technology**

There are many other types of technologies. Examples are as follows:

- Military technology
- Food technology
- Banking technology
- Weather forecasting technology
- Broadcasting technology

**Learning Activity 1.4**

1. Do some research on assistive technology. Find out how technology can be used in schools to assist learners with Special Education Needs. Write a brief paper summarising your findings. Give a short class presentation on this topic.
2. Do some research to find out other types of technologies. List them and share your list with your classmates.
3. Define the terms data and information.
4. Using an illustration, differentiate between analog and digital data.
5. Some factors that affect the quality of information are ___________ and ___________.
6. Two ways of communicating are ___________ and ___________.

### 1.5 ICT (Information and Communication Technology)

#### 1.5.1 Definition of ICT

ICT is the abbreviation for Information and Communication Technology. ICT refers to the application of information technology and telecommunication that includes the use of computer hardware, software, and telecommunications equipment for transmission and presentation of information.

#### 1.5.2 ICT Equipment, Its use, and Interaction

The following are some of the equipment used in ICT:

1. **Radio**

   **Use of a Radio**

   This is a device that is used to receive radio signals from broadcasting stations and convert them into sound.

   A radio antenna must be used but since the antenna will pick up many radio signals at a time, a radio tuner is necessary to tune into a particular frequency (or frequency range). The radio is used to relay news, announcements, music, advertisement and educational programmes among others.

   **Interacting with a Radio**

   To interact with a radio:
   
   (i) Connect the power cable to the power supply or insert dry cells in the radio battery compartment.
   
   (ii) Switch on the power button.
   
   (iii) Using the frequency adjustment knob, tune to the desired frequency.

   One can change the radio to different frequencies to listen to other channels.
2. **Television**

**Use of a Television**

The television or TV is an electronic device for receiving and reproducing images and sound of combined video and audio signals.

It is used to relay news, announcements, music, advertisements, and educational programmes among others.

**Interacting with a Television**

(i) Connect the television to the source of power.
(ii) Switch on the TV.
(iii) Ensure that the set top box is on and well-configured as directed by the manufacturer.
(iv) Tune to the desired channel
(v) Using the remote control or channel buttons on the TV set, select any other channel of interest.
3. Mobile Phones

Use of Mobile Phones

They are also referred to as cellular phones or cell phones. These are electronic telecommunication equipment that connect to a wireless communication network through radio waves or satellite transmission.

Most of these devices provide audio communication, Short Message Services (SMS) or Multimedia Message Services (MMS).

The smartphone is a cellular phone that performs most of the functions of a computer. The user interacts with the smart phone through a touch screen. Some features in a smart phone include Global Positioning System (GPS), camera, browsing, voice calls, email services, gaming, and downloading of content. Smart phones use connectivity features such as Bluetooth, and Wi-Fi.
Interacting with a Mobile Phone
(i) Switch on the mobile phone.
(ii) It opens the home screen.
(iii) The mobile phone displays different menus that are available.
(iv) Depending on the type of phone, use the key pad or the touch screen to interact with the mobile phone.
(iv) Select the menu of choice and interact with the available features.

4. Computer

Use of a Computer
A computer is an electronic device which is capable of receiving data and processing it into information. A computer has the ability to store, retrieve, and process data. The user is able to type documents, send and receive emails, play games, and browse the Internet.

Interacting with a Computer
(i) Connect the computer to the source of power.
(ii) Switch it on and allow it to boot up.
(iii) After the boot up process, the desktop is displayed with icons.
(iv) Click on the start button located on the task bar.
(v) From the menu, select the desired program to work with.

5. Tablet

Tablets: A tablet is a portable computer fitted with a touch screen display, circuitry, and battery in a single device. It is also equipped with features, including cameras, a microphone, and a speaker. The touch screen display is operated by swiping a finger or a stylus.
6. **Billing Machines**

**Uses of billing machine**

A billing machine is used in business to itemize, compute customer accounts, generate bills, provide customer invoices, and send account records.

**Learning Activity 1.5**

1. Visit a supermarket, shop, or a restaurant where they are using a billing machine.
2. Observe how the billing machine is used.
3. Complete this sentence:
   In a shop, a billing machine is used to ____________.

7. **Satellite**

**Use of Satellite**

A satellite is a self-contained communications system. It revolves around a planet in a circular or elliptical path. It has the ability to receive signals from the Earth and to retransmit those signals back. An example of an earth station that communicates with orbiting satellites is Very Small Aperture Terminal (VSAT).
Fig. 1.10: How a satellite communication system works

8. Projector

Use of a Projector

It is an output device that uses light and lenses to take images generated by a computer and reproduce them on a larger flat screen or wall (usually lightly coloured). For example, projectors are used in meetings to help ensure that all participants can view the information being presented.

Fig. 1.11: Projector connected to a laptop

<table>
<thead>
<tr>
<th>Learning Activity 1.6</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. ___________ is an electronic device that accepts data as input. It ___________ data using a set of instructions referred to as ___________ or programs and either stores or produces ___________ as output. (Use the following words to fill in the gaps: information, computer, processes, software)</td>
</tr>
</tbody>
</table>

13
14

2. Name the parts labelled C to G.

1.6 Importance of ICT

1.6.1 General Use of ICT

(a) Education

ICT has facilitated education through Computer Aided Learning (CAL), Computer Aided Instruction (CAI), Computer Aided Assessment (CAA), E-learning and computer based simulation among others.

(i) Computer Aided Learning (CAL): This is the integration of ICT into the learning process. It is also known as Computer Based Training (CBT). It involves the use of computers in education and training. CAL techniques include:

- Educational games: These are electronic games that have content relevant to a subject area. For example the Carmen sandiego helps students learn World geography.
- Problem solving tutorials: These are self-instructional programs that guide the learner through learning and resource material acting as their virtual teacher.
- Drill and practice: A set of questions from a database are given to students repeatedly to practice skills and concepts. The questions usually have straightforward answers and are therefore very easy for the computer to mark.
- Simulation: Multimedia content is used to mimic real learning activities. For example it can be used to mimic a chemistry experiment.
(ii) **Computer Aided Instruction (CAI):** This involves the use of computers to teach academic skills to students. CAI is used to develop communication and language skills. It includes computer modelling and computer tutors, for example, the typing tutor.

(iii) **Computer Aided Assessment (CAA):** It is a computerised innovation used in marking multiple choice examination papers where a box is marked in pencil to indicate the candidate’s preferred answer. An Optical Mark Reader (OMR) can identify the box having a mark and award a score appropriately.

(iv) **E-learning:** It is the delivery of educational programs, training or learning materials by electronic means. It involves the use of electronic devices such as mobile phones, tablets, computers and the Internet.

(v) **Computer Simulation:** This is the modelling of a real situation using a computer. It is used to model industrial processes enabling better understanding and improvement of production systems. The idea of simulation is to try and find out what mechanisms to control. A simulation also shows how a production system behaves. It can also predict or influence the behaviour of the system in the future. In industries, simulation can be used to:

- Train workers such as pilots.
- Study the efficiency of a production process.
- Evaluate how safe the activities in a factory are.

Simulation is also applied in the learning of mathematics and biological sciences. In the latter, it is used to simulate body systems such as the digestive, respiratory, and circulatory systems.
Learning Activity 1.7

Do some research on the application technology in education.

(a) Find out other new technologies used in the education sector.
(b) Write a short paper summarising your findings.
(c) Give a short class presentation on this topic.

(b) **Health**

The following are some of the uses of ICT in healthcare:

(i) ICT is used in the medical sector to keep records of patients.
(ii) In the Intensive Care Unit (ICU), ICT is used to control life support machines.
(iii) ICT is also used to conduct brain scans, body X-rays, ultra sounds, and other body scans.
(iv) Patients also receive medical diagnosis and advice from foreign medical experts through the use computerised expert systems.
(v) Knowledge enrichment, research, and education: Many doctors, pharmacists and medical practitioners use the Internet to keep themselves updated. They do research on specific questions and areas of interest. They also take refresher courses to enrich their medical knowledge in order to offer better services to their patients.
(vi) ICT-based equipment such as the Magnetic Resonance Imaging (MRI), X-Rays and CT-Scan (Computed Tomography Scan) are used to diagnose complicated medical conditions.

(c) **Business**

Business refers to commercial activities carried out for profit. Electronic business (e-business) is the application of ICT in support of business activities. Examples of ICT-based business activities include:

(i) **Online Shopping:** The use of plastic money, that is, money held in electronic credit cards or mobile devices makes it possible to order for goods and services from the comfort of one’s home or office.

(ii) **Advertising and Marketing:** Through the use of websites, organizations are able to advertise at a low cost. Most businesses now use websites with high web traffic as platforms for creating awareness about their products and services. For example the OnLine eXchange (OLX) website is used for selling second hand items.

(iii) **Use of electronic billboards:** These are created using graphic software such as Adobe Illustrator and Adobe Photoshop.
(iv) **Promotional Presentations**: These could be created using PowerPoint presentations, video presentations, and animation software.

**(d) Communication**

ICT is used to transmit textual, visual and audio information from one point to another through the use of telecommunication equipment at a very high speed. This is achieved through the use of electronic mails (e-mails), live chatting systems, online meetings (via Skype), short messages services (SMS), facsimile (fax), and video-conferencing among others.

**(e) Banking**

ICT can be used in banking where transactions such as electronic fund transfer (EFT), Internet banking, mobile banking, use of Automated Money Transfer, Automated Teller Machine (ATM), Database Management and Cheque clearing are made possible. Customers are also enabled to access their bank details through SMS alerts.

**(f) Manufacturing and Production**

ICT-based systems such as Computer Integrated Manufacturing (CIM), Computer Aided Design (CAD) and Computer Aided Engineering (CAE) are used to monitor and control production processes in factories.

**1.6.2 Advantages and Disadvantages of ICT**

**Advantages of ICT**

(i) Use of ICT helps in performing tasks faster and more efficiently.

(ii) ICT enables very high accuracy levels in large-scale production.

(iii) Greater access to ICT technology has helped to bridge the cultural gap by helping people from different cultures to communicate with each other, and allow exchange of ideas and views, hence increasing awareness.

(iv) ICT facilitates efficient sending and accessing of information from different locations across the world.

(v) ICT tools help organizations to gain a competitive edge over their competitors.

**Disadvantages of ICT**

(i) The initial capital investment of buying new equipment and the cost of maintenance is usually high.

(ii) ICT and automation can lead to loss of jobs, especially for computer-illiterate persons.
(iii) ICT equipment such as computers can lead to health problems. Some known health risks related to computer use include eye problems, backache, and wrist injuries.

Learning Activity 1.8

Do some research on other health effects that have been associated with the use of ICT. Write a short paper summarising your findings. Hand in the paper to your teacher for assessment.

1.6.3 Current use of ICT in Rwanda

Rwanda's Vision for 2020 framework addresses the educational, agricultural, industrial and social elements of the country’s economy. The Rwandan government has invested greatly in a knowledge-based economy with ICT as its cornerstone.

(a) ICT use in Education

(i) Learning in schools: The government project for One Laptop Per Child (OLPC) has facilitated the use of computers in learning institutions. The content has been developed by the Rwanda Education Board (REB). The students are able to learn programs such as Turtle, Gnome, and Scratch. Computers are also used in Higher Learning Institutions (HLIs) at the secondary school level.

(ii) Distance Learning: ICT has facilitated the running of distant educational programmes. An example is the African Virtual University (AVU) in collaboration with the University of Rwanda (UR) and Kigali Institute of Science and Technology. Distance learning programs offer opportunities for further training for people who desire to advance their education.

(iii) E-ICT: Electronic-ICT is easily accessible to anyone interested in high-technology courses. Such programs enable one to keep up-to-date with new technologies. The curriculum programs include ICDL (International Computer Driving License). Examples of courses offered include Microsoft Office applications and Cisco Networking among others.

Learning Activity 1.9

How is ICT being used in your school? Write a short paper summarising how your school has benefitted from the use of ICT.

(b) ICT use in the Health Sector

(i) Record keeping: The use of systems such as Open Medical Records System (OpenMRS) and Treatment and Research Aids Centre (TRAC) net system
facilitates nationwide tracking of patient data and managing clinical health information.

(ii) **Mobile e-Health systems**: They are used by community health workers to collect data on patients and health management, for example, OpenMRS and TRACnet systems.

(iii) **Telemedicine**: This facility allows the sharing of clinical information between urban and rural hospitals. An example is King Faisal Hospital that connects Kabgayi and Musanze, allowing citizens to receive specialized treatment services remotely without travelling to Kigali.

(c) **ICT use in Business**

(i) **Mobile banking and financial services**: Mobile service providers have introduced money transfer and other financial services.

(ii) **Village banking**: Banks are using telecommunication facilities to provide banking services in remote areas.

(iii) **E-business**: ICT is a great medium of transacting businesses. Through electronic payment systems such as credit cards and online banking, clients are able to transact business across borders without moving physically from one location to another. Online advertising platforms allow businesses to create awareness about their products.

(iv) **Market survey**: Rwandans have real time updates about the Stock Exchange daily market status. This enables them to make informed decisions about investments.

(v) **E-Soko**: This project enables farmers to make informed market pricing decisions on their produces.

<table>
<thead>
<tr>
<th>Learning Activity 1.10</th>
</tr>
</thead>
<tbody>
<tr>
<td>The use of the mobile phone has revolutionised how business is conducted. Cite examples of how mobile telephony is being used in business in Rwanda.</td>
</tr>
</tbody>
</table>

(d) **Communication**

(i) **Video Conferencing**: This refers to communication between individuals in different locations by use of simultaneous two-way audio and video transmissions. The users are able to communicate with each other as though they were in the same room. In this way conversations are facilitated. In Rwanda, video conferencing is used in the following situations:

(a) **Holding meetings**: Video conferencing provides a platform to work with others across a distance. For example, local government leaders in Rwanda from all districts are able to hold meetings and interact with the minister of local government through video conferencing technology.
(b) **Facilitate distance learning**: Students in Rwanda are able to register and take courses offered in foreign universities through online learning.

(c) **Interview employees remotely**: Public and private institutions in Rwanda are able to conduct job interviews without requiring the interviewees to be physically present within their premises. A popular platform for this is Skype for Business.

(d) **Television and Video Broadcasting**: Radio and television reporters are able to relay news on location for broadcasting. Video conferencing also enables a reporter to interview news sources across the world. The technology allows the new sources to interact live with the news anchor.

![Video conferencing diagram]

*Fig. 1.18: A video conference meeting*

(ii) **E-mail**: E-mail stands for Electronic Mail. It is a method of exchanging typed messages and attachments electronically between individuals. It is used in Rwanda to communicate with employees, customers, friends, and family. It has enabled people to communicate with others outside Rwanda. Examples of e-mail software include Yahoo! mail, gmail, and hotmail. Some benefits of email are:

(a) It allows individuals and groups to communicate with one another efficiently.

(b) It allows for affordable communication since envelopes and stamps are not needed.

(c) It is convenient since the user does not have to go to the post office to send or receive mails.

(iii) **Internet**: The following are some of the application areas of the Internet:

- **Research**: Internet has a lot of information which can be used for research materials. For example, sites such as [www.kidsclick.org](http://www.kidsclick.org) can be used for research.
• **Library:** The Internet has enabled libraries to be accessed from anywhere at any time. An example of an online library is [www.memphislibrary.org](http://www.memphislibrary.org).

• **Online Books:** Internet has enabled the availability of books online. A book can be accessed easily by many readers. An example of an online book site is [www.magickeys.com/books](http://www.magickeys.com/books).

• **Socializing:** The Internet enables the creation of social network services that develop online communities of people who have common interests and activities. Examples of sites are [www.fanlala.com](http://www.fanlala.com) and [www.facebook.com](http://www.facebook.com).

(e) **Service Delivery**

In Rwanda, the Internet has made it possible for deliver of services to the public online. For instance, there are services that are delivered through the website known as: [www.irembo.gov.rw](http://www.irembo.gov.rw). Examples of services delivered on this website include the issuing of driving licences and birth certificates. The site also allows one to search for criminal records on an individual among other services.

<table>
<thead>
<tr>
<th>Learning Activity 1.11</th>
</tr>
</thead>
<tbody>
<tr>
<td>Do some research on the available open online libraries.</td>
</tr>
<tr>
<td>(a) Compile a list of the available libraries you will find. Share the list with the rest of the class.</td>
</tr>
<tr>
<td>(b) Visit some of the open online libraries in your list. Access books online. Share your experience with the rest of the class.</td>
</tr>
</tbody>
</table>

**Revision Exercise 1**

1. ____________ is the measure of how close data is to the original data.
2. The **two** ways of communication are ____________ and ____________.
3. Name three elements of communication.
4. ICT is the abbreviation for ____________.
5. Two examples of ICT equipment are ____________ and ____________.
6. In the education sector, ICT is used for ____________.
7. Differentiate between verbal and non-verbal communication.
8. Define a tablet as used in ICT.
9. State any three application areas of the Internet.
10. Explain the impact of ICT in the business sector of Rwanda.
11. Explain how each of the following affects the quality of information:
   (a) Age    (b) Accuracy    (c) Completeness
2.1 Definition of a Computer

2.1.1 Definition of a Computer

A computer is an electronic device that accepts data, processes it using a set of instructions, stores it, and gives information as the output.

2.1.2 Functions of Computers

Computers perform four major operations or functions namely: input, processing, storage, and output.

- **Input**: This is data entered into a computer for processing. A computer has input devices that are used for data entry. It accepts the data entered into it.
- **Processing**: This is the conversion of data into information. Once data is accepted, the computer takes it to the processing unit where it is converted into information based on the instructions given by the user.
- **Output**: It is the information produced after processing of data is complete. This information can be used as data in another stage or it could be the last result required.
• **Storage**: A computer can store a large amount of data within it. It has primary and secondary storage devices that are used for this purpose.

### 2.1.3 Characteristics of a Computer

The following are some characteristics of a computer:

(i) **Speed**: A computer can carry out processing of instructions at a very high speed. It can perform in a few seconds the amount of work that a human being can do within a long period. The speed of computer is calculated in Hertz (Hz).

(ii) **Accuracy**: Computers are very precise in processing data as long as they are fed with correct data and instructions.

(iii) **Versatility**: A computer can perform more than one task at the same time. This is called multi-tasking.

(iv) **Reliability**: A computer is highly reliable as long as it is fed with accurate data reliability.

(v) **Power of Remembering**: A computer can store and re-produce information any time because of its large secondary storage space.

(vi) **No Intelligence Quotient (IQ)**: A computer possesses no intelligence of its own. It can only perform what it is programmed to do. Hence, the user must provide it with accurate instructions. There is a phenomenon called **Garbage In Garbage Out (GIGO)**. If the data fed into the computer does not make sense, the output will also not make sense to the user.

(vii) **Diligence**: A computer is a machine and therefore it does not suffer from human traits such as tiredness, bad attitudes, and mood swings among others. It also does not lose concentration after working continuously for a long time. Hence, computers can do the same tasks over and over again without getting tired. It can also perform long and complex calculations with same speed and accuracy from the start until the end.

(viii) **Storage**: Depending on the size of its memory, a computer can hold tremendous amount of data. It also has a variety of removable storage locations that could be used to back-up data.

### Learning Activity 2.1

1. Compare a computer to a typewriter. State the advantages of using a computer over the typewriter.
2. Using an example, explain the meaning of GIGO.
3. Data that has been entered into a computer for processing is called ____________.
4. The conversion of data to information is called ____________.
2.2 Computer Components

A computer system is a collection of components that work together to process data and manage information in a computer in order to achieve a desired goal. The components that make up a computer system include hardware, software, and liveware (user).

2.2.1 Hardware

Hardware refers to any physical or tangible component of a computer. It could either be mechanical or electronic. Examples of computer hardware include the Central Processing Unit (CPU), computer peripherals, storage media, ports, and connectors.

(a) The Central Processing Unit (CPU)

The CPU is also known as the processor. It is commonly referred to as the “brain” of a computer system.

The processor is a programmable device that controls the retrieval, interpretation, and execution of instructions in a computer. It consists of three components namely:

(i) The Arithmetic and Logic Unit (ALU)
(ii) The Control Unit (CU)
(iii) The memory units, known as the registers.

The Arithmetic and Logic Unit (ALU)

It is the part of the CPU that performs two main functions, namely:

- The arithmetic operations such as addition (+), subtraction (–), division (÷), and multiplication (×).
- The logical operations such as OR, AND, and NOT among others.
**The Control Unit (CU)**

It is the part of the CPU that coordinates the activities of different sections of the processor and input/output (I/O) devices. It also performs the following activities:

- Controls, supervises, and oversees all the activities of the computer.
- Fetches instructions from the main memory (hard drive or RAM, see page 46).
- Decodes the instructions in a format the computer can understand.
- Executes the instructions by issuing commands to respective components where action is supposed to be taken.
- Determines the next task to be taken up by the processor for execution.
- Processes the data in line with the instructions given.
- Controls the transfer of data and information within the available storage space.

The above functions can be summarized in what is regarded to as **Fetch-Execute Cycle**.

![Fig. 2.1: Fetch-Execute Cycle](image)

**Memory Units**

The memory units are found in the CPU.

**Registers**: They are temporary storage locations found inside the processor that are used to hold data, instructions or information awaiting processing or output. There are four types of registers namely: instruction register, accumulator register, address register, and storage register.

- **Instruction register**: It temporarily holds an instruction before it is converted to machine readable format.
- **Address register**: It temporarily stores the address of the next instruction to be processed.
• **Accumulator register**: It temporarily holds the last processing step of the Arithmetic Logic Unit (ALU).

• **Storage register**: It temporarily holds information waiting to be output.

<table>
<thead>
<tr>
<th>Learning Activity 2.2</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Part 1</strong></td>
</tr>
<tr>
<td>1. An electronic device that accepts and processes data to give information as output is a ____________.</td>
</tr>
<tr>
<td>2. Explain three characteristics of a computer.</td>
</tr>
<tr>
<td>3. State two functions of the Arithmetic Logic Unit.</td>
</tr>
<tr>
<td>4. Explain three types of registers used in a computer.</td>
</tr>
<tr>
<td>5. The CPU is also commonly referred to as the ____________ of a computer.</td>
</tr>
</tbody>
</table>

| **Part 2** |
| In groups, discuss the following: |
| (i) Parts of the Central Processing Unit. |
| (ii) Functions of a computer. |
| (iii) The characteristics of a computer. |

**(b) Computer Peripherals**

Peripheral devices are computer components that are connected to the ports in the system unit through cables or wireless media. They include input devices and output devices.

**Input devices**

These are hardware components that are used to enter data and instructions into a computer. They are classified into:

1. Keying devices
2. Pointing devices
3. Scanning devices
4. Voice input devices

1. **Keying Devices**

These are input devices that enable entry of data into the computer through the use of a set of keys. These devices are used for typing letters, numbers, symbols, and commands by pressing a key or combination of keys. Examples are the keyboard and the keypad.
(a) **The Keyboard**: The keyboard is used for typing letters, numbers and special symbols. It is sometimes referred to as the alphanumeric keyboard. Examples of keyboards are the traditional, flexible, Braille, and ergonomic keyboards.

(i) **Traditional Keyboard**: They are large and rigid keyboards. They are named based on the arrangement of the first six characters in the first row of the alphabet keys. They include QWERTY keyboards, AZERTY, QWERTZ, and HCESAR.

![Fig. 2.3: The keyboard is used to key in data.](image)

(ii) **Ergonomic Keyboard**: This is designed to minimize wrist injury. It is connected to the system unit using the Universal Serial Bus (USB) cable. Some ergonomic keyboards are split.

![Fig. 2.4: The ergonomic keyboard is designed to minimize wrist injury.](image)

(iii) **Flexible Keyboard**: This is a portable keyboard which can be folded and carried in a bag.

![Fig. 2.5: A flexible keyboard can easily be folded and carried in a bag.](image)
(iv) **Braille Keyboard**: This is specifically designed for the visually impaired. The keys have raised dots enabling the user to feel and identify the character or symbol represented by the key.

![Braille Keyboard Image](image)

*Fig. 2.6: The braille keyboard is designed for the visually impaired.*

(v) **The Keypad**: This is a small keyboard, which is mostly used on devices such as palmtops, calculator, microwaves and washing machines among others.

![Keypad Image](image)

*Fig. 2.7: The keypad is a small keyboard used on devices such as palmtops and mobile phones.*

2. **Pointing Devices**

These are devices which control the movement of a cursor or a pointer on the computer screen. Examples of pointing devices are the mouse, trackball, joystick, touch screen, light pen, touch pad and graphic tablet among others.

(a) **Mouse**: There are three types of computer mouse:

- **Mechanical mouse**: It contains a ball underneath which is rotated when the mouse is moved hence controlling a pointer on the screen.
- **Optical mouse**: It uses digital image processing technology to track the position of the mouse.
- **Wireless mouse**: It does not use cables. It uses infrared and radio waves such as Bluetooth to control the pointer on the screen.
Mouse Actions: The following are some of the mouse actions:

(a) **Clicking**: This is pressing and releasing the left mouse button once. It is used when selecting an item.

(b) **Double-clicking**: This is pressing and releasing the left mouse button twice in quick succession. It is used when opening a file/folder, or starting a program.

(c) **Right-clicking**: This is pressing and clicking the right mouse once. It is used to display the content menu.

(d) **Drag and drop**: It is pressing and holding down the left mouse button on an item. The mouse is then dragged to the desired location and the button released inorder to move an item.

- **Trackball**: It is a pointing device with a ball on the top that is rotated with the finger preferably the thumb, or the palm of the user’s hand to control the pointer on the screen. Unlike a mouse, a trackball does not need a mouse pad or a smooth surface underneath it to operate. A trackball has the left and the right button just like a mouse that is clicked to perform an action.

(b) **Joystick**: It is a device that looks like a gear lever used to control the movement of the pointer or some objects on the screen. It is mainly used for playing games. A joystick can contain more than three buttons for further manipulation of the object when playing computer games.
Fig. 2.10: A joystick looks like a gear lever. It is used to control the movement of the pointer.

(c) **Light pen**: It is a hand-held input device that utilizes a light sensitive detector to select objects or to write on the screen. It contains sensors at its tip that send signals to the computer whenever light is recorded. They are often used in design and can also be used for sensing information on magnetic bars and stripes.

Fig. 2.11: A light pen is an input device that utilizes a light sensitive detector to select objects.

(d) **Touch screen**: It is an input device designed to recognize the location of a touch on its surface. The user can make a selection or move a cursor by touching the screen with the finger.

(e) **Touch pad**: It is a pointing device commonly found in laptops where the user places or moves the finger across it to control the pointer on the screen. It contains two buttons that are clicked once the desired location is reached in order to execute an action.

Fig. 2.12(a): Touch screen  
Fig. 2.12(b): Touch pad
(f) **Graphics tablet or digitizer:** It is a pointing device used by designers and artists. They use it to draw a picture on a computer screen by free hand without using a mouse or a keyboard. It consists of a flat, a touch-sensitive pad and some sort of drawing device, such as a stylus. A stylus is a pen-like device moved over the surface of the tablet. Data about the stylus movements are sent to the computer.

![Graphic tablet](image)

*Fig. 2.13: The graphic tablet is used by designers to draw a picture on a computer screen.*

3. **Scanning Devices**

They are also known as scanners. They are peripheral components that capture data from the source directly to the computer by converting it into digital format. The source can either be a paper or an object. There are two main types of scanners which include optical scanners and magnetic scanners.

(a) **Optical Scanners:** These scanners capture data using light technology. Light is passed over the object or paper to capture the image. The image is then analyzed by specialized software. Examples of Optical scanners are the Optical Barcode Recognition (OBR), the Optical Mark Recognition (OMR) and the Optical Character Recognition (OCR).

(i) **Optical Barcode Recognition (OBR):** They are also known as Optical Barcode Readers. A barcode is a series of printed parallel vertical lines that differ in thickness and spacing. A barcode contains information about the item ID number. Once a barcode has been scanned, the computer reads the information stored on the barcode and accesses details about the product from the computer database. There are two types of barcode readers:

- **Handheld barcode reader:** It is also known as a wand. It is held by hand and passed over the product’s barcodes to read the information.
- **Countertop barcode reader:** It is permanently fixed on the counter and the product is passed over it to read the information.
Fig. 2.14: Optical Bar Code readers capture data using light technology.

- **Optical Mark Recognition (OMR):** This technology is used to read marks made using a pencil on a piece of pre-printed paper. The OMR shines light onto the paper and less light is reflected where a pencil mark is made. The marked area is usually darker than the unmarked one, making it easier for OMR to recognize the position of the mark or set of marks on a paper. The computer records the marked position and analyses it to determine the meaning of the data. The marks must however be very clear. They are used in reading shaded area in multiple choice examinations, lottery tickets, and questionnaires with objective-type questions.

Fig. 2.15: OMR are used to read marks made using a pencil on a piece of pre-printed paper.

(ii) **Optical Character Recognition (OCR):** Optical character readers consist of a scanner along with special user interactive software. They allow scanning of characters on paper (hardcopy) into a softcopy that is stored in the computer. The softcopy version can be edited or formatted.

Fig. 2.16: OCR is used for reading hardcopy data into a softcopy that is stored in the computer.
(b) **Magnetic scanners**: These scanners capture data written using magnetic ink. Examples of magnetic scanners are the Magnetic Ink Character Reader (MICR) and Magnetic Stripe Reader.

(i) **Magnetic Ink Character Recognition (MICR)**: It is a scanner that reads characters printed using special magnetized ink (the ink contains iron particles). The special ink contains information, for example, the bank account details which are usually on the bottom of a cheque. MICR is widely used by banks to authenticate cheques and obtain the information written using magnetic ink on the cheque.

![Fig. 2.17: The MICR reads characters printed using special magnetized ink.](image)

(ii) **Mobile Card Machine**: It is also known as the chip or the pin Reader. It is a device used by bank agents to access bank account details of the customer. A plastic card containing a chip is inserted in a slot. The user then enters his or her Personal Identification Number (PIN).

![Fig. 2.18: A Mobile Card Machine reads data contained in a chip embedded in plastic cards.](image)

(iii) **Magnetic Stripe Recognition**: This reads information coded in a magnetic stripe at the back of a plastic card when the card is swiped through it. They read information held on the stripe which could be a bank account number, the name of the card holder, and the card expiry date. They can also be used to control access to a building by swiping the card through the reader.
The difference between Magnetic Stripe Card Reader and Mobile Card Machine is that the magnetic stripe card reader reads cards with a magnetic stripe by swiping; while a mobile card machine reads cards with a microchip.

(iv) **The Magnetic Resonance Imaging (MRI)**: This is a medical imaging or scanning technology that is used to image the human body and the body systems. It is used in medical tests. It takes the pictures of human body organs, including tissues and bones. The MRI is used to scan for and diagnose diseases.

4. **Voice Input Devices**

These are devices used to input data in the form of spoken words into the computer.

They can be used to control access into a building or record speeches and music. An example of a voice input device is the microphone.
Output Devices

These are devices used for displaying data and information. They are classified into two categories, namely softcopy output devices and hardcopy output devices.

Hardcopy output devices

These are devices which produce output that is recorded on tangible media such as paper. Examples are printers and plotters.

Printers

A printer is a peripheral device that produces hardcopy output. Printers can be broadly classified into impact printers and non-impact printers.

(a) Impact printers

They print on paper. They apply the striking mechanism. The print head physically strikes an inked ribbon. The ribbon then presses on a paper medium to create the image hence the name impact printer.

Due to the impact made by the print head, impact printers are noisy. Examples of impact printers are daisy wheel, dot-matrix, and drum printers.

Impact printers can produce multiple copies of the same document at the same time using carbonated paper.

The following are examples of impact printers:

(i) Daisy wheel printers: These printers got their name from the daisy flower. The wheel has hammer-like structures that resemble the petals of a daisy flower. Each hammer (spoke) on the wheel has a character at the printing head.

As the wheel rotates, a selected spoke with the appropriate character bends and prints on the paper as is the case with a typewriter. These printers can only print one character at a time.
The Daisy wheel printer has hammer-like structures.

(ii) Dot Matrix Printers: The head of this printer consists of pins arranged in a matrix. When a character is to be printed, the printer works by using a set of pins to press an inked ribbon against the paper. When the inked ribbon hits the paper, a dot is left behind. The dots are arranged to form text and image.

(iii) Drum printers: Characters are raised in a cylindrical drum. Values of all characters are stored in the printer buffer. When a character is to be printed, the printer sends the information to the printer buffer. The printer drum is rotated as the character is printed by striking the hammer. The hammer strikes the ink ribbon and an impression is produced on paper.
(ii) **Non-impact printers**

They are printers that use thermal or electrostatic principles to produce print on paper. The print head element does not come into contact with the paper; hence they are quiet while printing. They print faster and produce high quality prints compared to impact printers. Their ink is contained either in a toner or cartridge. There are three main types of these printers namely: Inkjet, Laser jet and Thermal printers.

**Fig. 2.26: Non-impact printers have their ink contained either in a toner or cartridge.**

(i) **Inkjet printers:** These printers spray little dots of ink on a paper forming the shapes of characters and pictures when printing. They are commonly used for non-commercial purposes. Their initial cost is low but maintenance cost is very high. This is due to the high price of buying a new cartridge and the low number of print-out papers produced per cartridge.

(ii) **Laser printers:** They use the principle of light to form images on the paper. The printers operate by shinining a laser beam that ionizes some regions on the drum. The toner is sprayed on the drum and it sticks on the ionized regions of the drum. The drum is then pressed onto the sheet of paper and the paper is heated (fused) so that the toner is bound to the paper.

**Fig. 2.27: An ink jet printer.**

**Fig. 2.28: A laser printer.**
(iii) **Thermal printers**: These printers use thermal (heat) technology to produce images on a special paper.

The print mechanism is designed to heat the surface of chemically treated paper referred to as **thermochromic** or thermal paper.

When the paper passes over the thermal print head, the coating on the paper turns black.

This is due to the reaction of the chemical to heat forming the required images on the paper. They are popularly used at Point of Sale (POS) terminals to print receipts.

**Plotters**

These are special-purpose output devices. They are used to produce high-quality, multi-colour documents or large size documents such as charts, maps, architectural drawings, and three-dimensional representations based on commands from a computer. There are two types of plotters, namely drum and flatbed plotters.

(i) **Drum plotters**: In this type, the paper is mounted on the surface of the drum in the plotter. Automated pens are placed horizontally slightly above the paper. As the drum revolves and the part of paper to be plotted comes into alignment with the pens, the pens are activated to create the image.

(ii) **Flatbed plotters**: In this type, the paper is fixed on a flat surface and pens are moved to create the image. This plotter works by using an arm that moves a pen over paper rather than having paper move under the arm as is the case with drum plotter. The size of the plot depends on the size of the plotters bed.
Softcopy Output Devices

These are devices that produce information that can be seen, listened to, but not tangible. Examples of softcopy output devices are monitors, projectors, and speakers.

Monitors

A monitor is also referred to as Video Display Unit (VDU) or the screen. It is used to display data and information. There are two main types of monitors, namely the Cathode Ray Tube (CRT) and flat screens.

1. Cathode Ray Tube (CRT) Monitors: They are bulky and heavy. They produce an image (made up of tiny dots) by firing electron beams against a phosphor screen. Each dot is coloured red, green, and blue of different intensities combining to create millions of different colour shades.

![Cathode Ray Tube monitor](image)

*Fig. 2.32: The CRT monitor produces an image by firing electron beams.*

2. Flat screens: These monitors are becoming popular nowadays and are used in desktop and laptop computers. They are all characterized by the flat shape which makes them to be lighter, less bulky, and they consume less power than the CRT monitors.

Types of Flat screen monitors

- **Liquid Crystal Display (LCD) Monitor:** The monitor consists of two polarizing transparent plates and a liquid crystal solution in between them. When an electric current passes through the Liquid, the crystals are aligned to form so that light cannot pass through them. Individual crystal acts like a shutter, either blocking the light or allowing light to pass through.

- **Thin Film Transistor (TFT) Monitor:** This is made up of thousands of small pixels. Each pixel consists of three transistors which are red, green, and blue. Each transistor can produce different intensities of light which allow huge amounts of colours to be produced.

A back light is used to shine light onto these pixels to enable the colours to be produced.
In order to light a single pixel, tiny windows can be opened and closed to allow the light to pass through and onto the pixel.

- **Gas Plasma Display (GPD) monitor**: It is a thin display screen. It works by enclosing neon gas between two plates where each plate is coated with a conductive print. The print on one plate contains horizontal conductive lines and the other plate vertical lines. The two plates form a grid and when electric current is passed through the horizontal and vertical lines, the gas at the intersection glows, creating a pixel. A gas-plasma display can be viewed as a collection of very small neon bulbs.

- **Electroluminescent Display (ELD) Monitor**: This is an optical and electrical phenomenon where a material emits light in response to an electric current passed through it. These monitors refer to a type of display created by sandwiching a layer of electroluminescent material such as Gallium Arsenide (GaAs) between two layers of conductors. When an electric current is passed through a grid, the Gallium Arsenide film at the intersection glows, creating a point of light, or pixel hence an image is created.

![Flat screens](image)

**Fig. 2.33: Flat screens**

**Speakers or Voice Output devices**

These are devices that convert electronic signals from the computer into audible sounds.

This is achieved through the use of transducers such as speakers. A transducer is a device that converts energy from one form to another.

![Speakers](image)

**Fig. 2.34: Speakers**
**Projector**

It is a device that uses light and lenses to take an image, magnify it, and project it onto a larger screen or a wall. They can magnify still or moving images depending on how they are built.

The image must be shown through a sealed tube or frame when passing through the lenses to maintain focus. They are available in different kinds, namely digital/movie, portable, and overhead projectors among others.

![Fig. 2.35: A projector](image)

---

**Learning Activity 2.3**

<table>
<thead>
<tr>
<th>Part 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Define the term input device.</td>
</tr>
<tr>
<td>2. Differentiate between softcopy output devices and hardcopy output devices.</td>
</tr>
<tr>
<td>3. Three categories of input devices are __________, __________, and __________.</td>
</tr>
<tr>
<td>4. State three differences between impact printers and non-impact printers.</td>
</tr>
<tr>
<td>5. Describe how the trackball functions.</td>
</tr>
<tr>
<td>6. Explain three factors to be considered when purchasing an output device.</td>
</tr>
<tr>
<td>7. (a) An example of a keying in device is __________.</td>
</tr>
<tr>
<td>(b) Mention how projectors can be used.</td>
</tr>
</tbody>
</table>

**Part 2**

1. In groups, discuss the following:
   (i) The various types of output devices and their functions.
   (ii) The various types of input devices and their functions.
   (iii) The advantages and disadvantages of each of the input devices and output devices.
2. Observe physically the input and output devices available in the computer room. Record your observations and prepare a class presentation.
3. With the guidance of your teacher, watch video or digital images of the input devices and output devices.
(b) Ports and Connectors

A port is an interface on a computer on which a device can be connected. A connector is a part of a cable that plugs into a port or interface to connect two devices. Connectors can either be male (containing one or more exposed pins) or female (containing holes into which the male connector can be inserted).

Types of ports

<table>
<thead>
<tr>
<th>Port name</th>
<th>Connector</th>
<th>Port</th>
<th>Colour code</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>PS2/ Mouse</td>
<td><img src="image" alt="PS2 Mouse Connector" /></td>
<td><img src="image" alt="PS2 Mouse Port" /></td>
<td>Green</td>
<td>Mouse</td>
</tr>
<tr>
<td>PS2/ Keyboard</td>
<td><img src="image" alt="PS2 Keyboard Connector" /></td>
<td><img src="image" alt="PS2 Keyboard Port" /></td>
<td>Purple</td>
<td>Keyboard</td>
</tr>
<tr>
<td>Game Port/Midi</td>
<td><img src="image" alt="Game Port/Midi Connector" /></td>
<td><img src="image" alt="Game Port/Midi Port" /></td>
<td>Gold</td>
<td>Joystick/Midi devices</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Port name</th>
<th>Connector</th>
<th>Port</th>
<th>Colour code</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analog Microphone Audio input or stereo</td>
<td><img src="image" alt="Analog Microphone Audio Connector" /></td>
<td><img src="image" alt="Analog Microphone Audio Port" /></td>
<td>Pink</td>
<td>Microphone</td>
</tr>
<tr>
<td>Analog line level audio input</td>
<td><img src="image" alt="Analog Line Level Audio Connector" /></td>
<td><img src="image" alt="Analog Line Level Audio Port" /></td>
<td>Light Blue</td>
<td>Microphone</td>
</tr>
<tr>
<td>Port name</td>
<td>Connector</td>
<td>Port</td>
<td>Colour code</td>
<td>Use</td>
</tr>
<tr>
<td>--------------------------------------------------------------------------</td>
<td>-----------</td>
<td>------</td>
<td>-------------</td>
<td>-------------------</td>
</tr>
<tr>
<td>Analog line Audio output for the main stereo signal front speaker of headphones</td>
<td></td>
<td></td>
<td>Lime Green</td>
<td>Speaker</td>
</tr>
<tr>
<td>Analog line level audio output for surround speakers rear speakers</td>
<td></td>
<td></td>
<td>Black</td>
<td>Speaker</td>
</tr>
<tr>
<td>Analog line level audio output side speakers</td>
<td></td>
<td></td>
<td>Silver</td>
<td>Speaker</td>
</tr>
<tr>
<td>Analog line level audio output Centre speaker/subwoofer</td>
<td></td>
<td></td>
<td>Orange</td>
<td>Speaker/Subwoofer</td>
</tr>
</tbody>
</table>

Table 2.3: Types of ports and connectors

<table>
<thead>
<tr>
<th>Port name</th>
<th>Connector</th>
<th>Port</th>
<th>Colour code</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power Desktop computer</td>
<td></td>
<td></td>
<td>None</td>
<td>Desktop computer</td>
</tr>
<tr>
<td>Power Laptop</td>
<td></td>
<td></td>
<td>None</td>
<td>Laptop</td>
</tr>
<tr>
<td>USB 2.0</td>
<td></td>
<td></td>
<td>White</td>
<td>Flask drives/Keyboards</td>
</tr>
<tr>
<td>Port name</td>
<td>Connector</td>
<td>Port</td>
<td>Colour code</td>
<td>Use</td>
</tr>
<tr>
<td>---------------------</td>
<td>-----------</td>
<td>---------------------------</td>
<td>-------------</td>
<td>------------------</td>
</tr>
<tr>
<td>USB 3.0</td>
<td><img src="image" alt="USB 3.0" /></td>
<td><img src="image" alt="USB 3.0" /></td>
<td>Blue</td>
<td>External Hard drives</td>
</tr>
<tr>
<td>USB A / B</td>
<td><img src="image" alt="USB A/B" /></td>
<td><img src="image" alt="USB A/B" /></td>
<td>None</td>
<td>Printer</td>
</tr>
<tr>
<td>ESATA</td>
<td><img src="image" alt="ESATA" /></td>
<td><img src="image" alt="ESATA" /></td>
<td>None</td>
<td>External Hard disk</td>
</tr>
<tr>
<td>Firewire IEEE 1394/6pin</td>
<td><img src="image" alt="Firewire" /></td>
<td><img src="image" alt="Firewire" /></td>
<td>Grey</td>
<td>Camcorders</td>
</tr>
<tr>
<td>Fire IEEE 1394/4pin</td>
<td><img src="image" alt="Firewire" /></td>
<td><img src="image" alt="Firewire" /></td>
<td>Grey</td>
<td>Camcorders</td>
</tr>
<tr>
<td>Parallel Port</td>
<td><img src="image" alt="Parallel Port" /></td>
<td><img src="image" alt="Parallel Port" /></td>
<td>Burgundy</td>
<td>Printer</td>
</tr>
<tr>
<td>Serial Port</td>
<td><img src="image" alt="Serial Port" /></td>
<td><img src="image" alt="Serial Port" /></td>
<td>Teal/Turquoise</td>
<td>Projector</td>
</tr>
<tr>
<td>Ethernet LAN /NIC/ RJ45</td>
<td><img src="image" alt="Ethernet" /></td>
<td><img src="image" alt="Ethernet" /></td>
<td>None</td>
<td>LAN/Hub/Switch</td>
</tr>
<tr>
<td>Port name</td>
<td>Connector</td>
<td>Port</td>
<td>Colour code</td>
<td>Use</td>
</tr>
<tr>
<td>-----------</td>
<td>-----------</td>
<td>------</td>
<td>-------------</td>
<td>------------</td>
</tr>
<tr>
<td>MODEM RJ11</td>
<td></td>
<td></td>
<td>None</td>
<td>Telephone</td>
</tr>
</tbody>
</table>

*Table 2.4: Ports and Connectors dealing with the Output of Video information to the device*

<table>
<thead>
<tr>
<th>Port name</th>
<th>Connector</th>
<th>Port</th>
<th>Colour code</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>S-Video mini Din</td>
<td></td>
<td></td>
<td>Yellow</td>
<td>Video</td>
</tr>
<tr>
<td>RCA Composite</td>
<td></td>
<td></td>
<td>Yellow, White and Red</td>
<td>Video/Audio</td>
</tr>
<tr>
<td>VGA</td>
<td></td>
<td></td>
<td>Blue</td>
<td>Monitor</td>
</tr>
<tr>
<td>Display Port</td>
<td></td>
<td></td>
<td>Black</td>
<td>TV</td>
</tr>
<tr>
<td>HDMI</td>
<td></td>
<td></td>
<td>Black</td>
<td>Monitors/TV</td>
</tr>
</tbody>
</table>
### Storage Devices and Media

These are devices that are used for storing data, information, and instructions. They are divided into three categories, namely primary memory, secondary memory/mass storage, and tertiary storage.

#### (a) Primary Memory

Primary memory refers to the computer’s memory, which interacts directly with the computer’s CPU. It is also known as main memory. There are two types of main memory, namely Random Access Memory (RAM) and Read Only Memory (ROM).

**Random Access Memory (RAM)**

This is a memory in the form of integrated circuits (IC). It is mounted on a printed circuit board as modules and designed for use in computing devices. The contents of this memory can be accessed randomly and hence the name “Random Access Memory”.

RAM is a volatile memory. This means that the contents in it are lost when power is switched off. It holds data temporarily before and after processing; and also holds all the programs currently running together with the data being used by the programs.

*Fig. 2.36 (a): RAM is a volatile memory.*

**Read Only Memory (ROM)**

The ROM is a non-volatile memory. This means that the content in it is not lost when power is switched off. The content in ROM can be read but cannot be changed. It is intended for permanent or semi-permanent storage of data necessary for the operation of a computer system.
(i) **Programmable Read Only Memory (PROM)** is a Read Only Memory that allows the user to alter it only once after the content is written on it.

(ii) **Erasable Programmable Read Only Memory (EPROM)** is a Read Only Memory whose contents can be erased and can be reprogrammed again.

(iii) **Electrically Erased Programmable Read Only Memory (EEPROM)**: It is a type of ROM that can be erased and programmed again using electricity. For example, BIOS for storing Basic Input Output System (BIOS).

(b) **Secondary Memory/Mass Memory**

The computer’s main memory is always limited in terms of permanency and capacity. As a result, there is a need for having an alternative storage. The secondary storage devices provide an alternative long-term storage of data, information and programs. These devices can be classified according to portability, as either **removable** or **fixed** storage devices.

1. **Removable storage media**

   They are called removable storage media because they require either a USB port or an external drive connected to the motherboard using a cable. Examples are magnetic tapes, CD/DVD disk, Jaz disk, Zip disk and floppy disk among others. The units for measuring storage capacity is bytes, kilobytes (KB), megabytes (MB), gigabytes (GB), and terabytes (TB).

   (a) **CD/DVD disk**: They use laser beam of light for reading and writing data.

   (i) **Compact Disk (CD)**: This is a hard plastic disk on which information such as music or computer data is stored. The storage capacity of a CD ranges between 650 MB and 700 MB. They are available in three forms:

   - **Compact Disk Read Only Memory (CD-ROM)**: Data can only be read from it but cannot be written to it. They are popularly used to package and distribute software and music among other types of data.
   - **Compact Disk Recordable (CD-R)**: Once data has been burned on it, it cannot be erased but more data can be added on the empty tracks.
• **Compact Disk Read/Write (CD-RW):** These compact disks allow the user to record, erase, and rewrite new information as many times as desired.

(ii) **VCD (Video Compact Disk):** It is a Compact disk that is able to read and view graphics, data, audio, and video at the same time.

Fig. 2.37: CD-ROM  
Fig. 2.38: CD-R  
Fig. 2.39: CD-RW

(iii) **DVD (Digital Versatile Disk):** They are also known as *Digital Video Disks*. They are optical media used for storing digital data. They resemble CDs but have a higher capacity than the CD. Examples of DVDs are DVD-ROM, DVD-R, DVD-RW and Blu-Ray.

- **DVD-ROM (Digital Versatile Disk - Read Only Memory):** In this media, once data has been written, it cannot be erased or modified. It can only be read.
- **DVD-R (Digital Versatile Disk-Recordable):** Once data has been burned on it, it cannot be erased. It becomes Read Only.
- **DVD-RW (Digital Versatile Disk-Rewritable):** They allow the user to record, erase, amend, and rewrite new information.
- **Blu-Ray:** It is a high definition DVD format that is intended to replace the current range of DVDs. It is used for distributing large amount of material such as movies.

Fig. 2.40: A DVD can hold a minimum of 4.7 GB of data.

- **USB Flash memory:** They are also known as the *memory stick (mem stick)*. Their
capacity ranges between 1 GB and 16 GB.

- **Memory cards**: They are used in digital cameras and mobile phones for storing or transferring data from a device to another. They are inserted in a special slot for data reading and writing. Their capacity ranges between 1 GB and 16 GB.

---

**2. Fixed storage media**

They are known as fixed storage media because they are mounted on the computer motherboard. They are housed inside the computer system unit. An example is the hard disk.

**Hard disk**: A hard disk consists of one or several inflexible circular disks called platters which are coated with a magnetic material normally Iron II Oxide. On each platter data is stored on tracks that are concentric. These platters are held vertically above each other by a spindle to form cylinders. The platter(s), read/write heads and the mechanisms of moving the heads across the surface of the disk are sealed permanently in an airtight metallic casing to protect the assembly from damage.

---

**Tertiary Storage**

The main purpose of tertiary computer storage is to store data on a very large scale. This includes optical jukeboxes and tape libraries. They require a database to organize the data stored in them. The computer needs to go through the database to access the data.
Learning Activity 2.4

Part 1
1. A storage device has a maximum storage capacity of 1.44 MB. How many characters can be stored in this device given that 1 character = 1 byte.
2. State two characteristics of primary memory.
3. A __________ is an interface on a computer on which a device can be connected.
4. Draw the symbols of the following ports:
   (i) PS/2 for keyboard    (ii) Parallel port    (iii) Monitor port
5. Differentiate between parallel port and serial port
6. Describe the structure of a hard disk.

Part 2
1. In groups, discuss the following:
   (i) The various types of storage devices and their functions.
   (ii) The storage capacity for each storage device.
   (iii) The advantage and disadvantage of each of the storage devices
2. Observe physically the storage devices available in the computer room.
3. Name all the ports that are female in the system unit and those that are male.
4. Draw the symbols found in each port in the system unit.

2.2.2 Software

Definition of software
Software is abbreviated as SW or S/W. It refers to a set of instructions that either enable the computer hardware to perform its assigned tasks or help the user to accomplish specific tasks. Software is also referred to as programs.

Classification of Computer Software

Computer software can be categorized in two different classes, namely System Software and Application Software.

1. System software: They are software designed to manage computer resources and provide these resources to the user. There are five types of system software namely: Operating system, Utility software, Firmware, Programming languages and Networking software.
   
   (a) Operating System (OS): This is a group of programs that provide a platform for loading other programs known as application programs. The OS acts as an interface between the hardware and the application programs. Examples of
operating systems include Linux, Ms DOS, MS Windows, OS X, iOS, Android, and UNIX.

(b) Utility software: They are system software that are used to perform routine functions aimed at optimizing, analysing, and maintaining the operations of a computer. They manage computer files, diagnose, repair computer problems and help the computer to run more efficiently. Examples of utility software include Anti-virus, Disk cleaners, Disk Checkers, Disk Compressors, Disk Defragmenter, Disk partitioners, File managers, language translators, graphic editors, and text editors.

(c) Firmware: They are sometimes referred to as stored logic. These are software programs that are stored in the computer’s Read Only Memory (ROM), where they are available for immediate use. They are not affected by loss of power, hence the term firm. An example of firmware is Basic Input Output System (BIOS). Firmware may hold utility programs, language processors, or even operating systems.

(d) Programming Language Software: These are formal constructed languages designed to communicate instructions to a computer. They are used to create programs that control the operations of a machine. They have language translators integrated in them.

2. Application software: They are programs that are designed to enable the user to accomplish a given task. There are two groups of application software, namely customised software and off-the-shelf software.

(a) Customised Software: They are also known as in-house developed software. They are tailor-made to solve a specific problem at hand, or to meet a specific need of the user. They can be modified any time at the user’s request. They only contain features that are required by the user.

(b) Off-the-Shelf software: They are also known as standard software. They are software written by a software engineer or a programmer, packaged, and then made available through a vendor, a distributor, or a developer. Examples include the general purpose software. Examples are Microsoft Word, Open Office Writer and Ms-Access.

<table>
<thead>
<tr>
<th>Learning Activity 2.5</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Part 1</strong></td>
<td></td>
</tr>
<tr>
<td>1. Define the term software.</td>
<td></td>
</tr>
<tr>
<td>2. Differentiate between an application software and a system software.</td>
<td></td>
</tr>
</tbody>
</table>
Learning Activity 2.5

3. Explain three types of system software.
4. Define the term firmware.
5. Two examples of operating systems are _____________ and _____________.
6. State two roles of an operating system.
7. Categorise the following software as either application or system software.
   (i) Sugar                (ii) Antivirus
   (iii) Scratch            (iv) Word processor

Part 2

In groups, discuss the following:
(i) List examples of operating systems.
(ii) Identify the various types of utility software and state their functions.
(iii) Identify the various types of application software and categorise them as either customised or off-the-shelf software.

2.3 Computer Family

The term computer family refers to category of computers with the same operational design and microprocessors that are compatible with each other. Examples of computer families are the IBM or PC versus the Apple or the Mac family. Computers in these families can be classified as Microcomputers, Minicomputers, Mainframe and Supercomputers.

1. Microcomputers

They are popularly known as Personal Computers (PCs). They are designed to be used by one person at a time. They are the smallest, cheapest, and most portable. They are commonly used in offices, for training, entertainment, communication, business enterprises, and in homes among other places.

Examples of microcomputers are desktops, laptops, tablets, and Personal Digital Assistants (PDAs) or palmtops.

- Desktop computers: These are computers designed to be used while placed on top of a desk or a table. They cannot be powered from an internal battery and therefore must remain connected to a wall power outlet. In Rwanda, these are commonly used in offices, schools, and in businesses among other areas.
• **Laptop computers**: These are portable computers. They have all input/output, processing and memory devices inside the system unit. This leaves only a few external accessories to be connected to the ports. These computers are designed to be used while placed on the user’s lap. These are commonly used in offices. The XO laptops are also used in schools with the introduction of One Laptop Per Child Program in Rwanda.

![Fig. 2.44: XO laptop](image)

• **Tablets**: These are small, portable computing devices, similar to a notebook. They are primarily used for Internet access and email. They come with limited features and are relatively cheaper and much lighter compared to laptops. They are used for internet access. In Rwanda, news anchors use tablets as they present the news. They are able to interact with their viewers. Professionals also use tablets to make presentations and read speeches.

**Note**: The main differences between a notebook and a laptop are:

- A laptop has more ports and other plug-in options to allow for connection of additional peripherals compared to a notebook.
- A laptop has both the USB port and an inbuilt Digital Versatile/ Compact Disk drive whereas a notebook only contains the USB port.

• **Palmtops**: They are also referred to as **handheld computers**, or PDAs. They are designed to fit in the palm of the hand and easily fit in a pocket. Due to their small size, they do not have disk drives. However, many contain Personal Computer Memory Card International Association (PCMCIA) slots for expansion of memory and insertion of disk drives and MODEMs among others. They are commonly used in communication.

![Fig. 2.45: Examples of microcomputers](image)
2. **Minicomputers**

They are also referred to as mid-range computers. They are small in size and cheaper.

They have a low processing speed compared to super and mainframe computers. Their storage capacity is higher than that of microcomputers.

They are popularly used to computerize processes in manufacturing industries and production lines, as well as in autopilots in aeroplanes.

In Rwanda, minicomputers are also used as servers in large and medium-sized organizations.

3. **Mainframe computers**

They are the second largest in physical size. They are very large and expensive. They are capable of supporting thousands of users in a computer network simultaneously.

They mostly use operating systems which are based on UNIX and Linux.

Mainframes are used for centralized processing, for example, in large commercial organizations such as government agencies, banks, hospitals, airlines, manufacturing companies, and telecommunication agencies among others.

3. **Supercomputers**

They are the largest in size, fastest, most powerful and most expensive computers. Supercomputers are used to process large amounts of data at very high speed and they solve problems requiring complex calculations within a fraction of a second.

Due to their large size and weight, they are not portable and are housed in a special room that has special cooling system. These computers are mainly applied in scientific research work, for example, in weather forecasting, advanced military applications, and telecommunication companies among others.
Learning Activity 2.6

Part 1
1. Examples of microcomputers are ____________, ____________ and ____________.
2. State two differences between super computers and mainframe computers.
3. Mention two application areas of supercomputers.
4. Describe minicomputers.
5. State two differences between a notebook and a laptop.

Part 2
1. In groups, discuss the following:
   (i) The emergence of new microcomputer devices and how they are used.
   (ii) Discuss whether a supercomputer uses analog or digital technologies.
2. Observe physically some computer family available in the school computer room.

2.4 History (Evolution) of Computers

The evolution of a computer has taken many years and it exists out of inventions by different scientists. The following tools have been invented over time leading to the development of current computers:

(a) **Abacus**: It was the earliest counting tool used by Babylonians in around 300 BC. They later became associated with Chinese more than 2,000 years ago. See figure 2.49 (a) on page 56.

(b) **Pascaline/Mechanical Calculator**: The French mathematician, Blaise Pascal, invented the first mechanical calculator or calculating machine in 1642. It could add and subtract numbers; hence helped his father who was a tax collector.
Analytical Engine and Difference Engine: Charles Babbage was an English mathematician, a philosopher, an inventor and a mechanical engineer. He initiated the concept of a programmable computer.

While Babbage’s machines were mechanical and cumbersome, their basic architecture was similar to a modern computer. He first invented a Difference Engine followed by an Analytical Engine.

(i) Difference Engine: This was an automatic mechanical calculating machine. It could perform mathematical calculations commanded by a fixed instruction program. It was invented around 1822.

(ii) Analytical Engine: This machine was a general purpose, fully program controlled, automatic mechanical and digital computer.

It had all parts of the present day computers. As a result of his invention, Charles Babbage is referred to as the father of modern-day computers. It was invented around 1832.

The main difference between the Difference Engine and the Analytical Engine is that the Analytical Engine could be programmed using punched cards.
In the 1840’s, a mathematician known as Ada Lovelace developed a program for the Analytical Engine. Based on her work, Lovelace is recognised as the first computer programmer.

2.5 Generations of Computers

2.5.1 First Generation Computers (1940’s to mid-1950’s)

The following are the characteristics of the First Generation computers:

(i) They used vacuum tubes or thermionic valves technology for amplification and as switching devices. A thermionic valve is an electronic valve in which electrons are emitted from a heated cathode.

(ii) These computers used the machine language for programming.

(iii) They used magnetic drums for internal memory.

Fig. 2.51: Vacuum tubes (thermionic valves)

Fig. 2.52: The magnetic drum
(iv) **Punched cards** were used for data input.

![Punched cards](image)

*Fig. 2.53: Punched cards were used for data input.*

(v) The output was given in form of printouts.

Some examples of computers in the First Generation are: Electronic Discrete Variable Automatic Computer (EDVAC), Universal Automatic Computer (UNIVAC), Electronic Numerical Integrator and Calculator (ENIAC) and Mark 1.

**Disadvantages of the First Generation Computers**

(i) The vacuum tubes were huge. They, therefore, made the computers heavy and bulky.

(ii) They consumed a lot of electrical power.

(iii) They generated a lot of heat. This resulted in frequent breakdowns.

**2.5.2 Second Generation Computers (mid 1950’s to early 1960’s)**

The following are the characteristics of the Second Generation computers.

(i) They used **transistor technology**. A transistor is a semiconductor device with three terminals. It allows amplification and switching of signals.

(ii) They used the magnetic core for internal memory.

(iii) The magnetic tape was introduced as a secondary memory.

(iv) The assembly language was used for programming.

(v) They used punched cards for input of data.

(vi) Printouts were used for output of information.

Some examples of computers in the Second Generation are: Honeywell 1800, IBM140 and IBM 709.
Advantages of Second Generation computers

Compared to the First Generation computers:
(i) they were smaller due to the use of transistors;
(ii) they produced less heat; and
(iii) they were less prone to hardware failure.

Disadvantages of Second Generation computers

(i) They still produced a lot of heat. They, therefore, required a special cooling system.
(ii) They required frequent maintenance since they easily broke down.

2.5.3 Third Generation Computers (early 1960's to early 1970's)

The following are the characteristics of the Third Generation computers:
(i) They used Integrated Circuits (IC's) technology.
(ii) Magnetic disks and magnetic tapes were used for secondary memory.
(iii) Keyboards were used for data input.
(iv) Monitors were used for data output.
Common Business Oriented Language (COBOL) and Formula Translator (FORTRAN) programming languages were used for programming. Some examples of computers in this generation are: Burroughs B6500, Honeywell-115 and IBM 360.

**Advantages of Third Generation computers**

(i) They were smaller and less expensive than the previous two generations.
(ii) They had a higher processing speed and storage capacity compared to the previous generations.
(iii) They consumed lesser electrical power compared to the previous generations.

**Disadvantages of Third Generation computers**

(i) The initial cost was high due to the sophisticated technology required in the development of Integrated Circuits (ICs).
(ii) Air conditioning was required since they still produced a lot of heat.

**2.5.4 Fourth Generation Computers (early 1970’s to late 1980’s)**

The following are the characteristics of the Fourth Generation computers:

(i) They used Large Scale Integration (LSI) and Very Large Scale Integrated (VLSI) Circuits technology commonly known as **Microprocessor**.

![Microprocessor](image)

(ii) Optical disks, magnetic disks, and magnetic tapes were used as secondary memory.
(iii) Virtual memory was introduced. Virtual memory refers to the use of part of the hard disk as main memory for storing tasks held in the processor. Examples of Fourth Generation computers include IBM 370, Macintosh, Apple II and Honeywell DPS-88.

**Advantages of the fourth generation computers**

(i) They are smaller because of high level of circuit integration; hence they are portable.
(ii) They are cheaper since they are readily available in the market.
(iii) They have very high processing speeds compared to the previous generations.

2.5.5 The Fifth Generation Computers (Early 1990’s to present)

The following are the characteristics of the Fifth Generation computers:
(i) They use parallel architecture and super conductor technology.
(ii) They use Artificial Intelligence (AI). This is the science of developing machines that mimic human behaviour such as reasoning, learning, hearing, seeing, and communicating.

Their goal is to have a machine that can use and process natural language, respond to inputs, learn about its surrounding, and organize itself to adapt to the environment. These computers are still under development and further advancement is still going on.

Learning Activity 2.7

Part 1

1. ____________ is known as the father of modern computers.
2. State two advantages of the Fourth Generation computers.
3. The technology used in the Fifth Generation computers is ________________.
4. Mention three characteristics of the Third Generation computers.
5. ____________ is an example of a First Generation Computer.
6. AI is the abbreviation for ________________.
7. The technology used in the First Generation computers was the ________________.
8. ____________ was used for data input with the First Generation computers.
9. The Second Generation computers used ________________ technology.
10. The Third Generation computers used ________________ technology.
11. The ________________ was used for data input with the Second Generation computers.

Part 2

In groups, discuss the following:
(i) The various computer generations.
(ii) The various types of technology used by the various computer generations.
(iii) Speculate the features of a future computer; one that is not yet in existence. What are likely to be its capabilities.
2.6 Advantages and Disadvantages of Computers

2.6.1 Advantages of a Computer
A computer:
(a) Performs tasks faster and more efficiently than a human being.
(b) Processes the work accurately when correct data is fed into it.
(c) Performs a variety of tasks at the same time and helps the user to solve different problems while at the same time offering entertainment. A user can, for example, play background music while working on other tasks.
(d) Reduces costs: In an automated office environment, a computer is used to perform tasks that would normally be assigned to several officers.
(e) Offers convenient and paperless storage. This saves a company a lot of floor space that would otherwise have been used to store files.
(f) Is automatically programmed to receive instructions. When accurate instructions are fed into a computer, close monitoring of the tasks is not required unlike in the case of manual operations.

2.6.2 Disadvantages of a Computer
(a) A computer cannot reason. It is a machine that is only useful when the installed programs are appropriate for the intended tasks, and also match the skills of the user. This is because it takes in whatever data is fed into it, whether correct or wrong and processes the same. This phenomenon is described as Garbage in Garbage out (GIGO). It is, therefore, upon the user to verify the accuracy of the data entered.
(b) Using computers can lead to some health problems, especially if not properly used. Some of the health risks include eye problems, backache, and wrist injuries.
(c) Computers are expensive to acquire. If they are not taken care of, they can break down easily since they are vulnerable to dust and other environmental factors.
(d) Computers and automation can lead to loss of jobs, especially for computer illiterate persons.

2.7 Areas Where Computers are used
The use of computer technology has reduced the world to be one small village, also known as the global village.

2.7.1 Use of Computers in the Communication Industry
The computer has opened up communication channels. For example:
• Through a computer that is connected to the Internet, one is able to use electronic mail (e-mail). One can send messages (mails) to their friends and relatives living anywhere in the world cheaply and faster.
Computers technology has enabled the generation of digital content leading to high quality signals for television and radio transmission. Computer technology has also enabled communication possible through social media platforms such as Whatsapp! and Twitter.

2.7.2 Use of Computers in the Media Sector

- Advertisement companies use computers to design advertisement bill boards and place them on the streets and at bus stations.

![Billboards](image)

**Fig. 2.63: Bill boards erected in public areas as a medium of communication**

- Digital cameras are used to capture high quality images and pictures which are used in billboards, print media, and broadcasting.
- Television broadcasting has been changed from analog to digital systems.
- News anchors can now use video conferencing in broadcasting.
- Video conferencing facilities have enabled media personnel to broadcast information from two different countries or locations at the same time.
- Smart boards and tablets are used in news or events reporting.

2.7.3 Use of Computers in the Business Industry

- It is possible to buy goods and services from anywhere on the globe through electronic commerce (eCommerce). This involves selling and buying of goods and services through the Internet.
- For businesses that have embraced technology, they have improved their levels of customer service. They offer fast, reliable, and more efficient services, hence gaining competitive edge over their business rivals.
- Computers allow businesses to create websites, advertise their products, and connect with other businesses by uploading their latest articles, product images, and blog posts.
• Accounting software allows businesses to input financial data and analyse it to establish their gains and losses.

• Businesses store data centrally for easy access from multiple computers or stored locally for individual use. Computerized storage saves space and provides a more efficient organization structure.

2.7.4 Use of Computers in the Education Sector

The education sector has improved a great deal due to the integration of computers. In this sector, computers are used as an aid in teaching and learning activities. Students are able to register for courses offered outside their country without having to travel abroad. This is referred to as online learning, and it is done through the Internet.

Information technology has also facilitated education through Computer Aided Learning (CAL) and Computer Based Simulation (CBS).

Computer Aided Learning (CAL): It is also known as Computer Based Training (CBT). This refers to integration of ICT into the learning process. It involves the use of computers in education and training. CAL techniques include:

(a) Educational games: These are electronic games that have content relevant to a subject area. For example, the Carmen Sandiego helps students learn world geography.

(b) Problem solving tutorials: These are self-instructional programs that guide the learner through the resource material acting as their virtual teacher.

(c) Drill and practice: A set of questions from a database are given to students repeatedly to practise skills and concepts. The questions usually have straightforward answers and are therefore very easy for the computer to mark.

Computer Based Simulation (CBS): Computer simulation is the modelling of a real life situation using a computer. It can be used to mimic a real learning situation. For example, it can be used to mimic a chemistry experiment.

2.7.5 Use of Computers in the Entertainment Industry

The following are a few examples of use of computers in the entertainment industry.

• Desktop computers and portable computers are used for playing games. These games can be downloaded from the Internet or they can be bought from vendors.

• Disk Jockeys (DJs) use computerized systems to mix and play music in social events such as weddings and parties.

• Computers have made it possible for artists to produce their content and store it in digital format. They are also able to sell it online.

2.7.6 Use of Computers in the Medical Field
• Computers are used in the medical sector to keep records of patients. In the Intensive Care Unit (ICU), computers are used to control life support machines.
• Machines such as Magnetic Resonance Imaging (MRI) scanners are used to generate images of a human body during medical diagnosis. The MRI is useful in imaging the heart, muscles, the brain, and cancer cells compared with other medical imaging techniques such as X-rays.

![Fig. 2.64: The Magnetic Resonance Imaging (MRI) scanners](image)

• Patients also receive medical diagnosis and advice from medical experts through the use of computerised expert systems.
• Doctors can be reached easily through the use of cell phones and electronic mail (e-mail).
• There are many mobile applications that are used in the medical field. For example, there are applications that are designed to remind patients when to take drugs or go for their clinical appointments.

### 2.7.7 Use of Computers in Security Systems

• Computers are used by the law enforcers to analyse fingerprints. They are matched to the records contained in their database. Through this analysis, they are able to identify and arrest the offenders.
• Security forces also use computer-based face recognition programs and crime scenes analysis to carry out their investigations. This is done through the retrieval and matching of the suspects’ faces with those they have on their security database. Through the application of special software, they are able to model the person’s facial appearance. This automated method of verifying the identity of a person based on physiological or behavioral characteristics is known as biometrics or biometry.
• Computer based systems are also being used in tracking down vehicles. For example, when a vehicle has been carjacked, a car tracking system is able to automatically locate it. In some cases, the tracking system is able to automatically stop the car and
lock the doors until it is recovered.

- Closed Circuit Television (CCTV) systems are used in buildings, homes, streets and shopping malls to monitor the ongoing activities. CCTV systems are the common method in supermarkets for monitoring for shoplifters.
- Computerized metal detector machines are also used to ensure that people and cargo, for example, harmful explosives are not delivered into buildings or restricted environments.

### 2.7.8 Use of Computers in Traffic Control

Computerised systems can be used to control traffic on roads, oceans and air.

(a) **Air traffic control**: Aeroplane traffic service is provided by ground-based controllers who direct aircraft on the ground and in the air. They ensure that aircraft take off and land safely at all times. Every airport has its own air traffic control staff that use computer systems to monitor every single flight. At any given time the air traffic staff will know exactly the position of each aircraft for which they are responsible.

![Automated air traffic control systems](image)

Fig. 2.65: Automated air traffic control systems.

(b) **Ship traffic control**: ICT helps with working out the logistics of shipping by providing a means of monitoring ships efficiently. They help in monitoring ships on the high seas using Geographical Positioning Systems (GPS). Computerized systems also plan the docking, as well as the loading and unloading of cargo. For example, Vessel Traffic Service (VTS) is used for management of traffic and service control.

(c) **Automobile traffic control**: Computerised systems are used for controlling and coordinating traffic lights. Traffic enforcement cameras are used to detect vehicles which violate traffic rules.

### 2.7.9 Use of Computers in Weather Control

Weather forecasting is the prediction of weather conditions using measurements and observations of the current weather conditions. Weather forecasting sensors and instruments collect the data, then send it to computers for storage and analysis. The
data is then displayed in user-friendly graphics and animations that are easy to interpret. The following are some of the systems used in weather forecasting.

- **Doppler radar**: This is a device that uses beams to detect the location of storms, indicate wind direction and speed of wind, and the amount of rainfall, among other weather conditions.

  ![Doppler radar tower](image1)
  ![Radar beams detect storms](image2)
  ![Doppler radar image](image3)

  Fig. 2.66: Doppler radar is a device that analyzes objects at a distance using microwave signals.

- **Weather balloon**: It is a special type of high altitude balloon filled with hydrogen or helium. It is fitted with a device called a **radiosonde** that records weather conditions. The balloon expands as it rises. The device is able to collect information on atmospheric pressure, temperature, humidity and wind speed. When the balloon reaches a point it can no longer expand, it bursts, and launches a parachute that brings back the radiosonde with the weather recordings.

  ![Weather balloon](image4)

  Fig. 2.67: A weather balloon carries a weather measuring device called a radiosonde.

- **Satellites**: They are used to take pictures that help in the creation of weather maps that show type of clouds and the amount of rainfall. An example of such a satellite is the **METEOSAT**.

### 2.7.10 Use of Computers in Office Work

- Computers are used in offices to prepare memos, letters, and reports among others. They can also be used for preparing daily programs for the staff.
- They are also used for the purposes of keeping track of the computer activities
carried out by employees. This is done through the use of log file information.

2.7.11 Use of Computers for Storage

Computers with large storage space are used for storing volumes of files that could otherwise occupy a lot of floor space. It is possible to backup important files in virtual storage sites in what is known as cloud computing. These files can be opened from other locations provided one is connected to the Internet.

2.7.12 Use of Computers in the Manufacturing Sector

Manufacturers use computerised machines called robots to do jobs that may pose danger to human beings. Robots also help to reduce human labour costs. For example, in car manufacturing industries, robots are used to test the car engines at the early stages of development.

Fig. 2.68: Robots assembling a car

Computers are also used for quality and process control in some companies such as chemical industries. Other industries also use computers for inventory control, as well as preparing and processing cheques.

Revision Exercise 2

1. Name three types of ports and the devices that are used with them.
2. State the function of a register in a computer.
3. With the aid of a diagram, explain the Fetch-Execute Cycle.
4. Give two limitations of a voice input device.
5. Mention two ways in which computers have been modified for use by physically
challenged people.

6. Explain three factors to be considered when purchasing an input device.

7. The type of port used to connect a flash disk is the ____________.

8. ROM is the short for ____________.

9. RAM is the short for ____________.

10. Differentiate between RAM and ROM.

11. Differentiate between ports and connectors.

12. The type of port used to connect a smart phone is the ____________.


15. A laptop computer is more expensive than a desktop computer of the same specification. State two reasons for this.

16. State two ways in which computers are used in the education sector.

17. The type of port used to connect a monitor is the ____________.
Key Unit Competencies

By the end of this unit, you should be able to:
(i) Navigate the Windows environment.
(ii) Work with Windows Explorer to introduce the techniques of folder and file management.

Keywords in the Unit

- Customise
- Suites
- Graphics tablet
- Applications
- Screen
- Toolbar
- Clipboard
- BITMAP
- Programs
- CPU
- Accessories
- Desktop

3.1 Desktop

3.1.1 Definitions

- **Desktop** is the first screen that is displayed when a computer boots up. To boot a computer is to start it so that it can load the operating system and make it ready for use. The desktop consists of icons, the task bar, and other features.

- **Desktop Icons**: Icons are images that represent application programs, folders, and files. Icons are usually manipulated using pointing devices. Icons on the desktop include Computer, Documents and the Recycle Bin among others.

- **File**: A file is a collection of data that are stored together. Files can be stored on the hard drive, in a flash memory, or a Compact Disk (CD) among others. Everything that a computer does is based on data stored in files.

- **Folder**: A folder is a specific storage location in a storage media. Folders are used to organize and store related files. A folder may also contain other folders within it which are called subfolders.
Fig. 3.1: The Desktop in Windows 10

- **Task bar**: It is a bar usually at the bottom of a computer screen showing running programs. These programs can be clicked to start software applications or switch between open applications or active windows.

- **Start button**: It is the button in the far left bottom corner of taskbar.

- **Task manager**: It is used to provide information about the programs that are running on a computer, as well as the general status of the computer. Some implementations can also be used to terminate processes and programs, as well as change the processes priority.

- **System tray/Notification area**: This is a part of the taskbar in the desktop interface that displays small icons on the opposite side of the Start Menu such as the clock, date and time, antivirus, and the icons of certain programs so that a user is reminded that they are running in the background.

- **Quick launch**: It is a part of the taskbar near the Start menu where shortcuts to programs are added. This toolbar stays visible for shortcuts to be easily accessed, even when a window is open.
Customizing the Desktop

Customizing refers to personalising the desktop to suit the user’s needs and tastes.

The changes that the user can make to customise include new themes, mouse pointers, backgrounds, user images, and gadgets among others.

(i) To customize, right-click on the desktop. The following dialog box appears:
(ii) Click Personalize.
(iii) Select the desired option from the left pane of the Personalization window as shown in figure 3.2.
(iv) Click on the desired option on the right pane.

Fig. 3.2: The dialog box for customizing the desktop

Fig. 3.3: The dialog box for Customising Theme
**Customizing the taskbar**

To customise the task bar:

(i) Right-click the taskbar.

(ii) Click on the Properties option as shown in figure 3.4.

(iii) A dialog box appears as shown in figure 3.5. Click on the desired option from the window.

(iv) Click the Apply button.

(v) Then OK to apply and close the dialog box.

![Fig. 3.4: Pop-up menu on right-clicking the taskbar](image1)

![Fig. 3.5: Dialog box for customizing the taskbar](image2)
The following are some of the taskbar customisation options:

- **Lock the taskbar**: Check marking this option ensures that the taskbar cannot be moved or changed in size. Any changes can only be made by un-checking.
- **Auto-hide the taskbar**: Check marking this option hides the taskbar until the mouse pointer moves over the area where it is hidden and it pops up. It hides again when the mouse pointer is moved away from it.
- **Use small icons**: This changes the size of the icons on the taskbar and the width of the taskbar.
- **Taskbar location on screen**: It helps position the taskbar at the left, top or right of the screen instead of the default location at the bottom.
- **Taskbar buttons**: Helps select how application icons behave, that is, always combine, hide labels, combine when taskbar is full, and never combine.
- **Notification area**: It is used to select icons and notifications that appear on the taskbar.

### 3.1.2 Explore and customize the start menu

When the start button is clicked, two panes are displayed. The left pane shows the most used programs. The right pane shows icons of programs pinned to the Start menu. The Start menu can be customized as follows:

(i) If a program is not among the most used, click on All Apps. Right-click the Program name then select Pin to Start as shown in figure 3.6.

![Figure 3.6: Customizing the Start Menu](image)

**Fig. 3.6: Customizing the Start Menu**
To remove a program pinned on the start menu, right click on it then select Unpin from start.

To add a program icon to the Taskbar do the following:
(i) Right-click the Program icon then select More button.
(ii) Select Pin to Taskbar option. The program will be automatically added to the Start menu.

![Fig. 3.7: Pinning a program to the taskbar](image)

(iii) To control the items displayed on the Start menu, do the following:
• Click the Start menu, select All Apps then click on Setting. The setting dialog box appears.
• Click on Personalization.
• Click on Start.

To customize Start menu, on the Preview section either, choose On/Off buttons to active or inactivate the items; or click on Choose which folders appear on Start to make other modifications.

### 3.1.3 Recycle bin

**Definition**

It is a container that temporarily stores deleted files and folders before they are permanently deleted. It allows restoring of files and folders that have been deleted accidentally.

**Role of the recycle bin**

**Deleting and Restoring files from the Recycle Bin**

Deleting is the act of erasing files or folder. Deleted files are moved to the Recycle bin. To delete a file permanently, you go to the Recycle bin and delete it again. Restoring is the act of rescuing and retrieving the deleted files and folders from the Recycle Bin.
The deleted files remain in the Recycle Bin until it is emptied. If files have been deleted by mistake, they can be recovered by clicking the Restore button in the Recycle Bin. However, pressing Shift + Delete permanently erases the file without sending it to the Recycle Bin.

To delete a file or a folder, do one of the following:
(i) Click on the file or folder to be deleted. Press the Delete key on the keyboard; or
(ii) Right-click on the file or folder and then select Delete option from the pop-up menu.

The operating system will prompt the confirmation of the deletion by displaying a dialogue box as shown below.

![Prompt message when deleting a file.](image)

(iii) Click Yes to confirm deletion and No to cancel.

To restore a file or folder from the Recycle Bin, do the following:
(i) Right-click on the Recycle Bin icon on the Desktop and select Open from the pop-up menu or double-click the icon.
(ii) Right-click on the file(s) or folder(s) to be restored then select Restore from the pop-up menu. The file or the folder will be taken back to its original location.

To empty the recycle bin, do the following:
(i) Right-click on the Recycle Bin icon on the Desktop and select Open from the pop-up menu; or double-click on the icon.
(ii) Click on Manage tab under Recycle Bin Tools in the menu bar.
(iii) Click on Empty Recycle Bin icon.
(iv) A dialog box appears prompting you to confirm the deletion.
(v) If you are sure of the action, click Yes to conform the deletion otherwise, click No.
Fig. 3.9: The Recycle bin window

Alternatively, right-click on the Recycle Bin icon then select the Empty Recycle Bin command from the pop-up menu.

Fig. 3.10: Emptying the Recycle Bin.

Warning: Once items have been deleted from the Recycle Bin, they cannot be restored. Always keep a backup of your work. Do not attempt to delete program files. If you are unsure about an action, seek guidance from your teacher.

3.2 The Control Panel

It a graphical user interface found on the Start Menu which allows users to view and manipulate basic system settings and controls.
3.2.1 Desktop Background and Theme, Window Colour and Screen saver

**Desktop background and theme**

A background also known as *wallpaper* is an image used to decorate the graphical user interface on the screen.

A theme is a preset package used to customise the look and feel of graphical appearance details. It replaces a computer’s ordinary icons, sounds, pointers, background, or screen saver with a designed pattern to reflect the interests of the user.

To customise the desktop background and theme, do as follows:

(i) Click the *Start* menu, select *All Apps* then click on *Setting*. The setting dialog box appears.

(ii) Click on *Personalization*.

(iii) To change the background, click on *Background*.

(iv) To change theme, click on *Themes* in the left pane then click *Theme Settings* in the right pane.

(v) Click on the desired background or theme.

(vi) Click *Save Theme*. Type the name of the theme then click *Save*.

![Fig. 3.11: Theme settings in Windows 10](image-url)
3.2.2 Mouse Pointer

To customise the mouse pointer, do the following:

(vii) Click Start button, select All apps then click Setting.
(viii) Select Themes in the left pane.
(ix) Click on Mouse Pointer settings hyperlink in the Related Settings section.
(x) Click Pointers tab.
(xi) Select the desired pointer option under Customize.
(xii) Click Apply then OK.

Fig. 3.12: Mouse properties dialog box

3.2.3 Desktop Icons and Gadgets

Icons

Icons are small images used to represent a program, file, folder or commands. The icons are accompanied with a brief description of what it does.

The following procedure is used to customize desktop icons:

(i) Click Start button, select All Apps then click Setting and select Personalization.
(ii) Select Themes in the left pane.
(iii) Click on Desktop Icon settings hyperlink in the Related Settings section.
(iv) Select the icons to appear on the desktop, for example, Computer, Network and Control Panel.
(v) To change the way an icon appears, click on Change Icon button, select a desired option from the window displayed and click the OK button.
(vi) Clicking on Restore Default button reverts the setting to the original factory settings.
(vii) Click Apply then OK to close the window.
Gadgets

A gadget is a small application that is designed to sit on a user’s desktop screen and is capable of performing different tasks. Examples include the clock, CPU meter, and calendar among others.

- To show gadgets on the desktop, right-click the desktop, point to View, and then click Show desktop gadgets.
• You can keep gadgets on top of your open windows so they are always visible. To do this, right-click a gadget, and then click **Always on top**.

• If you do not want a gadget to appear on top of your open windows, right-click the gadget, and then click **Always on top** to clear the check mark.

### 3.2.4 Screen Resolution

Screen resolution determines the clarity of the text and images displayed on the screen. To change the screen resolution:

(i) Click **Start** button, select All Apps then click **Setting** and select **System**.

(ii) Select **Advanced Display Settings** link in the right pane.

(iii) Click on the box below **Resolution**. Select the preferred resolution using the slide bar.

![Screen Resolution dialog box](image)

**Fig. 3.15: Screen Resolution dialog box**

### 3.2.5 Changing Date and Time

To change date and time, do either of the following:

(i) Click **Start** button, select All Apps then click **Setting** and select **Time & Language**.

(ii) Click on **Date & Time** link in the left pane.

(iii) Click on **Change Date and Time** formats. Select the preferred date and time on the respective list boxes then click on the **Back** button.
(iv) Click Change button then select new date and time format on the list boxes displayed. Click Change to apply.

Fig. 3.16: Date and Time dialog box

3.2.6 Keyboard Layout

This refers to the arrangement of keys. To change keyboard layout:

(i) Click the Start button and select Settings.

(ii) Select Time & Language, click on Region & Language on the left pane.

(iii) Under Languages click the language desired and click Set as default.

Fig. 3.17: Region and Language dialog box
3.3 Windows

3.3.1 Definition

A window is an open application on a computer’s display screen. A window shows the program currently running.

3.3.2 Types of Windows

There are two types of windows, namely application and document windows.

(i) Application window: It is the larger window that is displayed when an application is opened, for example, MS Word and MS Excel among others. It helps the user to communicate with the application program.

(ii) Document window: It is the smaller window inside the application window. It is used for typing, editing, drawing and formatting the text and graphics.

3.3.3 Window Control Buttons

There are four window control buttons, namely Minimize, Restore Down, Maximize and Close.

- Minimize: It removes a window from a view to an icon on the taskbar.
- Restore Down: It reduces the size of a window.
- Maximize: It enlarges the window to occupy the entire screen.
- Close: It exits the active program.

3.3.4 Common Windows Accessories

The following are some of the common windows accessories:

(i) File Explorer: It is also known as Windows Explorer. It refers to the graphical file management utility that displays the drives and contents of folders and files in the computer.
(ii) **Math Input Panel**: It is a program whose purpose is to use input devices such as touchscreens, external digitizers or even a mouse, to write mathematical formulas which are recognized and inserted into different types of documents.

![Math Input Panel](image)

**Fig. 3.20: Math Input Panel**

(iii) **Windows Journal**: It is an application program that enables the user to make use of tablet pen to take handwritten notes on a tablet PC (see figure 3.21).

(iv) **Paint**: It is an application program designed for drawing images on the screen using a pointing device. The images are generated as bitmaps (see figure 3.22).
### 3.3.4 Files and Folders

**File**

A file is a group of related data given a unique name for ease of access, manipulation and storage. A file is created by opening a program and entering data in the program.

**Creating a file**

(i) To create a new file, click the File menu in the active program and then click New. A dialog box appears.

(ii) On the right pane, click Create button and select Blank Document under the available templates to create a new file.
Folder

A folder is a specific storage location in a storage media. Folders are used to organize and store related files.

A folder may also contain other folders within it which are called subfolders.

It is important to understand the organisational plan of the folders in the computer system when creating folders.

This helps in knowing where the work has been saved. To create a new folder, use one of the following options:

Creating a folder

(a) Using the menu

(i) Double click This PC icon on the desktop.
(ii) Select the folder/drive where the folder was to be stored. For example, Documents.
(iii) Click on the Home tab in the menu bar select the New folder command in the New group.
(iv) A folder will be automatically created with a default name “New folder” highlighted and surrounded with a box. Type a name for the folder and press Enter.
(b) Using Right Click

(i) Double click This PC icon on the desktop.
(ii) Select the folder/drive where the folder was to be stored. For example, Documents.
(iii) Right-click on an empty space.
(iv) Select New from the drop down menu that appears then click on Folder.
(v) Type the desired name to replace the name New Folder then press Enter.

**Saving**

Saving is the process of storing a document in a storage medium or device for future reference or later use. There are two ways of saving a document:

(i) **Save**: It updates an active or existing document in a given location. If it is a new document, clicking on Save displays the Save As dialog box.

(ii) **Save As**: It allows one to enter a new file name and specify the location where to store the document. If there is an existing file with the same name, the file is overwritten. The file can also be renamed by typing a different file name or specifying a different location.

![Save locations](image)

*Fig. 3.25: Saving a file*

When saving a file for the first time, do the following:

(i) Click on File tab and select Save As command. A dialogue box appears.
(ii) Select the location to save the file from the left pane, for example, in a folder in Documents, or in This PC.
(iii) Type the file name in the **File name** box.
(iv) Click the **Save** button. The document is saved in the selected location.

**Opening a file**

To open a file, do either of the following:

(i) Double-click on the file.
(ii) Right-click and then click **Open** from the pop-up menu.

**Renaming a folder**

Renaming refers to changing the name of a file or a folder. To rename a folder, do the following:

(i) Double click **This PC** icon on the desktop.
(ii) Select the folder/drive where the folder was initially stored. For example, **Desktop**.
(iii) Click on the folder to be renamed.
(iv) Click on the **Home** tab in the menu bar, select the **Rename** command in the **Organize** group. The original name will be highlighted and surrounded with a box.
(v) Type the new name and press the **Enter** key.

**Rename a file**

(i) Right-click on the file to be renamed.
(ii) Select and click **Rename** option from the pop-up menu.
(iii) Type the new name over the old name then press the **Enter** key.

![Renaming a Folder](image1)

![Renaming a file](image2)

**Fig. 3.26 (a): Renaming a Folder**

**Fig. 3.26 (b): Renaming a file**

**Cutting and pasting folders**

Cutting is also known as moving. It is the transfer of the selected file or folder to a new location without leaving a copy at the source location.

It is implemented using the **Cut command**. Once the file(s) or folder(s) to be moved are selected, they can be cut and pasted at any location by use of **menu**, **keyboard shortcuts** or by **dragging and dropping**.

The operating system automatically stores the cut data in a **clipboard** from where it will be pasted to the new location. **Pasting** refers to placing cut file or folder to a new location.
(a) Using the Menu

To move the selected file(s) or folder(s) to another location using menus, do the following:

(i) Double click This PC icon on the desktop.
(ii) Select the folder/drive where the folder was initially stored, for example, Desktop.
(iii) Click on the folder to be moved.
(iv) Click on the Home tab in the menu bar, select the Move to command in the Organize group.
(v) Click on a location from the drop down menu that appears.

(b) Using Keyboard

To move selected file(s) or folder(s) using the keyboard commands, do the following;

(i) Select the folder to be moved. Press Ctrl + X to cut.
(ii) Click on the new location for the folder. Press Ctrl + V to paste.

Cutting and Pasting files

(a) Using Right Click

(i) Select file to be cut.
(ii) Right-click on the file then select Cut option from the pop-up menu.
(iii) Right-click on the new location where the file is to be pasted then select Paste option.
To move the selected file(s) to another location using menus, do the following:

(i) Double click **This PC** icon on the desktop.
(ii) Select the folder/drive where the folder was initially stored, for example, **Desktop**.
(iii) Click on the folder to be moved.
(iv) Click on the **Home** tab in the menu bar, select the **Cut** command in the **Clipboard** group.
(v) Click on the new location and select the **Paste** command in the **Clipboard** group.

**Cutting and Pasting folders**

Copying is duplication of text which means that a copy remains at the source location.

To copy selected file(s) or folder(s) to another location using menus, do the following:

(i) Double-click **This PC** icon on the desktop.
(ii) Select the folder/drive where the folder was initially stored, for example, **Desktop**.
(iii) Click on the folder to be copied.
(iv) Click on the **Home** tab in the menu bar, select the **Copy to** command in the **Organize** group (see figure 3.28 on page 91).
(v) Click on a location from the drop down menu that appears.

To copy selected file(s) or folder(s) using the keyboard commands, do the following:

(i) Select the folder to be moved. Press **Ctrl + C** to copy.
(ii) Click on the new location for the folder. Press **Ctrl + V** to paste.
Fig. 3.28: Copying files to another location

**Copying and Pasting files**

To copy selected file(s) to another location, use one of the following options:

(a) **Right-click**
   (i) Select file to be copied.
   (ii) Right-click on the file then select **Copy** option from the pop-up menu.
   (iii) Right-click on the new location where the file is to be pasted then select **Paste** option.

(b) **Using menu**

To move the selected file(s) to another location using menus, do the following:

(i) Double click **This PC** icon on the desktop.
(ii) Select the folder/drive where the folder was initially stored, for example, **Desktop**.
(iii) Click on the folder to be moved.
(iv) Click on the **Home** tab in the menu bar, select the **Copy** command in the Clipboard group.
(v) Click on the new location and select **Paste** command in the Clipboard group.

(e) **Using Dragging and Dropping**

This option can be used to move or copy file(s) or folder(s). To use drag and drop do the following:

(i) Click the folder(s) or file(s) to be copied or moved.
(ii) Hold down the left mouse button.
(iii) Drag the selected folder to the preferred destination.
(iv) Release the mouse button.

**Note:** Dragging and dropping file or folder in the same drive moves the file or folder to the new location. Dragging and dropping the file or the folder on different drives creates a duplicate.

**Deleting files or folders**

Most Windows Operating Systems usually protect files and folders deleted from the hard disk by placing them in a Recycle Bin.

Files or folders deleted accidentally or prematurely can be retrieved from the recycle bin.

The deleted files and folders remain in the Recycle Bin until it is emptied.

![Fig. 3.29: The Recycle Bin holds the deleted files and folders](image)

Once the Recycle Bin has been emptied, its contents are permanently deleted from the computer and cannot be recovered. To delete a file, do either of the following:

(i) Click on the file or folder to be deleted. Press **Delete**.
(ii) Right-click on the folder to be deleted and then select **Delete** option from the pop-up menu. You will be prompted to confirm the deletion.
(iii) Click **Yes** to confirm deletion and **No** to cancel.

![Fig. 3.30: The user is prompted to confirm the deletion.](image)
Learning Activity 3.1

Part 1
1. A folder within a folder is called a ____________.
2. To ____________ a computer is to start it so that it can load the operating system.
3. The ____________ is used to temporarily hold deleted files.
4. Examples of gadgets in a computer are ____________ and ____________.
5. Define the term task manager.
6. Define these terms: desktop icons and control panel.
7. State and explain three parts of a task bar.
8. Outline the procedure followed to rename a folder.
9. State any two Window control buttons
10. List three accessories found in Microsoft Window.

Part 2
1. Using the taskbar shortcut set the date and time of the computer.
2. In pairs, change the background of the computer.
3. Create a file called Senior1 on the Desktop, delete the file and restore it.

Revision Exercise 3
1. Describe each of the following: Save and Save As.
2. Differentiate between a file and a folder as used in computing.
3. Explain how to customise the taskbar.
4. Explain the role of the Recycle Bin.
5. Explain how gadgets are inserted on the computer desktop.
Safe, Secure and Ethical Use of Computers

**Key Unit Competency**

By the end of this unit, you should be able to maintain a computer in good working condition and use it safely, securely and ethically.

**Keywords in the Unit**

- Ergonomics
- Brushes and swabs
- Fire extinguisher
- Cleaning agent
- Blower
- UPS
- Computer laboratory
- Vacuum cleaner

4.1 Safe Lab Procedure

A computer laboratory, simply known as a computer lab, is a special room set aside for safe storage and use of computer equipment. It is used in learning institutions to enable efficient teaching and learning activities.

4.1.1 Safety Precautions and Practices in a Computer Laboratory

Computers are expensive to acquire. They are also delicate and must, therefore, be handled with great care. It is for this reason that certain rules, precautions, and practices **MUST** be observed when handling the computer and its components. This would help to avoid damage to the computers, injury to the user, as well as provide a conducive environment for teaching and learning. Some safety precautions and practices are discussed below:

**General safety**

The following are some of the general safety precautions and practices:

(i) **DO NOT** run in and out of the computer lab. This may cause one to knock down computer equipment hence causing damage.

(ii) Always cover the computers with dust covers after use to avoid dust accumulation on the machines.

(iii) **DO NOT** carry food or drinks to the computer lab. This is because spilling food or drinks on computer parts can cause damage.

(iv) Reinforce the entrance to the computer lab by use of padlocks, burglar proof doors, and metallic grills to ensure proper security of computer resources.
(v) Ensure that the computer lab is well ventilated to ensure the right amount of temperature and humidity.

(vi) Always shut down the computer using the correct procedure. This is because improper shutting down of a computer can lead to either data loss or crashing of the hard disk. Crashing of the hard disk refers to the permanent damage of the read and write head of the hard disk. The following is the correct procedure for shutting down a computer:

(a) Close all open files and folders.
(b) Select the Start button and select Shut down.
(c) The shut down procedure automatically starts.
(d) Switch off the monitor.

(vii) Always consult the teacher or the technician before performing technical operations.

(viii) Ensure that all the cables in the computer laboratory are laid along the walls.

![General safety precautions and practices signs in the computer lab](image)

**Fig. 4.1: General safety precautions and practices signs in the computer lab**

**Health safety**

The following are some of the health safety precautions to be observed:

(i) The screen resolution should be properly adjusted and where necessary use anti-glare screens to prevent eye strain.

(ii) Use ergonomics chairs, tables, keyboards and mice among others to ensure good posture.
(iii) Ensure there is proper ventilation in the computer lab to ensure good health of the user.

(iv) Always take a break to prevent fatigue or repetitive strain injury.

Electrical safety

The following are some of the electrical safety precautions to be observed:

(i) Be careful when handling power cables and Cathode Ray Tube (CRT) monitors. They contain high voltage that can lead to injuries, electrocution, or even electrical fires.

(ii) Do not attempt to repair power supplies or CRT monitors. Always alert the teacher or the laboratory technician.

(iii) Always connect computers using Uninterruptible Power Supply (UPS). This protects them against damage by power instability.

(iv) Ensure cables are insulated to avoid short circuit or electrical shock.

Fig. 4.2: Proper posture when working on a computer.

Fig. 4.7: The UPS protects the computer against power instability.
Fire safety

The following are some of the fire safety precautions to be observed:

(i) Ensure that the computer lab is equipped with fire extinguishers that are regularly serviced. A fire extinguisher is a device that is used to put out fire (see figure 4.6).

(ii) Ensure that the computer lab has an exit door for use in case of emergency or fire outbreak.

(iii) Ensure that the computer lab has fire or smoke detectors and alarms for warning in case of fire outbreak.

(iv) Do not smoke in the computer laboratory. It may lead to unnecessary fire accidents. Remember that cigarette smoking is harmful to your health. It causes cancer of various body organs.

4.2 Proper use of cleaning tools and fire extinguishers

Cleaning Cloth: A lint-free cloth is used to clean components such as the case drives, mouse, and keyboard because they do not leave residue and will not scratch plastic surfaces. Do not use a cloth to clean any circuitry such as the motherboard and RAM.

Brushes and Swabs: Soft-bristled brushes and swabs that are lint-free are used to dust off the hard-to-reach areas and to wipe stains from electrical contacts.

Blower: It is a portable electric device used to remove dust and dirt from computers. Blowing is done by forcing compressed air through various internal parts of the computer. Always ensure that all doors and windows are open to avoid dust accumulation.

Portable vacuum cleaner: It is a device used for sucking dust, dirt, hair, and other particles when cleaning the computer lab floor and other surfaces as well. There are wet and dry vacuum cleaners that can be used to clean up wet or liquid spills.

Non-static vacuum cleaner: This is a small, hand-held vacuum cleaner that is designed specifically for use on computers to suck up dirt and dust loosened by brush or canned air.
It is advisable not to use the household vacuum cleaner. It creates static electricity that can damage the computer.

![Fig. 4.4: Some cleaning tools](image)

**Canned Air:** Canned air is also known as gas duster or compressed air. It is used to loosen dirt and dust from delicate computer components.

The following are some of the safety precautions when using canned air:

(i) Do not shake the container because it can explode.
(ii) Always keep the liquid **canned air** upright. Turning the can upside down or tilting causes the liquid to spill and this can cause irreparable damage to the computer components that it touches.
(iii) Avoid inhaling canned air because it can lead to death.

![Fig. 4.5: Canned air](image)

**Fire Extinguisher**

It is a metallic cylinder usually red in colour. It contains a substance that puts out a small fire.

The agent is represented by a colour band, for example, black for carbon (IV) oxide, red for water, and blue for dry powder among others.

![Fig. 4.6: Fire extinguisher](image)
The computer laboratory MUST be fitted with gaseous fire extinguishers filled with carbon (IV) oxide to be used in case of fire outbreak. Water-based or powder extinguishers should be avoided because water contains ions which complete an electrical circuit resulting in electric shock. Powder extinguishers, on the other hand, can clog the computer parts thus causing malfunctioning.

**Note**: It is advisable to refer to instructions that come with each fire extinguisher before use.

To use a fire extinguisher, do the following:
(a) Pull the pin. This will allow one to discharge the extinguisher.
(b) Aim at the base of the fire.
(c) Squeeze the top handle or lever to release the pressurised extinguishing agent in the extinguisher.
(d) Sweep from side to side until the fire is completely extinguished.

Your teacher will make arrangements to teach you how to use the fire extinguisher. The school management may consider inviting fire experts to conduct a fire extinguishing drill.

### 4.3 Maintaining your Computer

(i) **General precautions**
- Computers should be connected to the UPS or plugged into a quality surge protector.
- Ensure the anti-virus software is updated regularly. Always scan the computer and the external storage devices before use.
- Always shut down the computer using the correct procedure.
- Avoid placing computers and related components at the edge of the table where they are likely to fall.
- Laptops should be carried in a bag with padding for protection.
- Engage the services of a reputable insurance company to cover the risk in case of loss or damage.

(ii) **Power connectivity**
- Ensure there are enough sockets in the computer lab to prevent overloading.
- Connect the power cable from the main power source to the UPS and to the power supply unit on the computer.
- Correctly turn off the computer when not in use. Always remember to switch off the main power source.
- Install a standby generator that can automatically be used in case of power failure.
Precautions for connecting the mouse, keyboard and other external peripherals

- Connect the peripheral devices to the correct ports, for example, the USB or PS/2 ports for the keyboard and the mouse.
- Do not force peripheral devices into the ports to avoid bending the pins as this can lead to malfunctioning.
- Ensure that monitors are correctly connected.

Maintenance precautions

(i) System unit

- Switch off the computer system and unplug the power cable before removing the system unit cover.
- Use a damp lint-free cloth to clean the outer part of the system unit.
- Avoid using water to clean the internal components to prevent rusting. It is advisable to use a blower or a non-static vacuum cleaner.

(ii) Monitor

- Never spray cleaners directly onto the screen. Instead, use a lint-free cloth dampened with a recommended cleaner to wipe the screen. Use a clean cloth to dry off the screen.
- Clean the outside of the monitor with a recommended cleaning solution.
- Avoid pressing too hard on the screen when cleaning an LCD screen.
- Avoid cleaning the inside of the monitor. Always consult an experienced technician.

(iii) Keyboard

- Do not punch down keys with excessive force since this may damage the components underneath.
- Wipe the outside parts with a dampened lint-free cloth. Be careful to avoid dripping cleaning liquids onto or into the keyboard. If necessary, use a recommended cleaning solution to remove tough dirt. Always make sure that the keyboard is disconnected from the computer.
- Do not remove the keys but instead use canned air and a soft-bristled brush to clean hard-to-reach areas.

(iv) Mouse

- Use a damp lint-free cloth to clean the external part of the mouse.
Learning Activity 4.1

**Part 1**

1. List three general precautions applied on a keyboard.
2. UPS is the abbreviation for ____________.
3. State two health safety practices applied in a computer laboratory.
4. Give three fire safety measures practiced in a computer laboratory.
5. State any three cleaning tools used in a computer laboratory.
6. What are some of the electrical safety measures taken when working in a computer laboratory.

**Part 2**

(i) In pairs, practise how to clean a computer monitor using a recommended cleaning solution.
(ii) In groups, discuss the general precautions carried out in the school computer lab.
(iii) In pairs, demonstrate the general safety measures taken in the computer laboratory.
(iv) Compare safety precautions observed in the chemistry laboratory with those observed in the computer laboratory.
(v) In groups, practise power connectivity precautions taken when connecting computers.

**Revision Exercise 4**

1. Describe the correct posture to take when working on a computer.
2. State five general safety precautions practised in a computer lab.
3. Explain the reason for the use of lint-free swabs to clean the computer keyboard.
4. Explain three ways of maintaining a computer monitor.
5. Explain why non-static vacuum cleaners are recommended to be used in a computer lab.
5.1 Word Processing

5.1.1 Introduction

Word processors were created in order to solve the problems encountered while using a typewriter. They ensure that if there is a typographical error, it can be corrected without compromising the neatness of the document and its structure.

5.1.2 Definition of word processing application

A word processing application is a software that enables the user to create, save, edit, format, and print text documents. It is used to create documents such as letters, memos, reports, and minutes among others. Examples of word processing applications are: Word Perfect, Word Star, Lotus Word Pro, AmiPro and Microsoft Word among others.

5.1.3 Role of word processing applications

(i) Create and manipulate text-based documents.
(ii) Create and manipulate pictures and objects.
(iii) Create a document to be uploaded to the Internet.

5.1.4 Starting word processing applications

Microsoft Word is an example of a word processing application. It is available in various versions incorporated in an integrated package called Microsoft Office Suite.

Examples of Ms Word versions include Ms Word 2000, Ms Word 2003, Ms Word 2007, Ms Word 2010 and Ms Word 2013 among others. Ms Word 2013 has been used in this unit to illustrate the use of a Word Processing application.
Starting Ms Word 2013

To launch Ms Word 2013, do one of the following:

(i) Click on Start Button, go to All Programs and select Microsoft Office; then click on Microsoft Word 2013.

(ii) If the Microsoft Word icon is on the Desktop, do one of the following:
    - Right-click on the icon then select Open from the pop-up menu that appears.
    - Double-click on the icon.
    - Click on the icon then press Enter key.

(iii) Click on Start button then select Microsoft Word 2013 if it was pinned to the Start Menu.

(iv) Click Microsoft Word 2013 if is pinned to the Task Bar.

(v) Click on the Start button go to Search programs and files, type Run then press Enter key. On the dialog box that appears, type the word WINWORD. Click OK.

Fig. 5.1: Microsoft 2013 Word icon

Fig. 5.2: Starting Microsoft Word

5.2 Word Processing Environment

In the environment of a word processor, the following basic tools or features can be used: title bar, tabs, menus, toolbars, scroll bar, ruler, and status bar.

- Title bar: This is the topmost bar on the window. It contains minimize, restore/maximize, and close buttons as well as the name of the program and document. Any time a new word document is opened, Ms-Word gives it a temporary or a default name which could be Document1, Document2, and so on. When the document is saved, the default name is automatically changed to the new name.

- Tabs: This term refers to the part of a window or a dialog box which when clicked, displays different parts of a menu, program window, or webpage.
Fig. 5.3: The Word processing Environment

- **Menu Bar**: This bar displays a series of tabs namely File, Home, Insert, Page Layout, References, Mailings, Review and View. Other tabs appear if an image is inserted. Clicking on each tab displays a different ribbon.
- **File tab**: It is the first item on the menu bar. When clicked it produces a pull-down menu which contains a list of options to choose from such as New, Open, Save, Save As, Print, and Close.
- **Home tab**: It contains icons used for text formatting, paragraph formatting, and editing among others.
- **Insert tab**: It contains icons that allow the user to add graphics and images in a document. It can be used to add pictures, tables and word art among others.
- **Design tab**: It consists of document formatting features, themes and features for formatting page background such as watermark.
- **Page Layout tab**: It contains icons that are used for formatting an entire page and paragraph formatting icons among others.
- **References tab**: It contains icons that are used for creating and manipulating Tables of Contents, Footnotes, Captions, Citation, and Bibliography among others.
- **Mailings tab**: It contains icons that are used during mail merging.
- **Review tab**: It contains icons used for proofreading, adding comments, tracking,
and protection among others.

• **View tab**: It contains icons that are used to show the document views, add macros, zoom, and change the window appearance.

• **Ribbon**: It consists of icons of commands which are organized into groups and given a group name. For example, clicking on the **Home** tab displays a ribbon with five groups namely Clipboard, Font, Paragraph, Styles, and Editing.

• **The Quick Access Toolbar**: This is a small selection of the most commonly used commands. In most cases, it is located at the top left corner of the Title Bar but it can be placed above or below the Ribbon.

It can be customized by adding more commands on it or removing commands from it.

By default, this bar contains Save, Undo and Redo commands.

To customize it:

(i) Right click within the quick access toolbar, select **Customize Quick Access Toolbar** option. A dialog box is displayed.

(ii) Select the commands to add from the left pane then click **Add>>** button.

(iii) To remove the commands from the quick access toolbar, click on the command from the right pane of the window then select **<<Remove** button.

• **Toolbars**: This was a popular feature in the lower versions of MS Word. It refers to stripes that contain icons used for formatting, editing or inserting data. Examples of toolbars are drawing toolbar, formatting toolbar, standard toolbar, and picture toolbar among others. In MS Word 2013, the toolbar icons are incorporated in different ribbons in the window.

• **The Scroll bars**: They allow one to move or navigate through a large document. There are two types of scroll bars. The **vertical scroll bar** allows the content of a document to be moved from top to bottom. The **horizontal scroll bar** allows the content of the document to be moved from left to right and vice versa.
Rulers: The ruler is used to set the layout of the text across the page such as margins, tab positions, and indents. There are two rulers namely the horizontal ruler on top of the document and the vertical ruler on the left side of the document. Refer to figure 5.3. It shows the horizontal and vertical rulers.

Status bar: This bar is usually located at the bottom of the window. It displays information about the activities being carried out in the current document and certain general information about the document such as the current page, word count, view buttons and zoom level tools. Refer to figure 5.3. It shows the status bar.

Working area/zone: This is the largest part of a Word Processing window. It is the area where text and objects are displayed. It is enclosed with the top, bottom, left, and right margin. Any changes done on the typed text and inserted objects are reflected in this part of the window.
Learning Activity 5.1

1. Define the term word processing.
2. The ____________ tab allows the user to add graphics and images in a document.
3. The ____________ displays word count of the current document.
4. Give three examples of word processing applications.
5. State two roles of word processing applications.
6. Explain the use of any five tabs on the menu bar.
7. State the function of a title bar.
8. Label the diagram of the screen layout of Microsoft Word application window shown below.

5.3 Working with Documents

A document can be created, saved, opened, and renamed within the work area.

Creating a Document

It is the process of starting a new blank page from scratch or from an existing document. When the Microsoft Word program is launched, a new document is automatically created. However, to create another new document do one of the following:

• Click the File tab. Select New on the window that appears; then select Blank document; or
• Press Ctrl + N on the keyboard; or
• Click the New icon if it is on the Quick Access Toolbar.

Typing Text

Typing is the process of inputting text on a document. By default, typing begins from the left margin towards the right margin at the cursor position.

Saving a Document

Saving is the process of copying a document from primary memory to a secondary memory for future reference or later use. There are two main commands used when saving a document which are: Save and Save As.

1. **Save**: It is used when updating an existing document. Clicking on Save if it is a new document results in the display of the Save As dialog box. To update a document do one of the following:
   • Click File tab then select Save command.
   • Press Ctrl + S on the keyboard.
   • Click Save icon on the Quick Access Toolbar.

2. **Save As**: It is used when:
   • Saving a document for the first time in the computer.
   • Saving the document using a new file name.
   • Changing the storage location of a document.

To use Save as command do the following:

(i) Click File tab then select Save As command.
(ii) Specify the location where the file is to be stored by clicking My Computer in the first pane then Documents in the last pane.
(iii) In the File name box, type the name of the file.
(iv) Click the Save button or press the Enter key.
Open an existing document

It is also known as retrieving a document. This is the process of viewing the content of an existing document. To open a document, do one of the following:

- Click on the File tab on the menu bar. A pull-down menu appears. Select Open command. Click computer from the left pane then select Browse if the document was not among the recent ones. A dialog box is displayed. Specify the location where the document was previously stored and the file name. Click the Open command; or
- Click on the File tab on the menu bar. A pull-down menu appears. Select Recent Documents command. All recent documents are displayed on the right pane. Click on the desired file name to open it; or
- Open the location where the document was stored then open the document.

Renaming a document

To rename a document:

- Right-click on the document name then select Rename.
- Type the new name at the cursor position then press the Enter key.
5.4 Text Selection

Selecting text or a block of text

The selecting feature allows text or another object to be selected with the mouse or keyboard. When text is selected for formatting or editing, it becomes highlighted. The highlight goes off when the action of formatting or editing is completed, or when one clicks on another area on the screen.

To select any block of text, take the cursor to the beginning of the block of text then do one of the following:
(i) Click and drag the mouse over the text.
(ii) Press Shift + arrow keys, depending on the direction of the desired text.

However, to quickly select the specified text, the following options can be chosen:

<table>
<thead>
<tr>
<th>Option: To select:</th>
<th>Action to be taken</th>
</tr>
</thead>
<tbody>
<tr>
<td>A word</td>
<td>• Double-click anywhere within the word.</td>
</tr>
<tr>
<td>A paragraph</td>
<td>• Triple-click anywhere within the paragraph.</td>
</tr>
<tr>
<td>A sentence</td>
<td>• Press the Ctrl key then click anywhere within the sentence.</td>
</tr>
<tr>
<td>An entire document</td>
<td>• Press CTRL +A</td>
</tr>
<tr>
<td>A line of text</td>
<td>• Take the pointer to the left of the line until it changes to a right pointing arrow and then click.</td>
</tr>
<tr>
<td>Multiple sequential items</td>
<td>• Click the first item</td>
</tr>
<tr>
<td></td>
<td>• Hold down the shift key and click the last item then release the shift key.</td>
</tr>
</tbody>
</table>

Figure 5.11 below shows selected text.

```
Information is power. Be empowered.
Cigarette smoking is harmful to human health.
Say No to cigarettes.
Say No to Drugs and substance abuse.
```

Fig. 5.11: A selected block of text

Deselecting text

To deselect text, click anywhere on or away from the selected text.
Learning Activity 5.1

Part 1
1. Differentiate between Save and Save As commands.
2. What is text selection?
3. The function of the keyboard shortcuts CTRL + N is ______________.
4. The function of the keyboard shortcuts Shift + ↑ ______________.
5. The combination of the keys CTRL + A allows the user to ____________.
6. In wordprocessing, the ____________ feature allows the user to pick out text, objects, and images with the mouse.
7. Outline the procedure of renaming a document.

Part 2

Type the following text and save it as STI in Documents

Sexually Transmitted Infections (STI) are also called sexually transmitted diseases (STD). They are spread from one person to another through unprotected sex or genital contact. STIs can be contracted by both boys and girls of all ages and backgrounds who are engaging in premarital sex.

One reason why STIs spread among young people is because they think they can only be infected if they have sexual intercourse; yet STIs such as genital warts or herpes are contracted through skin-to-skin contact with an infected area or sore.

Another myth about STIs is that a person cannot contract them if they have oral or anal sex. That is inaccurate. The fact is that the viruses and bacteria that cause STIs can enter the body through any tiny cut or tear in the mouth and anus, as well as the genitals.

It is not easy to tell whether someone has STIs or not. Some of the behaviours that increase chances of contracting STIs are:
- Engaging in premarital sexual activity
- Having many different sex partners
- Unprotected sex

5.5 Basic Text Formatting

Formatting is the process of enhancing the appearance of a document, making it attractive or stand out from the rest. Formatting features are divided into two broad categories namely: text and paragraph formatting.
Text formatting

This involves enhancement of the appearance of the text. Some of the common text formatting features includes font, font style, font size, font colour, underline, styles, change case, and font effects among others.

(a) **Font**: A font is a set of printable text characters in specific style and size. Font is a combination of typeface and other qualities such as size and space. Examples of font include Calibri, Times New Roman, Calibri, Arial Black and Arial Narrow among others.

(b) **Font style**: There are four types of font styles namely; bold, italic, regular and bold italics.

(i) **Bold**: makes the selected text appear thicker or darker than the rest of the text in a document. (This text is typed in bold.)

(ii) **Italic**: makes the selected text to slant forward. (This text is typed in italics.)

(iii) **Regular**: It takes up the style defined by the font type used. It is the default style. (This text is typed in regular font.)

![Figure 5.12: The Font dialog box contains commands used for text formatting.](image)
(c) **Font size**: It refers to how small or large the characters are set. The standard size is 12.

(d) **Font colour**: The default font colour is black. The user can, however, change this colour to a desired one, by selecting options from **Font Color box**

(e) **Underline**: It is a line placed under the letter, word, or sentence. There are various underline styles that the user can choose from. Example include words only, double underline and dotted lines.

(f) **Font Effects**: There are various font effects that can be applied on a document in order to enhance the text appearance. These includes superscript, subscript, strikethrough, double strikethrough, all caps, small caps, and hidden.

  **Superscript**: It is where text is formatted to appear slightly above the normal typing line. For example in cm$^3$, the text 3 is a superscript.

  **Subscript**: It is where text is formatted to appear slightly below the normal typing line. For example in “H$_2$O”, the text 2 is a subscript.

  **Strike through**: It is used to cancel already typed text. It draws a line over the text.

To use any of the text formatting features, do the following:

- Select the desired text.
- From the **Home tab**, either select the desired text formatting icon on the **ribbon** under the **Font** group or click on the dialog box launcher (arrow) besides the **Font** group label. From the dialog box that appears, select the **font tab** then select the desired formats and click **OK**.

(g) **Change case**: Refers to the process of switching between the available cases. The following are the various types of cases available:

  (i) **Sentence case**: Only the first character of a sentence is capitalized. In this sentence the first letter of the first word in the sentence is in capital letters.

  (ii) **UPPER CASE**: All the characters in a word or sentence are capitalized.

  (iii) **lower case**: All the characters in a word or sentence are displayed in small letters.

  (iv) **Capitalize Each Word**: The first character of each word in a sentence is in capital letters. It is also known as title case in the lower versions of MS Word.

  (v) **tOGGLE CASE**: All characters in upper case are changed to lower case and vice versa.
The table below illustrates changing case. The original sentence reads as follows:

Abstaining from premarital sex is the most assured way of avoiding contracting the HIV and AIDS and other sexually transmitted infections.

<table>
<thead>
<tr>
<th>Example of sentence</th>
<th>Type of case</th>
</tr>
</thead>
<tbody>
<tr>
<td>Abstaining from premarital sex is the most assured way of avoiding contracting the hiv and aids and other sexually transmitted infections.</td>
<td>Sentence case</td>
</tr>
<tr>
<td>ABSTAINING FROM PREMARITAL SEX IS THE MOST ASSURED WAY OF AVOIDING CONTRACTING THE HIV AND AIDS AND OTHER SEXUALLY TRANSMITTED INFECTIONS.</td>
<td>UPPER CASE</td>
</tr>
<tr>
<td>abstaining from premarital sex is the most assured way of avoiding contracting the hiv and aids and other sexually transmitted infections.</td>
<td>lower case</td>
</tr>
<tr>
<td>Abstaining From Premarital Sex Is The Most Assured Way Of Avoiding Contracting The Hiv And AIDS And Other Sexually Transmitted Infections.</td>
<td>Capitalise Each Word</td>
</tr>
<tr>
<td>aBSTAINING FROM PREMARITAL SEX IS THE MOST ASSURED WAY OF AVOIDING CONTRACTING THE hiv AND aids AND OTHER SEXUALLY TRANSMITTED INFECTIONS.</td>
<td>tOGGLE cASE</td>
</tr>
</tbody>
</table>

Table 5.1: Changing case

To change case, do the following:

- Select the text to be formatted.
- From the Home tab, click on the arrow in the Change case icon under the Font group.
- Select the desired option. Figure 5.13 shows a change case icon.
**Paragraph formatting**

They are features used to improve the appearance of an entire paragraph. They include alignment, indentation, spacing, tabs, Bullets and Numbering.

(a) **Alignment:** It refers to the arrangement of text relative to the left or right margin of a page. There are four types of alignments namely: left, right, centre, and justified alignments.

(i) **Left alignment:** This is where text is evenly positioned along the left margin but uneven at the right margin. Typing begins at the left margin and does not have to end at the right margin.

```
We need to save Mother Earth! It is high time we did something!
The planet we live on is suffering. We are extracting all it has including oil, minerals, and water. We are cutting down trees.
```

*Fig. 5.14(a): Left alignment*

(ii) **Right alignment:** This is where text is evenly positioned along the right margin but uneven at the left margin. Typing begins at the right margin and does not have to end at the left margin.

```
Why are we killing animals? Why are we exploiting nature?
The resources on this Planet are getting depleted. This poses great threat to our existence.
```

*Fig. 5.14(b): Right alignment*

(iii) **Center Alignment:** This is where text is evenly arranged at the center of the page but uneven both at the left and right margins. Typing begins at the centre of the page.

```
Let us do something to save the planet.
Let us start by planting more trees!
Let’s take care of our water sources.
    Let’s take care of the soil.
Let’s conserve the environment.
Our survival is dependent on it.
```

*Fig. 5.14(c): Centred text*

(iv) **Justification:** This is where text is evenly arranged both at the right and left margins.

```
Let us prevent the occurrence of soil erosion. Let’s plant cover crops. Let’s practise contour farming in slopy areas. Let’s keep the right number of animals on a piece of land. We must do something to save the planet. Our survival is dependent on it.
```

*Fig. 5.14(d): Justified text*
Indentation: It is the process of moving text away from the right or left margins by a given interval. They include right, left, and special indents.

(i) Left indent: The lines of text in an entire paragraph are pushed away from the left margin by several units of measurements. The first paragraph in the following text is left indented.

Life is about choices. Whatever choices you make in your day-to-day living, they affect you in one way or the other. Choose to make wise decisions. Do not give in to peer pressure. Make responsible choices. Say No to alcohol. Say No to cigarette smoking. Say no to all harmful drugs and substances.

(ii) Right indent: The lines of text in an entire paragraph are pushed away from the right margin by several units of measurements. The first paragraph in the following text is right indented.

As a student in Senior 1 you are in adolescence stage. You will face many social challenges. Some of these challenges will affect you physically, emotionally and socially. You will experience body changes as you develop into a young adult. There are some adolescents who get affected by the changes. They may suffer low self esteem and become shy. The changes you will experience are normal, and are expected. Make wise choices.

(iii) Special Indents: There are two types of special indents, namely first line and
hanging indents.

- **First line indent**: The first line in a paragraph is pushed away from the left margin by several units of measurements. The other lines in the paragraph remain on the left margin. The first line in the paragraph is indented.

  Gender equality means equal empowerment and participation of boys and girls, and men and women in all areas of life. Both girls and boys can excel in science and art subjects.

  *Fig. 5.15 (c): First line indent*

- **Hanging indent**: The first line of a paragraph remains at the left margin. The rest of the lines in the paragraph are pushed several units of measurements away from the left margin. Hanging indent is applied in this paragraph.

  In all areas of life, both girls and boys should be valued equally. They should all be given opportunities for education and work. Promoting gender equity means treating both boys and girls fairly.

  *Fig. 5.15 (d): Hanging indent*

(c) **Line spacing**: It refers to the distance between lines of the text in a paragraph or a document. The default line spacing is Single. Other options are 1.5 lines, Double, At least, Exactly, and Multiple line spacing.

(d) **Bullets and Numbering**: Bullets and numbering allow text to be organized in lists.

(i) **Bullets**: They are small solid shapes used just before a line of text such as an item in a list. They are used to mark the beginning of a point.

(ii) **Numbering**: This is the use of numbers to list different points. They may be set in Arabic (1, 2, 3, ...) or Roman (i, ii, iii, ...).

To apply line spacing, indentation, bullets and numbering, and alignment do the following:

- Highlight the text. From the **Home tab**, either select the desired paragraph formatting icon on the **ribbon** under the **Paragraph** group; or click on the dialog box launcher besides the **Paragraph** group label. A dialog box appears as shown in figure 5.16(a).

- From the dialog box that appears, select the **Indents and Spacing** tab then select the desired formats and click **OK**.
Borders and Shading: The term border refers to a line separating two parts in a document. For example, to separate two cells in a table, a border can be used. Shading refers to the process of making an area in a document to have a relatively dark tone that produces a shade.

Shading can be applied to a drawing, a table, or a picture. To create borders and shading on a table, do the following:
• Click anywhere within the text.
• Click the Page Layout Tab, in the Page Setup Group, click on the dialog box launcher.
• A dialog box is displayed. Select the Layout tab from the Page Setup dialog box.
• Click on the Borders command. The Borders and Shading dialog box is displayed as shown in figure 5.16(b).

![Borders and Shading dialog box]

Fig. 5.16(b): Creating borders and shading

• Select the Borders tab and specify the settings, style, colour, and width.
• In the Apply to section, specify the area where the border will be effected.
• Click OK to close the dialog box and effect the changes.

(f) Sorting: This is the process of arranging data in a particular order; that is, either in ascending or descending order. Data can be sorted when it is in a paragraph.

Sorting a paragraph of data: A paragraph can be sorted using the first letter in each line. For example, when the following data is sorted in ascending order it will appear as follows:

<table>
<thead>
<tr>
<th>Unssorted</th>
<th>Sorted</th>
</tr>
</thead>
<tbody>
<tr>
<td>I am a patriot.</td>
<td>I am a law abiding citizen.</td>
</tr>
<tr>
<td>I am a law abiding citizen.</td>
<td>I am a patriot.</td>
</tr>
<tr>
<td>I will always defend my country.</td>
<td>I love my country.</td>
</tr>
<tr>
<td>Let us work as a team.</td>
<td>Let us work as a team.</td>
</tr>
<tr>
<td>We must protect our country.</td>
<td>We must protect our country.</td>
</tr>
<tr>
<td>I love my country.</td>
<td>I love my country.</td>
</tr>
</tbody>
</table>

To sort data in a paragraph do the following:
• Select the paragraph. Click on Sort from the Paragraph group in the Home tab. A dialog box appears as shown in figure 5.17. Ensure that the words to be sorted are separated by a comma or by tab stops.
• Under Sort by select Paragraphs. Under Type select Text
• Choose either ascending or descending sort orders. Click OK to apply.
Tabs: Tabs are special buttons on the horizontal ruler. They are used to indicate how far to indent text or where to begin a column of text in a paragraph. By default, the tab stop position is 0.5 inches. The table below shows a summary of the tabs and their purpose. Figure 5.18 shows the location of the tabs in Microsoft Word 2013.

<table>
<thead>
<tr>
<th>Name</th>
<th>Button</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Left tab</td>
<td>![L]</td>
<td>Aligns text to the left</td>
</tr>
<tr>
<td>Centre tab</td>
<td>![L]</td>
<td>Aligns text to the center</td>
</tr>
<tr>
<td>Right tab</td>
<td>![L]</td>
<td>Aligns text to the right</td>
</tr>
<tr>
<td>Decimal tab</td>
<td>![L]</td>
<td>Aligns text at the decimal character</td>
</tr>
<tr>
<td>Bar tab</td>
<td>![L]</td>
<td>Inserts vertical line at the tab stop and aligns text to the right of the line</td>
</tr>
</tbody>
</table>

Table 5.2: Tabs and their purpose
Fig. 5.18: Tabs

Learning Activity 5.3

Part 1

1. Differentiate between subscripts and superscripts.
2. The term __________ refers to a line separating two parts in a document.
3. The __________ allows the user to navigate a document from top to bottom.
4. How can the paragraph indentation measurements be changed from inches to centimeters?
5. The two rulers used to set the layout of text in a page are __________ and __________.
6. Differentiate between bullets and numbers.
7. Define the term sorting.
8. Describe three types of indentations that can be applied in a document.

Part 2

Open the Internet document you created in Learning Activity 5.2 (Part 2) and do the following formatting:

(a) Create a space at the top of the document and type the heading *Sexually Transmitted Infections*, font size 20 points, italicized, bold, centred, and underlined.
(b) Change the line spacing of the second paragraph to 1.5 spacing.
(c) Italicize the word “myth”.
(d) Change the case of the word “genitals” in paragraph 1, 2 and 3 to upper case.
(e) Save the changes as STD1.

5.6 Proofing Features

(a) **Proofing**: This is the process of reading through a piece of write-up in order to find and correct any mistakes before printing. The features that are used for proofing include spelling and grammar checker, Thesaurus, Autocomplete, and Autocorrect. These are found under the **Review Tab**.

(i) **Spelling and grammar checker**: It is a feature that contains an inbuilt dictionary for checking spelling and grammatical mistakes. It notifies the user of the mistakes found on an active document by either using a red wavy line for spelling mistakes or a green wavy line for grammatical errors. It also allows the user to add words in the dictionary.

To make use of this feature do the following:

- Click **Review Tab** from the menu bar. Select **Spelling and Grammar** command from the ribbon under **Proofing** group. A window appears in the right pane.
- To make the correction, select the right word in the **Suggestions** box and click **Change** command button.
- To leave the word or phrase as it is, click **Ignore** button.
- If the word occurs several times in the document, click **Ignore All** to leave all the occurrence of the word as it is.
- To add the word in the dictionary, click **Add** button.

Note: **Ignore All** only appears when there is a spelling error.
Once the spelling and grammar checking process is complete, a dialog box will be displayed. It notifies the user that the spelling and grammar check is complete.

Click the OK button to close the dialog box.

Fig. 5.18: Spelling and grammar dialog box.

To spell-check a document simply press F7 key on the keyboard. Figure 5.19 shows the Spelling and Grammar Complete dialog box.

Fig. 5.19: A dialog box showing that spelling and grammar check has been completed.

(ii) **Thesaurus**: This feature displays synonyms and antonyms of a selected word. **Synonyms** are words with similar meaning while **antonyms** are words with opposite meaning to the selected word.

To use the thesaurus do the following:

- Highlight the word whose synonym or antonym is required.
- Click Review Tab from the menu bar. Select Thesaurus command from the ribbon under Proofing group. A list of words is displayed on the right pane.
of the window.

- Point to the desired word from the resulting list and click on the arrow besides it; then select **Insert** to automatically replace the highlighted word with the selected one.

![Thesaurus](image)

**Fig. 5.20:** Thesaurus displays synonyms and antonyms of a word.

**Moving and copying a section of text**

MS Word contains commands that can be used for moving and copying text from one part of a document to another. These commands are cut, copy, and paste.

(a) **Moving a text**

Moving refers to changing the position of text to a new location. The original text is moved to a clipboard awaiting to be pasted to the new location. A clipboard is a temporary space where all items to be moved or copied are stored before they are pasted to the desired location.

To move text, do the following:

(i) Select or highlight the text. Use one of the following options:

- From Home tab, click **Cut** icon.
- Right-click on the selected text and click **Cut** command from the resulting pop-up menu.
- Press **Ctrl + X** on the keyboard.

(ii) Position the cursor where the text is to be moved.

(iii) To paste, use one of the following options:

How HIV is transmitted
It is transmitted by infected semen or vaginal secretions getting into your body. You can become infected with HIV in several ways, including:

- **By having sex.** You may become infected if you have vaginal, anal or oral sex with an infected partner whose blood, semen or vaginal secretions enter your body. The virus can enter your body through mouth sores or small tears that sometimes develop in the rectum or vagina during sexual activity.
- **From blood transfusions.** In some cases, the virus may be transmitted through blood transfusions. Hospitals and blood banks now screen the blood supply for HIV antibodies, so this risk is very small.
- **By sharing needles or sharp objects.** HIV can be transmitted through needles, razor blades and syringes contaminated with infected blood. Sharing unsterile drug paraphernalia puts you at high risk of HIV and other infectious diseases, such as hepatitis.
- **During pregnancy or delivery or through breast-feeding.** Infected mothers can infect their babies. But by receiving treatment for HIV infection during pregnancy, mothers significantly lower the risk to their babies.

- gore (n.)
- gore
- plasma
- lifefood
- body fluid (Dictionary For
  - life blood (Dictionary For
  - family (n.)
  - kinship
  - folk
  - clan
  - household
  - relations (Dictionary For

blood ➪

We’re not showing definitions because you’re offline.
• Click Home tab, under the Clipboard group, click Paste icon.
• Right-click and select Paste Command from the pop-up menu.
• Press Ctrl + V on the keyboard.

(b) Copying text

Copying refers to creating a duplicate of text. To copy, do the following:

(i) Select or highlight the text or document to be copied.
(ii) Use one of the following options:
• From Home tab, click Copy icon under the Clipboard group.
• Right-click on the selected text and click Copy command from the pop-up menu.
• Press Ctrl + C on the keyboard.
(iii) Position the cursor where the item is to be copied.
(iv) To paste, use one of the following options:
• From Home tab, click Paste icon under the Clipboard group.
• Right-click and click Paste command.
• Press Ctrl + V on the keyboard.

Another copy is created in the new location while the original remains in the previous location.

Moving through the text

(a) Moving through a document using keyboard shortcuts

The keyboard shortcuts can be used for moving through a document. When they are used, the position of the cursor is automatically changed.

The following are some keyboard shortcuts that can be used:
<table>
<thead>
<tr>
<th>Press Keys</th>
<th>To move</th>
</tr>
</thead>
<tbody>
<tr>
<td>Page down (Pgdn)</td>
<td>• Down one screen</td>
</tr>
<tr>
<td>Page up (Pgup)</td>
<td>• Up one screen</td>
</tr>
<tr>
<td>End</td>
<td>• To the end of the current line</td>
</tr>
<tr>
<td>Home</td>
<td>• To the beginning of the current line</td>
</tr>
<tr>
<td>Ctrl + Home</td>
<td>• To the beginning of the document</td>
</tr>
<tr>
<td>Ctrl + End</td>
<td>• To the end of the document</td>
</tr>
</tbody>
</table>

Table 5.3: Keyboard shortcuts used in moving around a document

(b) Scrolling through the text

Scrolling is the process of moving around a document without changing the position of the cursor. The vertical scroll bar is used to move up or down the pages. The horizontal scroll bar is used to scroll from side to side.

Table 5.3: Using the vertical scroll bar

<table>
<thead>
<tr>
<th>To Scroll bar</th>
<th>In the vertical scroll bar</th>
</tr>
</thead>
<tbody>
<tr>
<td>Up one line at a time</td>
<td>• Click on the up scroll arrow.</td>
</tr>
<tr>
<td>Down one line at a time</td>
<td>• Click on the down scroll arrow.</td>
</tr>
<tr>
<td>Multiple pages up or down the document</td>
<td>• Drag the scroll box to the top, bottom or middle of the scroll bar.</td>
</tr>
<tr>
<td>To the previous page</td>
<td>• Click the double-up arrow.</td>
</tr>
<tr>
<td>To the next page</td>
<td>• Click the double-down arrow.</td>
</tr>
</tbody>
</table>

Deleting Text or image in a Document

To delete text or image refers to remove or erase content such as words and pictures from a document. Deleting can be done using the Backspace key and the Delete key.

(i) Backspace key: Erases character by character from the left side of the cursor position to the right.

(ii) Delete key: Erases character by character from the right side of the cursor position to the left.

Typing Modes

There are two typing modes used to edit documents. These are the Insert and the Typeover modes:

(i) Insert mode: It is a typing mode that adds text between words at the insertion point without replacing them as the user types. The existing words are pushed
forward towards the right margin and to the next line when the cursor reaches the right margin. It is the default typing mode.

(ii) **Typeover mode**: It is also referred to as **Overtype** mode. When in this mode, characters are overwritten at the cursor position towards the right margin. Text added at the cursor position automatically deletes and replaces the existing text. To activate overtype mode, do one of the following:

- Press the **Insert** key on the keyboard. To switch back to insert mode press the insert key again.
- From **File** tab, click **Options**. From the **Word Options** dialog box, click the **Advanced** tab then click on the box next to use overtype mode.

**Undo and Redo commands**

(i) The **Undo** command is used to cancel or negate a series of the last commands executed starting with the most recent in order to restore the status of the document.

   Assuming that the following command have been executed in the following order: delete, copy, and paste. When the undo command is executed, the “paste” command will be negated first.

   The next execution of undo command will negate “copy” and another execution of the same command will negate “delete”. The undo command is executed using one of the following options:

   - Press CTRL + Z on the keyboard.
   - Click on the **Undo** command icon on the **Quick Access Toolbar**.

(ii) The **Redo** command is activated only when the undo command had been used earlier. It nullifies a series of the negated actions. The redo command is executed using one of the following options:

   - Press CTRL + Y on the keyboard.
   - Click on the **Redo** command icon on the **Quick Access Toolbar**.

**Find and Replace**

The **Find** command is used to locate a word or phrase within a document. This makes it easy to identify a word or words to be formatted or changed with another.

Assuming that a document has many occurrences of the article “the” and needs to be replaced by the word “an”, the **find and replace** command facilitates this change. The **Replace** command is used to automatically substitute the located word with a new word.
(i) **The Find command**: The following are the steps followed to locate words:

- Click on **Home tab** on the menu bar.
- In the **Editing** group click on the **Find** command. The Navigation task pane appears as shown in Figure 5.21.
- Type the word to search in the **Search Document** box. Press the Enter key.
- All the occurrence of the word will be automatically highlighted on the document and a summary displayed as shown in Figure 5.22.

Note that this task pane can also be shown by pressing CTRL + F on the keyboard.

- Click on the close button in the navigation pane to exit the search as shown in Figure 5.22.

(ii) **The Replace command**

To replace an existing word or phrase with a new one do the following.

- Click on **Home tab** on the menu bar, in the **Editing** group, click on the **Replace** command. A dialog box is displayed as shown in figure 5.24. The box can also be displayed automatically by pressing CTRL + H on the keyboard.
• Type the word to be replaced on the Find what box, and the word to substitute it in the Replace with box.
• Click on the Find Next button to locate the word in the document.
• Either click on Replace button to substitute one occurrence of the word at a time or click on the Replace All button to substitute all the occurrence of the word in the document at once.
• Click Cancel button to stop the procedure and close the dialog box.

![Find and Replace dialog box with replace tab activated.](image)

**Fig. 5.24: The Find and Replace dialog box with replace tab activated.**

<table>
<thead>
<tr>
<th>Learning Activity 5.4</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Part 1</strong></td>
</tr>
<tr>
<td>1. The _____________ a feature that contains an in-built dictionary for checking language mistakes in a document.</td>
</tr>
<tr>
<td>2. The process of reading through a piece of write-up in order to find and correct any mistakes before printing is called the _____________.</td>
</tr>
<tr>
<td>3. A feature that makes the text is made to appear slightly below the normal typing line _____________.</td>
</tr>
<tr>
<td>4. A feature that makes the selected text appear thicker or darker than the rest of the text in a document is _____________.</td>
</tr>
<tr>
<td>5. Differentiate between find command and replace command.</td>
</tr>
<tr>
<td>6. Write the keyboard shortcut used to do the following:</td>
</tr>
<tr>
<td>(i) Move to the end of the document.</td>
</tr>
<tr>
<td>(ii) Move to the beginning of the document.</td>
</tr>
<tr>
<td>(iii) Open the Find navigation pane.</td>
</tr>
<tr>
<td>7. Describe how the vertical scroll bar could be used to move up or down one screen.</td>
</tr>
</tbody>
</table>
Part 2

(a) Open a new document then copy STD1 document created in Learning Activity 5.2 (Part 2) and do the following:
(b) Copy the first paragraph to the bottom of the document.
(c) Move the second paragraph to the paragraph after the words “STI or not”
(d) Delete the fourth paragraph.
(e) Spell check the document.
(f) Find all occurrence of the word “STI” in the document and replace it with the word “STD”.
(g) Save the changes as STD3.

Revision Exercise 5

1. Differentiate between the following: (a) Moving (b) Copying (c) Deleting
2. Distinguish between the spelling and grammar checker and the thesaurus.
3. Differentiate between the delete key and the backspace key.
4. Define the term selecting of text.
5. Outline the procedure used for sorting data in a paragraph.
6. Differentiate between End Key and Home Key functions.
7. The keys represented by Pgdn and Pgup are the ________ and ________.
8. Define the term scrolling through text.
9. Differentiate between undo and redo commands.
10. Describe two types of typing modes that can be used in a word processing application.
6.1 Manipulating a document

A document can be formatted and edited in order to make it error free and appealing. One way through which this can be achieved is through changing the page setup of a document. The other ways are proofreading, adding breaks, styles, columns, and nested lists among others.

6.1.1 Page Setup Group

It is found on the ribbon when the Page Layout tab is clicked. It is used to specify the margins and the orientation of a page among other specifications.

(i) Setting Margins

Page margins are the blank spaces around the edges of a page. Text and graphics are normally inserted in the printable area between the margins. However, some items can be positioned in the margins such as headers, footers, and page numbers among others.

To set the margins do the following:

• Click Page Layout tab, from the Page Setup group and click Margins command.
• Click the margin type desired from the pull-down menu that appears. The margins are automatically adjusted.
• To set a customized margin, either click Margins, then select Custom Margins command or click on the dialog box launcher at the bottom of Page Setup group. A dialog box is displayed.
• Click on Margins tab on the dialog box that appears.
• Specify all the desired options and click OK to apply.

![Page Setup dialog box](image)

Fig. 6.1: Setting margins and orientation

**Orientation**

(i) **Page Orientation**

This refers to the positioning of the page in relation to the text or graphics. There are two types of page orientation.

- **Portrait**: This is where text and graphics are printed with the longest side placed vertically and the shortest placed horizontally.
- **Landscape**: This is where text and graphics are printed with the longest side placed horizontally and the shortest placed vertically.
Change the page orientation of an entire document

To change the page orientation of an entire document, proceed as follows:

(i) Click on the Page Layout tab, in the Page Setup group, click Orientation.
(ii) Select either Portrait or Landscape.

Using both portrait and landscape orientation in the same document

(i) Select the content on the pages or paragraph(s) whose orientation is to be changed to portrait or landscape.

Note: If some but not all of the text on a page is selected to change to portrait or landscape orientation, Word places the selected text on its own page, and the surrounding text on a separate page.

(ii) Click on the Page Layout tab, in the Page Setup group.

(iii) Click Margins, then select Custom Margins command or click on the dialog box launcher in the Page Setup group.

(iv) Click on the Margins tab on the dialog box that appears.

(v) Under the Orientation section, select the desired orientation.

(vi) Under the Apply to section, choose Selected text option.

(vii) Click OK to apply.

Page borders

To create page borders do the following:

• Click anywhere within the page. Click the Design tab, in the Page Background group, click on Page Borders.
• Specify the settings, style, colour, art, and width.
• In the Apply to section, specify the area where the border will be effected.
• To customize the margin, click on Option button.

Fig. 6.2: Page orientation can either be portrait or landscape.
• A dialog box is displayed as shown in figure 6.3.
• Click OK to close the dialog box and effect the changes.

![Borders and Shading dialog box](image)

*Fig. 6.3: Borders and shading dialog box*

![Border and Shading options](image)

*Fig. 6.4: Border and shading options*
**Background**

The background is also known as the **page colour**. It is used to create a more appealing background for online viewing. Backgrounds are visible in all the views except **Draft** and **Outline** view.

Gradients, patterns, pictures, solid colours, or textures can be used for backgrounds. If a document is saved as a Web page, the pictures, textures, and gradients are saved as JPEG (Joint Photographic Experts Group) files and the patterns are saved as GIF (Graphics Interchange Format) files.

A JPEG is a graphics file format with .jpg extension in Microsoft Windows. The JPEG format is supported by many Web browsers. It is used for compressing and storing photographic images. It is best used for graphics with many colours such as scanned photos.

A GIF is a graphics file format with .gif extension in Windows. The GIF format is used to display indexed-colour graphics on the World Wide Web. It supports up to 256 colours and uses lossless compression, meaning that no image data is lost when the file is compressed.

**Adding a background to a document**

Do the following to add a background in a document:

1. Click on the **Design** tab, in the **Page Background** group.

2. Click **Page Color** icon.

3. Do one of the following:
   - Click the desired colour under **Colours**.
   - Click **More Colours** and then select a desired colour.
• Click Effects to add special effects, such as gradients, patterns, or textures. Select the desired colour before applying a gradient or pattern.

To remove a background, do the following:
1. Click on the Design tab, in the Page Background group.
2. Click on Page Colour.
3. Select No Colour.

**Watermarks**

Watermarks are text or pictures that appear behind text in a document. They can be viewed in Print Layout view or in a printed document. If a picture is used as a watermark, it can be lightened or washed out, so that it does not interfere with the legibility of the text in the document.

**Adding a watermark to a document**

Do the following to add watermark:
1. On the Design tab, in the Page Background group, click Watermark icon (see figure 6.5 on page 133).
2. Do one of the following:
   • Select one of the predesigned watermarks, such as Confidential, Urgent or Disclaimer in the pull down menu displayed.
   • Click Custom Watermark command. A dialog box is displayed as shown in figure 6.6.

![Fig. 6.6: Adding a watermark in a document.](image-url)
Select either **Picture watermark** or **Text watermark** options. If the picture watermark is chosen, click on Select Picture button and insert the appropriate picture.

If **Text watermark** option is selected, type the appropriate text in the **Text** box. Make all the other necessary adjustments. Click **OK** to apply and close the dialog box.

**To remove a watermark**

1. Click on the Design tab in the Page Background group, click **Watermark**.
2. Click on **Remove Watermark** command.

---

**Learning Activity 6.1**

**Part 1**

1. There two types of page orientation are ___________ and ___________.
2. ___________ are the blank space around the edges of a page.
3. A ___________ refers to text or pictures that appear in the background of a document.
4. JPEG is the abbreviation for ___________.

**Part 2**

1. Create a new document.
2. Add a watermark “**No Pain, No Gain**” diagonally on the page.
3. Include a background colour of your choice on the document.
4. Add a border and change its measurement to be 0.7 inches from text.
5. Change the page margin to have the following measurements. Left margin 1.2 inch, right margin 0.9 inch, top margin 0.7 inch and bottom margin 0.9 inch.
6. Save the document as **My Page**.

### 6.2 Proofing features

**(a) Track changes**

If this feature is activated, it enables the user to view all the changes that have been done on a document.

To turn on track changes do the following:

- Click on the Review tab in the menu bar, in the Tracking group, click the **Track Changes** icon. Click on track changes again. The **Track Changes** option will be
automatically be turned on. Any changes done to the document will always be highlighted in red.

- To add a track changes indicator to the status bar, right-click the status bar and click Track Changes. Then click the Track Changes indicator on the status bar to turn Track Changes on or off instead of using the menu option.

(b) Comments

A comment can be inserted. A comment is a note that an author or reviewer adds to a document.

Microsoft Word displays the comment in a balloon in the margin of the document or in the Reviewing Pane.

Comments can also be cleared or hidden to ensure that they do not appear in the document.

Adding a comment

To add a comment do the following:

(i) Select the text or item or click at the end of the text.

(ii) Click on the Review tab, in the Comments group, click New Comment. A comment line is added with a comment balloon as shown in Figure 6.6. Type the comment text in the comment balloon.
Fig. 6.8: Inserting comments in a document.

Fig. 6.9: Type the desired comment in the balloon at the cursor position.

Note: To respond to a comment, click its balloon, and then click New Comment in the Comments group on the Review tab. Type the desired response in the new comment balloon.

Deleting a comment

- To delete a single comment, right-click the comment, and then click Delete Comment or click on it then select Delete command in the Comments Group from the Review tab.
- To quickly delete all comments in a document, click a comment in the document. On the Review tab, in the Comments group, click the arrow below Delete icon, and then click Delete All Comments in Document.

(e) Word count

When a document is being typed, Microsoft Word automatically counts the number of pages and words in the document and displays them on the status bar at the bottom of the Workspace.

If the word count is not displayed in the status bar, right-click the status bar, then and click Word Count option.

Counting the Words in a Selection

It is possible to count the number of words in a selected paragraph or sentence. To do this, simply select the text to be counted. Microsoft Word will automatically display the number of words in the selection at the status bar.

For example, 11/2036 means that the selection accounts for 11 words of the total number of words in the document which is 2036.
The Word Count feature

Counting the number of pages, characters, paragraphs and lines

The Word Count dialog box displays the number of pages, paragraphs and lines in a document. It also displays the number of characters, either including or excluding spaces. To view the word count, do the following:

(i) Click on the Review tab.

(ii) In the Proofing group, click Word Count. A dialog box is displayed with all the possible word counts.

Fig. 6.10(b): Word count feature provides a summary list about a document.
Learning Activity 6.2

1. How are watermarks used?
2. Explain the importance of washout feature used when a picture watermark is to be added.
3. State the importance of adding breaks in a document.
4. The _____________ feature allows the user to count the number of words in a document.
5. A _____________ t is a note that an author or reviewer adds to a document.

Open My Page document created in Learning Activity 6A and do the following:
1. Type the National Anthem or your School Anthem.
2. Add the track changes feature.
3. Add a comment line.
4. Write an explanation of each stanza of the anthem in the comment line.
5. Spell check the document.
6. Save the document as Anthem.

6.3 Columns and Breaks

Columns

Columns are created to enhance the look of a document. The flow of the content from the bottom of one column to the top of the next one in the same page should be consistent. Columns can either be created using predefined or user-defined options.

Predefined columns

To create a column, do the following:
- Select the text.
- Click Page Layout tab from the menu bar; then click on the Columns command under Page Setup group.
- Click on the number of columns desired from the drop-down menu displayed.

Fig. 6.11: The Columns menu
User Defined columns

- Select the text.
- Click Page Layout tab from the menu bar then click on the Columns command under Page Setup group.
- Select More Column option from the resulting pull down menu.
- Specify the column width and spacing, line between columns, number of columns, and where the column is to be applied. Click OK to apply once all the desired options have been selected.

![Column dialog box](image)

Fig. 6.12: Column dialog box.

**Breaks**

A break is inserted in order to demarcate the end of a part and beginning of another. There are four types of breaks, namely the page break, column break, section break, and text wrapping break.

(a) **Page Break**: It demarcates the end of one page and the beginning of the next. It is automatically inserted when the bottom margin is reached and a new page created.

To insert a page break, do the following:

- Place the cursor where the page break is to be inserted.
- Click Insert tab, then click the Page Break under Pages group.
(b) **Section Break**: The section breaks include the Next page, Continuous, Even, and the Odd page section break.

Use sections breaks to make (or fence in) other formatting changes on different pages in a document, including:
- Paper size or orientation.
- Headers and footers (remember to unlink the header or footer from its previous section).
- Page numbering (remember to unlink the header or footer from its previous section).
- Line numbering.
- Footnote and endnote numbering.

![Inserting a Page break](image)

**Fig. 6.13: Inserting a Page break**

![A page with different formats in different sections](image)

**Fig. 6.14: A page with different formats in different sections.**
To insert a section break:

Click **Page Layout** tab, in the **Page Setup** group, click **Breaks**. Select the desired type of section break. The following are some examples of section breaks:

(i) **Next Page section break**: This inserts a section break and begins a new section on the next page.

![Fig. 6.15: Next Page break added in a document.](image1)

(ii) **Continuous section break**: This inserts a section break and begins a new section on the same page.

![Fig. 6.16: Continuous section break is useful when there is a need for changing the formatting features.](image2)

A continuous section break is useful when the user would want to change the formatting, such as changing the number of columns, without starting a new page.

(iii) **Even Page section break**: This inserts a new section and begins the new section on the next even-numbered page.

(iv) **Odd Page section break**: This inserts a section break and begins the new section on the next odd-numbered page.

![Fig. 6.17: Odd Page section break.](image3)
(a) **Column breaks**

It is used to indicate that the text following the column break will begin in the next column.

- Click at the position where the column break is to be inserted.
- Click on the Page Layout tab, select Breaks in the Page Setup group and then click Column.

(d) **Text wrapping Break**

Text wrapping breaks are used to separate the text around objects on a page. For example, it can be used to separate caption text from body text.

- Click on the page where the wrapped text is to end.
- Click on the Page Layout tab, select Breaks in the Page Setup group and then click Text Wrapping.

**Note:** Text wrapping breaks are formatting marks that aren’t usually visible in a document. To view these breaks, turn on the formatting marks by clicking Show/Hide in the Paragraph group on the Home tab. The text wrapping break character (¶) will be shown indicating a text wrapping break.

### 6.4 Formatting Text

#### 6.4.1 Styles

A user can create a style of their own using Word 2013 or they can make use of Quick Styles, which make it easy to create a professional and well-designed document faster.

Formatting styles such as Bold, Italics, indent and font size could be applied directly through the Font group or paragraph group in the Home tab. However, if the same formatting is to be used for another heading or even for another document, then it becomes easier to define a style that can be re-used. Styles are specially packaged sets that apply many formats at once. They are there to be used over and over again.

For example, one set of Quick Styles may include styles for several heading levels, body text, Font size, quotes, and title. All of the style colours and formats in a single style set are designed to be used together to create an attractive and readable document.

(a) **Headings**

These are styles that have been defined in word processing application. Every heading comes along with its font size, colour, font and indentation among others. There are four main heading styles that the user can choose from namely: Heading 1, Heading 2, Heading 3 and Heading 4.
The heading styles are necessary when the user want to create a table of contents. They are defined in a heading/subheading. Main heading is given heading 1 style, subheading, heading 2 style and so on. For example:

\[
\begin{align*}
ICT & \quad \text{Heading 1} \\
\text{Senior} & \quad \text{Heading 2} \\
\text{Course Book} & \quad \text{Heading 3} \\
\text{Students' Book} & \quad \text{Heading 4}
\end{align*}
\]

\textit{Fig. 6.18: Heading styles}

(b) \textit{Apply a Style}

Click on the Home tab, in the Styles group, select a set of styles desired. Apply the styles from the convenient Quick Styles gallery as the document is being created.

(c) \textit{Create a Style}

It creates a style based on the formatting of the selected text.

To create a new style and add it to the Quick Styles gallery do the following:

1. Select the text to be used to create the new style.
   For example, if the words “Business Information” is to be formatted so that it always appear as a red Heading 1 in a document.

2. On the Mini toolbar that appears above the selection, select Styles then \textbf{Heading 1} and finally click on \textbf{Red color} to format the text as shown in figure 6.19.

\textit{Fig. 6.19: Applying style}
3. Right-click the selection, click on **Styles** then click **Create a style command**. A dialog box appears as shown in figure 6.20.

![Create New Style from Formatting](image)

*Fig. 6.20: Creating a new style*

4. Give the style a name, for example, Business Info, and then click **OK** or **Modify** to make other changes. The style created appears in the Quick Styles gallery with the given name, ready for application whenever the user desire to apply it.

![Style added](image)

*Fig. 6.21: Adding a new style to the quick style gallery.*

**Clear Formatting**

1. Select the text whose style is to be erased.
2. Right-click the selection, click on **Styles**, and select **Clear Formatting** command. The formatting style will be changed back to the default style automatically.

**6.4.2 Nested lists**

Bullets and numbers are used for the purposes of easier identification of items in the list. Nested lists refer to lists at different levels (sub-lists) that is a list within another list.

To create a nested list, do the following:

(i) Create the list with each item on its own line as shown below:

- Vegetables
- Fruits
- Cereals

(ii) Select the list then, click on the **Numbering** or **Bullets** icons from the **Home** tab in the **Paragraph** group.
(iii) From the resulting menu, select the desired type of bullet or numbering list to automatically apply it. For example:

- Vegetables
- Fruits
- Cereals

To create a nested numbering list under vegetables, do the following:

(iv) Click at the end of the word vegetables.

(v) Press the Enter key and then press on the Tab key. A number is automatically inserted. Type the sublists.

1. Vegetables
   (a) Cabbage
   (b) Carrots
      (i) Source of vitamins
      (ii) Eaten raw or cooked

2. Fruits
   (a) Mangoes
   (b) Oranges
      (i) Source of vitamin C
      (ii) Used to make juice

3. Cereals

Fig. 6.21: Creating a nested list

(v) Press the Enter key and then press on the Tab key. A number is automatically inserted. Type the sublists.

1. Vegetables
(i) Cabbage
(ii) Carrots

2. Fruits
3. Cereals

To create another nested list for carrots which was under vegetables, repeat steps (iv) and (v).

1. Vegetables
   (a) Carrots
      (i) Contain carotene which is rich in vitamin A.
      (ii) Carrots can be eaten raw or cooked.
   (b) Cabbage

2. Fruits
3. Cereals

(vi) To close the current list level, either press the Enter key twice or press shift + tab.

6.4.3 Drop caps

A drop cap is a large capital letter usually at the beginning of a block of text that has the depth of more than one line of regular text. The letter “A” at the beginning of this sentence is a drop cap.

![Drop cap](image)

To set a drop cap proceed as follows:

- Highlight any character within the line of text where the drop cap is to be inserted.
- Click on the Insert tab, select Drop Cap icon under text group.
A drop down menu is displayed.
Select either the Dropped or In margin option.

However, to customize the options:
• Click on the Drop Cap Options. A dialog box will appear, specify the position of the text, the number of lines to drop, font and distance from text.
Click OK to apply.

6.4.4 Headers and footers

Headers are lines of text or graphics that appear above the top margin of a page or selected pages. Footers are lines of text or graphics that appear below the bottom margin of a page or selected pages. To insert a header and footer do the following:
• Click Insert tab from the menu bar; then click on Header or footer command from the ribbon.
• Under Header & Footer group, type the desired content to insert a header or footer respectively. Then press Enter.
• A drop down menu appears. Click on the desired option.

Fig. 6.23: Inserting header and footers.

Page numbering

This is a formatting feature that organises a large document for ease of reference and makes it easy to track by inserting numbers beginning with the first page. To insert page numbers, do the following:
• Click Insert tab on the ribbon that appears.
• Click on Page Number from Header and Footer group (see figure 6.23 above).
• Click on the Page Number icon. The options shown in the figure below will be displayed.
• Choose the preferred option.
Learning Activity 6.3

1. A __________ is a large capital letter usually at the beginning of a block of text that has the depth of more than one line of regular text.
2. Explain how a header can be inserted in a document.
3. List three types of heading styles that can be applied in a document.
4. State the importance of using columns in a document.
5. Differentiate between portrait and landscape orientation

Revision Exercise 6

1. A __________ is a line or block of text appearing at the top of each page of a book or document.
2. Differentiate between an odd page break and an even page break.
3. Explain how column breaks are inserted.
4. Use diagrams to differentiate between the two types of page orientation.
5. Define the term styles.
6. Mention the importance of tracking changes in a document.
7. Three features used for formatting text are __________, __________ and __________.
8. Define the term watermark.
9. Two types of proofing features are __________ and __________.
10. List two types of drop caps that can be used in a document.
Geographic Information Systems (GIS) and Maps

Key Unit Competencies

By the end of this unit, you should be able to:

(i) Define and recognise basic features of GIS.

(ii) Differentiate the elements or components of the interface of the GIS application.

(iii) Query a map and organise map layers.

Keywords in the Unit

<table>
<thead>
<tr>
<th>GIS</th>
<th>Raster Data</th>
<th>Pan</th>
<th>ArcToolbox</th>
</tr>
</thead>
<tbody>
<tr>
<td>Layers</td>
<td>Vector Data</td>
<td>Attribute</td>
<td>Geodatabase</td>
</tr>
<tr>
<td>Shapefiles</td>
<td>Metadata</td>
<td>Bookmark</td>
<td>Python</td>
</tr>
<tr>
<td>ArcCatalog</td>
<td>Query</td>
<td>Toolbars</td>
<td>ArcMap</td>
</tr>
<tr>
<td>Layers</td>
<td>Spatial</td>
<td>Geocoding</td>
<td>OpenGL</td>
</tr>
<tr>
<td>TINs</td>
<td>Basemap</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Introduction

GIS is a system designed to capture, store, manipulate, analyze, manage, and present all types of geographically referenced data; that is, data identified according to their location. GIS applications are tools that allow users to create interactive queries (user-created searches), analyze spatial information, edit data in maps, and present the results of all these operations.

It is a computer-based system that stores geographically referenced data. It links it with non-graphic attributes (data in tables) allowing for a wide range of information processing including manipulation, analysis, and modelling. A GIS also provides for map display and production.

The GIS software is used to take descriptive words of places on earth stored in databases and spreadsheets and display them as map layers. The data is geospatial, that is, for every point to be mapped there is a unique set of numbers, latitudes and longitudes that describe the place.
Geographic Information Systems cover the following areas among others:

- **Natural Resources**: This includes forestry management, habitat identification, and evaluation.
- **Community services**: Examples include fire, ambulance, police, crime investigations, and utility management.
- **Health**: Mapping the spread of infectious agents.
- **Water resources**: Planning water needs, and mapping aquifers among other services.
- **Minerals**: Mapping oil, coal, natural gas deposits, and copper among others.
- **Education**: Mapping population demographics and school distribution.
- **Mapping natural phenomena**: Examples are the occurrence of volcanoes, hurricanes, floods, and earthquakes.

### 7.1 Components of ArcGIS

ArcGIS Desktop contains a set of integrated applications. There are three ArcGIS desktop applications namely the **ArcCatalog**, **ArcMap**, and **ArcToolbox**.

(i) **ArcCatalog**: This application is used for managing spatial data contained in the computer and other locations, managing database designs, recording and viewing metadata. ArcCatalog allows previewing of documents, and organization of geographic data and creation of sophisticated geodatabases to store the data.

(ii) **ArcMap**: This is the main mapping application that allows the creation of maps and query attributes and analyzes spatial relationships and layout of the final projects. It helps in mapping and editing tasks, as well as for map-based analysis.

(iii) **ArcToolbox**: This application is used for data conversion and geoprocessing. These three applications can perform any GIS task, including mapping, data management, geographic analysis, data editing, and geoprocessing.

### 7.2 Defining Terms and Concepts of GIS

- **Java edition (AEJEE)**: AEJEE is an abbreviation for ArcExplorer–Java edition for Education. It allows viewing and querying local data as well as ArcIMS services from the geodata.gov or other hosted sites. AEJEE comes with several pre-packaged project files, as well as sample data to get one started. It is no longer supported by Esri (ArcGIS developer) but it still serves a valuable need for schools using computers with limited capacity.

- **PostGIS**: It is a free open-source extension for PostgreSQL databases. It is used for storing, manipulating, and retrieving spatial data. It adds spatial functions such as distance, area, and intersection to the database.

- **ArcExplorer**: It is a lightweight data viewer. It performs a variety of basic GIS
functions including display, query and data retrieval applications.

- **Layers**: A layer is a method used to display geographic data sets in ArcGIS. Each layer points to a data set and specifies how that data set is represented using symbols and text labels. The features in layers are related to one another. Data set is represented using symbols and text labels.

- **Raster Data**: These are items, usually images that are composed of pixels. The images may be extracts of satellite images, scanned maps, aerial photographs, or any object that shows pixels when enlarged.

- **Vector Data**: These are images such as streets, rivers, railway lines, lakes, city blocks, and any other features that can be drawn on a map.

Images showing raster and vector data are usually represented by (x,y) points or lines as shown in the figures below.
Different Kinds of Vector Data

- **Points (●):** These are dots. They are used to display individual locations or data sampled at specific points such as temperature, pH, and conductivity.
- **Lines:** These are used to represent linear features such as roads, trails, streams, and contour lines.
Learning Activity 7.1

**Part 1**

1. GIS is the abbreviation for ____________.
2. The two types of general data formats used in GIS are ____________ and ____________.
3. Two types of vector data are ____________ and ____________.
4. There are three ArcGIS desktop applications namely ____________, ____________, and ____________.
5. The ____________ allows previewing of documents and organization of geographic data.
6. AEJEE is an abbreviation for ____________.
7. Raster data represents ____________.
8. Pieces of information that provide a description of features in GIS are called ____________.
9. Give five different areas where GIS can be applied.

**Part 2**

Do research on the Internet. Find out the type of institutions in Rwanda that are likely to be using GIS and maps. Find out the basic features of GIS they could be using.

### 7.3 The Interface of ArcMap

ArcMap can be opened from multiple locations. It can be opened from the Start menu or by use of an icon on the desktop.

To launch ArcMap, Click on the ArcMap icon pinned on the status bar. The startup window in figure 7.7 appears.
Click OK. The screen in figure 7.8 appears.
The interface of ArcMap normally consists of Table of Contents (TOC), menu bar, status bar, main window, and toolbars.
If there are existing maps, the dialog box in Figure 7.9 appears:

![Fig. 7.9: Opening an existing map in ArcMap](image)

To open an existing map, select the map then click Open or double-click on the map. Clicking Cancel displays a blank window as shown in figure 7.10.

(i) Start ArcMap by opening the Catalog window. The dialogue box in figure 7.10 appears:
Fig. 7.10: The catalog window

The following steps describe how one can open a new map using a template in an ArcMap:

(ii) To open a new map, a template has to be chosen. Expand Templates (see the labels in figure 7.9).

(iii) Choose either from the Standard page sizes, from the Traditional layouts or Browse for more choices. Figure 7.9 shown on page 158 appears.
(iv) Clicking on World, displays the templates of the continents. Select the desired template, for example, Africa.

Fig. 7.11: Templates under Traditional Layouts

Click OK. The window shown below appears in the map display area of the ArcMap.

Fig. 7.12: A Template of a Map showing the Active Layers
7.3.1 Table of Contents (TOC)

The table of contents is used to manage the contents of the map display. It lists all the layers on the map. It also shows the features that each layer represents.

The table of contents has the following command buttons:

(i) **List By Drawing Order**: The layers are listed by drawing order. Drag and drop to change the drawing order. When the layers tab is right-clicked, the commands are displayed.

![Commands under Layers](image)

**Fig. 7.13: Commands under Layers**

- **Add Data**: The command is used to add new data to the maps in active data frame. Data can also be dragged into the map from the catalog window.
- **New Group Layer**: The command is used to add a new, empty group layer to the active data frame.
- **Copy**:Copies a dataframe(s) to the clipboard.
- **Reference Scale**: Under this command, the reference scale can be set, cleared, or zoomed.
• **Labelling:** The command has the label manager, label priority ranking, label weight ranking, lock labels, pause labelling, and view uplaced labels.

• **Activate:** It makes the data frame become the active data frame. When the map contains more than one data frame, there is always one frame that is active; the one in which the operations being performed are applied.

(i) **List by Source:** The Layers are listed by the geodatabase or folder containing the data source they reference. Tables are also shown. The list according to the source can be different from the list according to the drawing order.

(ii) **List by Visibility:** The Layers are listed according to whether they are turned ON or OFF. A layer can be turned ON or OFF by checking the checkbox next to it. Layers that are turned ON, but not drawn because of the current map scale are listed separately.

(iii) **List by Selection:** Layers are listed by whether their features are selectable by the interactive selection and editing tools. Layers with features selected are listed separately.

(iv) **Options:** It is used to change the behaviour and appearance of the Table of Contents.

### 7.3.2 The Menu Bar

The Menu bar has options such as **File, Edit, View, Bookmarks, Selection, Geoprocessing, Customise, Windows, and Help.**
(a) **The File Tab**

The file tab enables the user to open a **New** window, open an existing file document, **Save** a document, save a document in a different location using **Save As** option, **Save A Copy..**, share a map package using **Share as** option, **Add Data**, **Print**, **Print Preview**, and **Export Maps** among other commands as shown in figure 7.10.

(b) **The Edit Tab**

The edit tab allows the user to **Undo** an operation, **Redo** an operation, **Cut**, **Copy**, **Paste**, **Paste Special**, **Delete**, and **Copy** map to clipboard among other operations as shown in figure 7.10.

(c) **View Tab**

The view tab contains the **Data View**, **Layout View**, **Graph** and **Scroll Bar**, **Status Bar**, **Reports** and **Data Frame** properties among other options.

**Data and Layout View**

ArcMap provides two ways of viewing a map; **data view** and **layout view**. Each view allows one to view and interact with the map in different ways.

- **Data View** provides a geographic window for exploring, displaying, and querying the data on the map. The view allows one to work using real-world coordinates and measurements. If the map contains more than one data frame, the contents of the active data frame will be displayed.
- **Layout View** allows working with the map layout elements such as titles, north arrows, scale bars, and data frame among others.

![Data View and Layout View](image)

*Fig. 7.13: Data View and Layout View are contained in the View Tab*
Fig. 7.14(a): Display of data view

Fig. 7.14(b): Display of layout view
A bookmark is a toolkit that can be used to save a feature to a map. Bookmarks provide shortcuts to a place on a map. When one clicks a bookmark, the map zooms to that location.

The bookmark captures the current point of the map and makes it easy to get back to that point after navigating away. Bookmarks are usually listed in the bookmarks menu and are stored in the map document.

A **Spatial Bookmark** is an electronic marker in a map. It identifies the geography of the map for future reference or retrieval.

### Learning Activity 7.2

**Part 1**

1. Name three parts in the interface window of the ArcMap.
2. The Add Data button is used to ____________.
3. ArcMap has two ways of viewing maps namely the __________ and __________.
4. Zoom In button is used to __________.
5. The Identify tool is used to __________.
6. __________ provides a geographic window for exploring, displaying, and querying data on the map.
7. A __________ is a toolkit that can be used to save a feature to a map.

**Part 2**

1. Explain different ways of launching ArcMap
2. Explain the function of the three command buttons in the table of contents for ArcMap.
3. What is the function of the “Add Data” button?
4. Explain how one can switch between Data View and Layout View in ArcMaps.

### 7.3.3 File Handling with ArcMap

ArcCatalog organizes spatial data stored. It also allows search, preview, and addition of data to ArcMap, as well as managing metadata and setting up address locator services (geocoding).

**ArcCatalog: Data Management**

To open the ArcCatalog, double-click on the ArcCatalog icon on the desktop, or from the Windows Start menu, select the ArcCatalog. After opening the software, the screen in figure 7.15 appears.

![Fig. 7.15: ArcCatalog Interface](image)
The screen lists a set of possible locations for data in the Catalog Tree. The screens may not look exactly the same. It is however easy to add directories for data by clicking on the ‘Connect to folder’ icon 🗂️ on the top left toolbar.

**Previewing Data**

From the catalog tree on the left side, navigate to C:\Program Files\ArcGIS\Desktop 10.3\. A list of files will be displayed with various extensions. For example, the .shp extension of the file means that these files are in shapefile format and thus can be read by ArcGIS.

To be able to view file extensions, navigate to Customize, then select ArcCatalog Options and under the General tab unclick Hide file extensions and hit OK.

Figure 7.16 shows Shapefiles as viewed in GIS data ArcCatalog. A combination of 3 to 7 individual files makes up a shapefile.

![Catalog Tree](image)

**Fig. 7.16: Shapefiles**

**Description Tab**

This tab provides an explanation of the files, spatial information, and a list of all of the attributes associated with a file.

**Properties of Geographic Information Systems**
(a) **Location** – Coordinates are used to give the exact location of an object.

(b) **Attributes** – Provides information about the location, for example, the population and the number of homes in a locality.

(c) **Spatial Relationships** – These are properties associating an object with other objects. These include the shape of the object and the relationship of an object with other objects.

---

**Learning Activity 7.3**

<table>
<thead>
<tr>
<th>Part 1</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1. ___________ organizes spatial data contained on the computer and various other locations.</td>
<td></td>
</tr>
<tr>
<td>2. The list of possible location for data in the catalog is known as ___________.</td>
<td></td>
</tr>
<tr>
<td>3. ___________ are used to give the exact location of an object in the map.</td>
<td></td>
</tr>
<tr>
<td>4. What are attributes for a given data?</td>
<td></td>
</tr>
</tbody>
</table>

**Part 2**

1. What is an ArcCatalog? Explain how it is different from an ArcMap.
2. Name and explain the different types of GIS files.
3. Explain different properties of GIS.

---

### 7.4 Navigation Tools

#### 7.4.1 The Basic Toolbar

Navigation is usually done using tools found in the basic toolbar. They are discussed as follows.

(a) **Zoom In/Out**: Zoom in is a tool used to enlarge the maps for a better view. Figure 7.17 (a) shows the Zoom In tool.

To zoom in, click once on the Zoom In tool and then click anywhere on the map to be enlarged.

Each click enlarges the map by a certain percentage. Zoom out is a tool used to reduce the size of the image.

Figure 7.17 (b) shows the map of the world. To zoom in to Africa, you click and drag around the map. After zooming in the resulting display is shown in figure 7.17(c) on page 170.
Fig. 7.17(a): The Zoom in tool

Fig. 7.17(b): Using the Zoom in tool
Fig. 7.17(c): After zooming in, the map of Africa is enlarged

- To zoom out, click once on the Zoom Out tool and then click anywhere on the map. Each click on the map reduces the map by a certain percentage.
- Zoom in and zoom out can also be done by rolling the mouse scroll wheel in either direction.

(b) Fixed Zoom In/Out: Fixed Zoom in enlarges the image from the center of the page. To zoom, open the image and click on the Fixed Zoom In tool.
- Fixed Zoom out reduces the image from the centre of the page. To zoom out, open the image and click on the Fixed Zoom Out tool.
- Fixed zoom in and zoom out functions can also be performed by rolling the mouse scroll wheel.

(c) Zoom to Full Extent: The tool zooms the image of the map to its full limit. After opening the map, click on the Full Extent tool.

(d) Zoom to Previous/Next: Zoom to previous tool takes the image back to the previous extent after navigating.
- Zoom to the next extent takes the navigator go forward again through the sequence of extents one had viewed.
- The operations can also be performed using the < and > keys on the keyboard.
(e) **Pan**: Pan is to move an image horizontally or vertically from a stationary point in order to view from different angles. The map is panned by dragging on the screen.

- The pan tool can be clicked to re-centre the image or double-clicked to re-centre and zoom in. Holding down the C-key changes the cursor to the pan tool, then use the mouse to move the map.
- The map can also be moved by holding down the scrolling wheel of the mouse.
- To roam around the map, hold down the Q key or hold down the scrolling wheel of the mouse until the shape of the cursor changes, then roam as desired.

### 7.4.2 Query Methods

**Query Using Find Tool**

Find is a navigation tool used to search for locations using address or name of a place to find features that match particular attribute values and to find locations using linear referencing.

**Finding Features**

To find “Kigali” from the map of Rwanda, do as follows:

(i) Click on the Find tool on the Tools toolbar. The find dialogue box shown in figure 7.18 appears. Once the results of find are displayed, each feature can be navigated.

(ii) Click an entry in the results list to flash it in the map (if it is within the map extent), double-click to Pan it (center the map on its location), or right-click to access a shortcut menu of the many operations that can be applied to the Find results.

**Note**: If one is using the default locator service from ArcGIS Online or another locator service on the web, an Internet connection is required to use the Find tool.
**Finding Locations**

To find locations:

(i) Click the Find tool to open the Find dialogue box and click the Locations tab.

(ii) Identity the locator to be used. The window in figure 7.19 appears.

![Fig. 7.19: Find Tool dialog box](image)

(iii) Enter the place name or address to be searched.

(iv) Click the Find button to search for and work with the results.

**Linear Referencing**

The Find tool can be used to locate events and observations with linear referencing onto line features. Linear referencing is the method of storing geographic locations by using relative positions along measured linear features.

One can find locations expressed as measures along routes. For example, one can find measures like the following;

- Find the point location of measure 20 along a certain route.
- An observation that starts at a measurement 36 and ends at 45.

**Query Using Identify Tool**

To view attribute values for a certain feature, use the Identify tool that can be accessed from the Tools toolbar. To use the Identify tool, follow the following steps;

(i) Click the Identify tool on the Tools toolbar.
(ii) Click on a location in the data frame to identify the features at the location. The attributes are presented in the identify window as shown in figure 7.20.

![Image 7.20: Identifying Specified Features](image)

(iii) Alternately, one can create a box to identify a group of features. Click on a location in the data frame, then drag to create a box. A window showing all the features within the selected box appears as shown in figure 7.21.

![Image 7.21: Selecting a Group of Features](image)
The attributes for the highlighted features are displayed at the bottom panel. Right-clicking a feature gives a drop-down menu shown below in figure 7.22. This menu enables more operations such as Zoom to as shown earlier in figures 7.17(a), (b) and (c). Others are Flash, Pan to, Create bookmark, Remove from Tree, Sort Ascending among other features to be performed.

![Menu showing more options for a Feature](image)

**Fig. 7.22: Menu showing more options for a Feature**

Feature geometry is needed to use the Flash, Zoom To, Pan To, and Create Bookmark commands.

In some cases, feature geometry is not available, so these commands are unavailable. These cases include the identification of features from any WMS layer and features from an ArcIMS image service that does not include geometry in any query results.

**Choosing the Layers to Identify**

By targeting layers to identify, one can focus on what is relevant when exploring a map. The Identify Tool can be customized to narrow down the amount of data to be seen by either filtering the layers one is interested in or customizing the field properties of those layers.
The Identify Tool identifies the topmost layer in your map by default. Use the Identify From list at the top of the Identify window to choose the specific layer(s) to identify.

The following options can be used:

- **Topmost layer**: Identifies the attributes of the feature(s) from the layer that is highest in the table of contents drawing order and currently visible. The option does not identify features in a layer that is turned off in the table of contents or currently not being drawn because of the scale of the map. With this setting, one can get the attributes of the feature clicked on without getting the attributes of features in other layers that are drawn underneath that feature.
- **Visible layers**: It identifies the attributes of the features that are currently visible in your map.
- **Selectable layers**: It identifies the attributes of the features belonging to selectable layers. One can manage the list of selectable layers in the table of contents List by Selection view.
- **All layers**: It displays feature attributes for all map layers in the data frame regardless of whether they are in the display or not.
- **A layer**: Select a specific layer in your map. If you choose a particular layer, its features are identifiable even if the layer is currently turned off in the table of contents or currently not being drawn because of the scale of the map.

**Layers in a Map**

A layer represents geographic data in a map, such as a particular theme of data. Examples of map layers include terrain, roads, political boundaries, parcels, streams and lakes, building footprints, and utility lines among others.

Layers are used to display and work with a specific GIS dataset. A layer references the data stored in geodatabases, coverages, shapefiles, imagery, rasters, CAD files, and so on, rather than actually storing the geographic data. A layer will not function in a map unless it has access to the data source on which the layer is based.

**Ordering Layers**
To change the drawing order, click the table of contents List By Drawing Order button, click and hold a layer name, then drag it up or down in the table of contents to a new position.

Fig. 7.23: Layers in a Feature

Removing a Layer

To remove a layer, right-click on the layer to be removed and select the Remove option as shown in figure 7.24.

Fig. 7.24: Removing Layers

Renaming a Layer
To rename a given layer, right click on the layer name and select properties. The screen shown in figure 7.25 appears. In the Layers Name box, type the new name and click Apply, then OK.

![Layer Properties](image)

Fig. 7.25: Renaming a Layer

**Learning Activity 7.4**

**Part 1**

1. The __________ tool enlarges the image from the centre of the page.
2. The __________ enlarges the image of the map to its full limit.
3. The __________ is used move an image horizontally or vertically from a stationary point in order to view it from different angles.
4. The __________ tool is used to search a location.
5. __________ is the method of assigning geographic locations relative positions along measured linear features.
**Part 2**

1. Explain the function of the following tools as used in GIS;
   (i) Fixed Zoom In  (ii) Pan
2. Explain how the Map of Rwanda can be located using the Find tool.
3. What is linear referencing?
4. Explain how the attribute values for Lake Kivu can be determined in GIS.
5. The figure below shows the ArcMap Window. In pairs, label as many features as you can.

---

**Revision Exercise 7**

**Part 1**

1. Explain how the attribute values of Lake Kivu can be determined in GIS.
2. Differentiate between ArcMap and ArcCatalog.
3. What is ArcExplorer?
4. Give multiple locations from where ArcMap can be opened.
5. In the table of Contents, what is List by drawing order?
6. What is spatial bookmark?
7. Give different ways in which a map can be moved to give different angle view.
Network and Internet Fundamentals

Key Unit Competency

By the end of this unit, you should be able to understand the rationale of a computer network and use the Internet efficiently and effectively.

Keywords in the Unit

<table>
<thead>
<tr>
<th>Network</th>
<th>Node</th>
<th>Server</th>
<th>WAN</th>
</tr>
</thead>
<tbody>
<tr>
<td>Website</td>
<td>Server</td>
<td>PAN</td>
<td>Internet</td>
</tr>
<tr>
<td>Wi-Fi</td>
<td>Search</td>
<td>Engines</td>
<td>WWW</td>
</tr>
<tr>
<td>Webpage</td>
<td>URL</td>
<td>E-Mail</td>
<td>Username</td>
</tr>
<tr>
<td>ISP</td>
<td>Cc (Carbon Copy)</td>
<td>Broadband</td>
<td>Protocol</td>
</tr>
</tbody>
</table>

8.1 Computer Network Concepts

8.1.1 Definition of Network

A network is generally described as a system or group of interconnected objects or people.

8.1.2 Definition of Computer Network

A computer network is a set of interconnected computing nodes which communicate with one another through a transmission medium using a set of rules. The nodes share resources and services. A computer network must have sharable resources, transmission medium and set of rules (protocols).

8.1.3 Characteristics of a Computer Network

The following are some characteristics of a computer network:

(i) **Security**: A network must provide protection data from unauthorised access, manipulation and implement policies for recovery from data loss.

(ii) **Reliability**: A computer network should work consistently to perform according to its requirement.

(iii) **Transmission capacity**: It must have two or more computing nodes connected using a transmission medium.
8.1.4 Role of a Computer Network

A computer network can be used to do the following:
(i) Store data centrally for ease of access and backup.
(ii) Communicate with other network users.
(iii) Share resources.

8.1.5 Advantages and Disadvantages of a Computer Network

Advantages of a Computer Network

(i) **Resource sharing:** A computer network allows sharing of resources such as printers among the users in a network thus eliminating the need to have individual printers for each computer. This reduces the cost of purchasing and maintaining the resources.
(ii) **Speed:** A computer network provides a very fast means of sharing and transferring files thus saving time while maintaining file integrity.
(iii) **Communication:** A computer network provides the hardware necessary for exchanging information between the users in the network, for example, use of e-mail.
(iv) **Work group computing:** Many users in different geographical locations can work on a document or a project at the same time using workgroup software and hardware, thus saving time and traveling expenses.
(v) **Security:** A computer network allows administrators to manage critical data by regularly backing up and implementing security measures to control access to critical information.
(vi) Increased storage capacity: Many computers in a network provide a lot of memory that can be shared among the computers to increase the overall storage capacity.


Disadvantages of a computer network

(i) Expensive to install and maintain: High costs are involved in installing and maintaining the network, for example, the cost of cables, file servers, software and technical support services among others.

(ii) Failure of the server and other hardware: The whole network breaks down if the server fails and in some configurations, one broken cable or a malfunction of a node may terminate the functioning of the entire network.

(iii) Insecurity of information: Shared information in a network is exposed to hacking, cracking and eavesdropping among others.

(iv) Spread of computer viruses: Viruses can easily spread to other computers within a computer network.

8.1.6 Classification of computer network according to geographical areas

Types of Networks

There are four main types of computer networks classified according to geographical areas. They are Personal Area Network (PAN), Local Area Network (LAN), Metropolitan Area Network (MAN) and Wide Area Network (WAN).

Personal Area Network (PAN)

It is also known as Wireless Personal Area Network (WPAN). It is the smallest network used for data transmission among devices within the environment of an individual user.

These devices may include bluetooth-enabled devices or infra-red enabled devices such as a wireless printer, a telephone, a TV remote control, a wireless computer keyboard and a mouse among others.

- Bluetooth: This is a wireless protocol that connects electronic devices over a short distance of up-to about 10 meters creating a PAN with a high level of security.
- Infra-red: This is a wireless electromagnetic energy technology with a wavelength longer than those of red visible light. It is use in conveying data from one device to another.
Fig. 8.2: The Personal Area Network (PAN) is the smallest network.

(a) Local Area Network (LAN)

This is a network that covers a small geographical area for example, an office, a building, an institution, or an organization.

Fig. 8.3: The Local Area Network (LAN) covers a small geographical area.
(b) **Metropolitan Area Network (MAN)**

A metropolitan area network covers a city or town. It can be made up of many LANs and can provide Internet connectivity in a Metropolitan region.

![Metropolitan Area Network](image)

Fig. 8.4: The Metropolitan Area Network covers a city or a town.

(c) **Wide Area Network (WAN)**

This is a network that interconnects LANs and MANs within a very large geographical area and may span across regions, country, continents or even the whole world.

![Wide Area Network](image)

Fig. 8.5: The Wide Area Network (WAN) covers across regions, countries, and even continents.

**Differences between LAN and WAN**

<table>
<thead>
<tr>
<th>Local Area Network</th>
<th>Wide Area Network</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Covers a small geographical area.</td>
<td>• Covers a very large geographical area usually world-wide.</td>
</tr>
<tr>
<td>• Transmits data at high speeds (higher bandwidth) because of small distance covered.</td>
<td>• Transmits data at lower speeds (lower bandwidth) because of very large distance covered.</td>
</tr>
<tr>
<td>Local Area Network</td>
<td>Wide Area Network</td>
</tr>
<tr>
<td>--------------------------------------------------------</td>
<td>--------------------------------------------------------</td>
</tr>
<tr>
<td>• Less transmission costs because it is</td>
<td>• High transmission costs because it is</td>
</tr>
<tr>
<td>managed within an organization.</td>
<td>managed by other organizations such as satellite and</td>
</tr>
<tr>
<td></td>
<td>telephone companies</td>
</tr>
</tbody>
</table>

**Learning Activity 8.1**

**Part 1**

1. A ________ is a group of interconnected objects or people.
2. A ________ is a set of interconnected nodes that communicate with one another using a set of rules.
3. A set of rules that allow communication between two or network devices is referred to as ________.
4. A computer connected to a network is referred to as ________ while the one that is not connected is a ________.
5. LAN is a network covering a small geographical area while MAN covers a ________.
7. Apart from LAN and MAN give two other examples of computer networks as classified according to geographical area.

**Part 2**

1. Distinguish between a LAN and a WAN.
2. Give three resources that are shared in a computer network.
3. What are the disadvantages of a computer network?

**Part 3**

Find out the type of network in your school and the neighbouring institutions.

---

**8.2 Internet Concepts**

**8.2.1 Definitions**

**Definition of the Internet**

Internet stands for International Network. It is a worldwide network of computers connecting millions of computer networks via communication media such as telephone lines, wireless connections, and fiber optic.
**Definition of other Terms**

- **World Wide Web (WWW):** It is commonly referred to as the Web. WWW refers to a large virtual space in the Internet where information pages called web pages are installed. The web pages can be accessed using a web browser.

- **Webpage:** This is Hypertext and hypermedia documents containing information about an individual or organization.

- **Website:** A collection of related web pages stored as a single file in a web server.

- **Web browser:** It is commonly referred to as a browser. These are programs used for displaying and viewing web pages on the World Wide Web (WWW), for example, Mosaic, Netscape Navigator, Internet Explorer, Mozilla Firefox, Opera and Google Chrome among others.

- **URL:** It is an abbreviation for Uniform Resource Locator. A website address is commonly known as URL. It is a unique address of each web page in a websites which identifies the location of a specific web page on the Internet.

- The URL consists of three parts namely; protocol, server name and resource ID.

- An example of URL is http://www.techrwanda.com

- **ISP:** This is the abbreviation for Internet Service Provider (ISP) is a licensed organization or company that provides access to the Internet usually at a fee. Examples of ISPs include Rwandatel, Tigo, ISPA, and MTN Rwanda among others.

---

**Learning Activity 8.2**

**Part 1**

1. Define the term Internet as used in computer.
2. The abbreviation ISP stands for ____________.
3. The abbreviation WWW stands for ____________.
4. The abbreviation URL stands for ____________.
5. Differentiate between a web page and website as used in the Internet.
6. Briefly explain the term web browser.

**Part 2**

Explore the Internet. Find out the URL of:
(i) Your school
(ii) The Rwanda Education Board
(iii) other institutions of your choice

### 8.3 History of the Internet

#### 8.3.1 Development of the Internet

The root of today’s Internet came from visionary people in the 1960’s for the purpose of information and research sharing. In 1962 packet switching was developed and it formed the basis of Internet connection. The Advanced Research Projects Agency (ARPANET) which was a branch of the department of defense was the first known fully operational packet-switching network.

In 1969, ARPANET began working on an experiment to determine whether computers at different universities could communicate with each other without a central system.

*Fig. 8.7: Evolution of computers: A large computer being delivered by 13 men*

The corporation Bolt Baranet and Newman developed Interface Message Processor (IMP), the basis of the new communications system. IMPs were small machines which were dedicated to forming the network between computers. They used a technology which split large sections of data into small parts called packets, each labelled with its destination address, and later re-assembled at the destination computer.
In 1970, Vinton Cerf and others, published a proposal for protocols and later ARPANET began operating Network Control Protocol (NCP) to enable computers to communicate. In 1974, Vinton Cerf together with Bob Kahn presented their protocol for packet network interconnection, which became the basis of the modern Internet. In 1978, TCP was split into two protocols TCP/IP (Internet Protocol).

In 1982, TCP/IP was established as the protocol for ARPANET and by January 1983, all of the ARPANET was switched over from NCP to TCP/IP.

By the end of the 1980’s, a young British Scientist, Tim Berners-Lee assigned a common system of written addresses and hypertext links to all information. Hypertext is the organization of information units into connections that a user can make.

In 1990, Lee started working on a hypertext graphical user interface browser and editor. By 1991 the first World Wide Web (WWW) files were made available on the net for downloading using File Transfer Protocol (FTP). The mid 1990’s saw the introduction of search engines and by late 1990’s Independent Internet Service Providers (ISPs) such as Sprint and AT&T had so many subscribers.

In 1993, the world started waking up to the WWW and at least 200 known HTTP servers were connected. In 1994, Netscape Communications was born and Microsoft created a Web browser for Windows 95.

Later in 1998 Google search engine was born changing how users engaged with the Internet.

Today the Internet is everywhere, enabling people to communicate and share interests in many ways more faster using sites such as Facebook, Twitter, Linked-In, YouTube, blogs, wikis, and many more.

8.3.2 Internet Uses in Daily life

Internet can be used in the following ways in daily life;

(a) **Communication**: Through electronic mails (e-mails), social sites, chat rooms and newsgroups, the public and employees in both government and private sector can easily exchange information within and outside the country. Rwandans, for example, get real time updates about the Stock exchange’s daily market. This enables them to make informed investment decisions.

(b) **Research**: People use the Internet to get information on various topics. For example, university students in Rwanda are able to use the internet to research on topics of study.

    Research firms in Rwanda also use the Internet to carry out research. It is possible to conduct an interview using online platforms such as filling in Google forms.
(c) **Business**: Customers can buy and sell goods and services through the Internet. They can pay for the goods and services through Electronic Funds Transfer (EFT), cheques and credit cards among others.

In Rwanda, people are able to buy goods from other countries in the comfort of their homes. For example, through Visa card transaction systems, a Rwandan bank account holder in Bank de Kigali is able buy an electronic book from Amazon.com. A trader is also able to sell a product made in Rwanda to customers around the World. There are also advertising platforms that are used. For example, the Rwanda Development Board’s tourism department is able to attract more tourists through its Adverts on Google.

(d) **Education**: The Internet is used in various ways such as distant education or online education, Internet or Web-based training. It can also be used to take up short term courses with the course materials available online, attend virtual classes, learn and take examinations.

For example, Rwandan University students follow Stanford University’s free online courses known as Udacity.

(e) **Medicine**: Medical practitioners are using the Internet to update themselves on specific areas of interest and even take refresher courses to enhance their medical knowledge for better services. This has enhanced delivery of services in Rwanda hospitals.

A number of ICT health projects exist in Rwanda. An example is the OpenMRS. This is an open-source medical records system that facilitates nationwide tracking of patient data. There is also TRACnet. This is a system that allows central collection and storage of clinical health information. Another is the Mobile e-Health. This is a system that is used by community health workers to collect data for OpenMRS and TRACnet systems. There is also Telemedicine. This is a system that connects King Faisal Hospital to Hospitals in Kabgayi and Musanze. This assists in the sharing of clinical information between urban and rural hospitals. With the use of this system, ordinary citizens are able to receive hospital services remotely without physically travelling to Kigali.

(f) **Internet banking**: Bank customers access their accounts and carry out transactions through the Internet. Rwanda people are able to transfer money online from one account to another without necessarily having to physically visit their respective banks.

(g) **Entertainment**: Internet provides various forms of entertainment, for example, one can play games, watch online movies, upload and download entertainment materials such as music.
8.3.3 Methods /Ways of connecting to the Internet

Connecting to the Internet can be done using the following ways:

(i) Dial up

It involves connecting a computer to an Internet Service Provider (ISP) by use of a modem and telephone line such as a Subscriber Identity/ Identification Module (SIM) card, only when accessing the Internet. The connection is terminated once the user logs out from the Internet. Dial-up Internet connection is mostly used in rural or remote areas where broadband Internet access is not available. However, dial up Internet is potentially approaching extinction because of the advancements in wireless technology.

(ii) Broadband

This is a high capacity transmission technique that uses a wide range of frequencies to enable a large number of messages to be communicated simultaneously. Some examples of broadband are Wi-Fi, 4G and satellite among others.

(iii) Wi-Fi

Wi-fi stands for Wireless Fidelity. This is a wireless networking technology that uses radio waves to provide high-speed Internet and networking connections. Examples of Wi-Fi enabled devices includes laptops, cell phones, tablets, iPads, and peripheral devices such as the mouse, printers and keyboards among others. They communicate with a single computer which is fitted with a Wi-Fi adapter.

8.3.4 Getting online

Web browser

A web browser is a program that is used for displaying and viewing web pages on the World Wide Web (WWW).

Examples of web browsers are Mosaic, Netscape Navigator, Internet Explorer, Mozilla Firefox, Opera Mini, and Google Chrome among others.

![Icons for various web browsers](image-url)
Basic parts of a web browser

The following are basic parts of a browser window:

(a) **Menu bar** – It consists of a list of menus to choose from, for example, File, Edit, View, Tools, and Help.

(b) **Control buttons** – These buttons are found on the far right-side of the title bar of the search engine and include the following:
   - **Minimize**: It removes a web page window from a view to an icon on the taskbar.
   - **Restore Down**: It reduces the size of a web page window.
   - **Maximize**: It enlarges the web page window and fills up the screen.
   - **Close**: It exits the active window.

(c) **Address bar**: This is where an address (or name) is typed so as to go to a given web site page. An example of a web site address is [www.techrwanda.com](http://www.techrwanda.com).

(d) **Search text box**: This is where keywords are typed to describe the information that one wants to find.

(e) **Search button**: It is the command button clicked in order to initiate the search.

(f) **Search Query**: It is the information typed by the user to help the search engine decipher the required information.
Web Address

A website address is commonly known as Uniform Resource Locator (URL). It is a unique address of each web page in a websites which identifies the location of a specific web page on the Internet. The URL consists of three parts namely; protocol, server name and resource ID.

An example of URL is http://www.techrwanda.com

Explanation of the address

(i) **Protocol:** It is a set of rules that govern how data is transmitted in a network. There are many types of protocols used in a network.

   In an URL address, the protocol is shown at the beginning of the address then followed with a colon and double slashes. In our example the protocol is http (Hypertext Transfer Protocol).

(ii) **Server name:** It identifies the computer on which the resource is located. This computer is known as a remote server.

   Most web server names begin with the letters www, for example:

   www.techrwanda.com: The server name always ends with a dot and a three or two-letter extension called the domain name.

   The domain is important because it usually identifies the company, agency or organization that is directly responsible for the information, or is providing the computer space where the information is kept. Sometimes it indicates the country where the server is located.

   The Domain Name System (DNS) is a class or naming order system for computers, services, or any resources connected to the Internet or a private network.

   A top-level domain (TLD) is a domain at the highest level in the Domain Name System of the Internet. For example, in the domain name www.techrwanda.com, the top-level domain is com. Some common top level domain names are:

   .com which identifies company or commercial sites.

   .org for non-profit organization sites.

   .edu for educational sites.

   .gov for government agencies sites.

   .net for Internet service providers.

   .co for company.

   .ac for academic/educational institution.

   .mil for military organization.

   Examples of country domains include .rw for Rwanda, .ke for Kenya, .uk for United Kingdom,
.jp for Japan, .tz for Tanzania, .us for United States, .au for Australia, and .ca for Canada.

(iii) **Resource ID:** It identifies the file name and the folders or subfolders under which the webpage is stored on the remote server. An example of resource ID is `/index.php/icons/services`.

### Learning Activity 8.3

**Part 1**

1. Give a brief description of the Internet history.
2. Explain the application of the Internet in the following areas:
   - (a) Communication
   - (b) Research
   - (c) Education
3. Explain two ways in which one can get connected to the Internet.
4. Explain three basic parts of a web browser.
5. State the three main parts of a website address.

**Part 2**

Explore the Internet connection in your school. Identify the method of connection.

(i) Find out the web address of your school

(ii) Write the domain of your school.

### 8.4 Search Engines

#### 8.4.1 Definition of Search Engine

Search Engines are programs that help a user to look for and identify items that corresponds to keywords or phrases specified from the World Wide Web. Examples include; Yahoo, Google, Bing and Ask.com among others.

#### 8.4.2 Advantages and Disadvantages of Search Engines

**Advantages of search engines**

- They provide precise results.
- They have indexes representing important parts of the Internet which offer a wide range of information resources.
- They enable users to describe the information being searched.
- They enable users to locate and access information in different websites.
- They reduce the time taken to locate desired information.
- They provide a wealth of information for professional and personal use.

**Disadvantages of search engines**
• Tiresome and complex to search if the keyword typed is ambiguous. Many users get discouraged and frustrated because of the many links they have to search before getting the correct information.
• A lot of irrelevant information gets displayed after typing a keyword.
• A lot of distractions from advertisements that keep on popping up.
• A link to sites containing viruses could be displayed as a search result.

8.4.3 List of Search Engines

The following are some examples of search engines:
(a) Google  
(b) Google scholar  
(c) Yahoo!
(d) Bing  
(e) Ask.com  
(f) Wikipedia
(g) WiseGeek.com

8.4.3 Deciphering search results

Defining deciphering

Deciphering is the conversion of text written in code form into natural language. A search engine results page displays a lot of different information. In fact, one may not be aware of all the different types that appear. From vertical search engine results to related new stories, to suggested spellings, the results page offers all sorts of ways for one to dig dipper into a subject.

![Fig. 8.10: Search results on a search engine](image-url)
Procedure for deciphering search results

(i) Type your search query in the Search Box.

(ii) Click on the Search Button. The result is displayed with the following sections:

Search Box: The box where you type your search query. In this case it is “Use of ICT in Rwanda.”

Search Verticals: Links to the vertical search engines, the specialized ones that narrow your search into a specific type of result, such as news or images. Clicking one of these links takes you to a results page with only news or only images.

Page Count: The number of Web pages the search engine finds that match your search query in some way.

Time the Search took: How long the search engine took to retrieve your results.

Related Searches: Other topics that contain your query or other searches the search engine thinks might be relevant.

Images: Picture files that match your query. This comes from Images vertical engine. Clicking the link would take you to the vertical search results.

News Results: Any news results pertaining to your query or containing a keyword. These come from the vertical news engine. Clicking the link would take you to the news page.

Sponsored Links: These are paid advertisements (ads). Note how some of them...
relate to a specific geographical location near you. This is thanks to the local vertical search engine.

**Organic Results:** The listing results from a general search of Google’s index, with algorithms applied to determine relevance.

**Pagination:** Links to the additional pages of results.

**Disambiguation:** The “Did you mean . . . ?” suggestions that usually display after a misspelled search query or search queries that turned up very few results. It is the search engine’s way of trying to guess what you actually wanted. When the search query is spelt correctly, no disambiguation appears. You can test this feature for yourself by typing a mispelt query in Google.

(iii) Click on one of the options within the sections to access the web page.

### Learning Activity 8.4

#### Part 1

1. The interconnectivity of networks is known as ____________.
2. A host computer is also referred to as ____________.
3. ____________ is a collection of related web pages stored as a single file in a web server.
4. Hypertext and hypermedia documents containing information about an individual or organization is called ____________.
5. A computer that stores hypertext and hypermedia documents is known as ____________.
6. ____________ is a large virtual space of the internet where information pages called web pages are installed.
7. A website address is commonly known as ____________.

#### Part 2

1. Distinguish between a network and internet.
2. What are the uses of internet?
3. Define the term URL and identify its three parts.
4. Give an example of the URL.
5. Define the term search engine and identify three examples.
6. What is a web browser?
7. Give three examples of internet software browsers.
8. What is WiFi?
9. State two advantages of using a search engine.
10. Outline two disadvantages of search engines.

Part 3

- Apart from use of emails, social media is becoming very popular of late.
- Students can use it to share and exchange information and other contents to participate in the social networking.
- However, people have to be very careful with what they post or posted to them in the social media.
- Discuss how social media can be used negatively in a person’s potential future career seeking. Present your findings during group class discussions.
- In your discussion, cite examples you may have come across.
- Give examples of common social media platforms commonly used by your friends.

Part 4

Search for information on the following topics and do brief write-ups:
(i) The harmful effects of drug and substance abuse
(ii) The importance of conserving the environment
(iii) The dangers of engaging in premarital sex
(iv) The importance of maintaining peace in a country

8.5 Electronic Mail (E-Mail)

8.5.1 Definition of Email

E-Mail refers to a system of exchanging messages electronically over a computer network. The user must have an e-mail address in order to use e-mailing services.

8.5.2 E-mail address

The following is a sample format of an e-mail address:
username@hostcomputer.domainname

Explanation

- username: It identifies the owner of the e-mail address.
- @ (“at” sign): Separates the username from the rest of the address parts.
- hostcomputer: The name of the remote server on which the e-mail account is hosted. For example gmail, yahoo, and hotmail among others.
• .(dot): Separates the domain from the other part of the e-mail address.
• domain name: It identifies the type of institution offering the services. This has been discussed earlier in this book.
• For example, nkeza@gmail.com, nkeza is the username, gmail is the host computer and .com is the domain name for a commercial organization.

8.5.3 Advantages and Disadvantages of Email

Advantages of E-Mail

(i) It allows sending of one mail to many recipients at the same time.
(ii) It is cheaper compared to traditional mails.
(iii) It is fast and efficient as it allows instant sending and receiving mails from anywhere in the world.
(iv) E-mails can be saved for future retrieval in another computer.
(v) It is easier to reply and forward mails.
(vi) Allows sending and receiving of any form of information.

Disadvantages of E-Mails

(i) Use of email requires computer literacy to use.
(ii) E-mails are not accessible to everyone due to Internet connectivity problems.
(iii) There are security concerns. Hackers are able to gain authorised access to users’ accounts and, for example, solicit for money.
(iv) Allows spread of viruses such as hoax.

8.5.4 Creating an Email Account

Follow these steps:

(i) Open the e-mail application software. Then select Check Mail option. The Sign in dialog box is displayed.
(ii) Click Sign Up and follow the procedure provided in the application.

When creating a password for the account ensure that the password is strong enough. A strong password should have a minimum of 8 characters and should be a mixture of both letters, numbers and if possible symbols. Note that:

• Passwords are case sensitive.
• Always use a combination of characters that you can easily remember.
• Avoid using characters that can be guessed.
• Passwords are always encrypted for security purposes.
For example: To create a mail account in Gmail, the steps are as follows:

(i) Open Gmail application software.
(ii) Click Create an account link in the Sign in dialog box. This will open the sign up page as shown in figure 8.12.

![Fig. 8.12: A form to create an e-mail account in gmail](image)

(iii) Type the required information on the sign up page.
(iv) Finish by clicking on the check box “I agree to the Google’s Terms of Service and Privacy Policy”.
(v) Click Next Step button.

**Sending and Reading messages**

Before sending and reading a message, the user must open their account. The procedure of opening an account is referred to as Signing in.

**Sign In**

To sign in to an existing account do the following:

(i) Open the web browser software installed in the computer.
(ii) Open the e-mail application program to display the sign in window. A sample is shown in figure 8.13.
(iii) Type the e-mail address under User Name box and password under the Password box.
(iv) Click Sign in button to open the e-mail.
Receiving a message

Upon signing in, the user’s inbox is automatically opened. The messages are displayed in three columns showing the name of the sender, the subject and the Date/Time when the mail was sent.

To read a message, click on the Subject. Once the message is read the user can decide to select one of the following options available on the message window: Reply, Reply to All, Forward, Move and Delete among others.

- **Reply**: This option is selected if the user desires to respond to the read mail.
- **Reply to All**: This option is selected if the user desires to respond to all the addresses listed in the CC, BCC and To box. Both CC and BCC forward a copy of the message to everyone listed as a recipient. The difference between CC or Carbon Copy and BCC (Blind Carbon Copy) is that, with the latter, the recipients do not get to know each other.
- **Forward**: This option is selected if the user desires to send the same message to other e-mail addresses.
- **Delete**: This option is selected if the user desires to erase the mail. Note that deleting the message only sends it to the Trash folder. The user can retrieve the message from this folder if so desired.
- **Move**: This option is selected if the user wishes to remove the message from the Inbox folder and transfer it to another folder.
- To permanently delete the message, empty the trash folder.

Sending messages

The user can either compose a new message or send one that already exists in their inbox. Composing is the process of creating a new mail.
To compose a message do the following:

- Click on the **Compose** button in the e-mail account window. A dialog box appears.
- Click at **To** text box and type the e-mail address of the recipient.
  
  **Note:** To send the same message to a number of people the following options can be used:
  
  ✓ **Cc (Carbon Copy):** When this option is used, the list of all the recipients appears in each recipient’s mail.
  
  ✓ **Bcc (Blind Carbon Copy):** When this option is used, the list of all the recipients is hidden from the other recipients of the mail.
- Click at **Subject** text box to type the title that describes what the e-mail is about.
- Type the message in the body section.
  
  **Note:** E-mail text can be formatted the same way as in a Microsoft Word document using the formatting bar.
- Click **Send** button once the message is completed.

![Fig. 8.14: Composing a new mail](image)

**Organise email message**
The following are some of the ways of organising an Email.

**Move**

An email in the inbox can be transferred from the inbox to another folder. The following is the procedure for moving an email.

1. Select the emails to be stored in a folder by checking the box to the left of the email's name or thumbnail.
   
   **Note:** Multiple emails can be selected to be moved at once.

2. Move the emails into the folder by clicking the **Move to** button at the top of the email list and select the name of the folder from the drop-down menu.
   
   **Note:** If multiple emails have been selected, they will move together.

![Fig. 8.15: Moving an Email from one folder to another](image-url)

**Delete**

An email can be erased from the account using either of the following procedures:

- Click on the email and then click the **Delete** button.
- OR
- Right-click on the Email message and click **Delete** from the pop-up menu.
Add or switch folders

1. On the left side of the page, click More at the bottom of the labels list.
2. Click Create New Label.
3. Type the name of the new label and click Create.
4. Gmail does not use folders. Instead, it uses labels to help the user organize the mails more effectively.
Fig. 8.18: Gmail uses labels to help the user organise the mails effectively

Figure 8.19: Switching folders

Comparison between labels and folders

<table>
<thead>
<tr>
<th>Labels</th>
<th>Folders</th>
</tr>
</thead>
<tbody>
<tr>
<td>• A conversation can have more than one label.</td>
<td>• You can only put a message in one folder.</td>
</tr>
<tr>
<td>• A conversation can be in several locations (Inbox, All Mail, Sent Mail, etc.) at the same time, making it easier to find later.</td>
<td>• You have to remember where you filed a message to retrieve it.</td>
</tr>
<tr>
<td>• You can search conversations by label.</td>
<td>• You can’t always do folder-specific searches.</td>
</tr>
</tbody>
</table>

Address Book

It is an online contact manager used to store all contact information and it makes it easy to keep track of names, e-mail addresses, phone numbers, fax numbers and a lot more. It is possible to add a contact to the address book from an e-mail message.
To add names to the address book:
(i) Click on Add contact option. A dialog box is displayed.
(ii) Type the details of the contact requested.
(iii) Click Add on the dialog box. The window is automatically closed.

Using the address book
(i) Once a contact exists in the address book, when the user starts typing the e-mail address, a list of all the possible contacts that match it are displayed.
(ii) Select the desired contact.
(iii) Press the Enter key.

8.5.5 Uploading/Attaching a document to an e-mail

It is possible to attach one or more files to an e-mail address. The attachment could be a Microsoft Word document file, a spreadsheet, a sound file, a video file, or a picture file among others.

To attach a file do the following:
(i) Click on the Attach command button. A dialog box appears.
(ii) Select the file to be attached then click Open button. The attachment procedure begins.
(iii) Once the procedure is complete, click the Send button.

Note: Once a message is sent, a copy is stored in the Sent folder.

Downloading Information from Net

Downloading is the process of getting information from the Internet. This information can be viewed, backed up (saved) or printed. Any attachment sent in an e-mail needs to be downloaded.

To download a file, do the following:
(i) Click File on the page to be downloaded.
(ii) Select Save As option and follow the procedure for saving a document.

To print the page without saving, do the following
(i) Click File on the page to be downloaded.
(ii) Select the Print option and follow the procedure for printing a document.
<table>
<thead>
<tr>
<th>Learning Activity 8.5</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Part 1</strong></td>
</tr>
</tbody>
</table>
| 1. Define the following terms:  
   (a) E-mail  
   (b) Hyperlink  
   (c) Password  
2. State three advantages of using an e-mail.  
3. Define the term downloading.  
4. What is the role of an address book in an e-mail.  
5. State three characteristics of a strong password.  

<table>
<thead>
<tr>
<th><strong>Part 2</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Work in groups</td>
</tr>
</tbody>
</table>
| 1. Create email accounts with assistance from the teacher.  
2. Exchange emails among yourselves.  
3. Search the Internet for information on the effects of the Internet on Rwanda’s economy. Do a brief write-up.  

---

**Revision Exercise 8**

**Part 1**

1. _____________ is a system of exchanging messages electronically over a computer network.  
2. The format of an e-mail address has a number of items. List them.  
3. _____________ is the process of creating a new mail.  
4. Cc is short for _____________ while Bcc is the short for _____________.  
5. Give some examples of programs that enable a user to compose, send, archive, receive, format and forward emails.  
6. State some challenges that come with the use of emails.  
7. Explain the format of an email address.  
8. Differentiate between Cc and BCC.  
9. What are advantages of email over traditional mail.
By the end of this unit, you should be able to create a music sprite and add music with scratch and audacity.

**Keywords in the Unit**

<table>
<thead>
<tr>
<th>Sprite</th>
<th>Script</th>
<th>Blocks</th>
<th>Projects</th>
</tr>
</thead>
<tbody>
<tr>
<td>Animations</td>
<td>Costumes</td>
<td>Lists</td>
<td>Online</td>
</tr>
<tr>
<td>Offline</td>
<td>Menu</td>
<td>Hat</td>
<td>Thumbnails</td>
</tr>
<tr>
<td>Script area</td>
<td>Stop button</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### 9.1 Introduction

Scratch is a free programming language that allows creation of interactive games, animations, music and stories that can be shared around the world.

A sprite is an object that performs actions in a project. Most projects contain at least one sprite. Sprites can be created by the user in the paint editor that is part of the Scratch program or can be imported from external sources.

Scratch program was developed and is maintained by the *Lifelong Kindergarten group* at the Massachusetts Institute of Technology.

#### 9.1.1 Opening the Scratch Program

To open the Scratch program, do either of the following:

1. Click the **Start** button.
2. Select ![Scratch](image) from the resulting menu; or
3. Double-click on the Scratch shortcut icon from the computer desktop as shown in figure 9.1.

![Scratch](image)

*Fig. 9.1: Scratch shortcut icon*
The Scratch user interface window will be opened as shown in figure 9.2.

### 9.2 Scratch 2.0 User interface

By default, the Scratch user interface divides the screen into four main areas:

1. **Stage area**: It displays the sprite(s) and the results. It contains the View full screen button, project title and two script control buttons, that is, Green Flag and Stop buttons as shown in figure 9.3.

![Fig. 9.2: The Scratch user interface](image)

**Stage Area**

**Block Palettes**

**X, Y Position**

**Stage backdrop pane**

**Sprite List**

**New Sprite buttons**

**Scripts area**

![Fig. 9.3: Part of the stage area](image)

**View Full Screen button**

**Stop button**

**Project Title**

**Green Flag button**

207
• **View full screen**: Clicking on the button shown in figure 9.3 makes the stage area to cover the whole screen. The button changes and appears as shown in figure 9.4 (b).

![View full screen button after clicking](image)

**Fig. 9.4: View full screen button after clicking**

To restore to the previous view, click on the button again.

• **Project title**: This is the name of the project. It only appears after the project has been saved.

• **Green Flag**: This button is used for starting all scripts in a project that are hatted with the ‘**when Green Flag clicked**’ block.

• **Stop button**: Stops all scripts in all sprites.

2. **Sprite list**: It is located at the bottom left area of the Scratch window and displays sprites as thumbnails. Each thumbnail contains information about the selected sprite and tools for manipulating the sprite. Sprite information is accessed by clicking the blue button ![information icon](image) which displays the information and manipulation tools as shown in figure 9.5 below:

![Thumbnail displaying Sprite information and manipulation tools](image)

**Fig. 9.5: Thumbnail displaying Sprite information and manipulation tools**

To change the sprite’s name, simply click in the box labelled **Sprite1** and type the preferred name.

3. **Scripts Tab**: This tab contains the block palettes that are activated by clicking. It is located in the middle of the Scratch window and contains blocks that can be dragged onto the scripts area to make a project. Dragging a block from the **Block Palettes** makes a copy to follow the mouse until it is dropped where desired in the scripts area.
It is organized into 10 groups of block palettes, that is, Motion, Looks, Sound, Pen, Data, Events, Control, Sensing, Operators and More Blocks as shown in figure 9.6.

![Block Palettes](image)

Fig. 9.6: Block Palettes

<table>
<thead>
<tr>
<th>Learning Activity 9.1</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Insert bear 1-a from the Costume Library from the animal category and apply different colours on it.</td>
</tr>
<tr>
<td>2. Draw different shapes and fill them with colours of your choice.</td>
</tr>
<tr>
<td>3. Zoom the figure to 200%.</td>
</tr>
</tbody>
</table>

- **Motion blocks**: They are used to control how sprites move and change angles or direction.
- **Looks blocks**: They are used to control how sprites appear, for example, displaying thought bubbles or speech, changing sprite colour and making the sprite larger or smaller among others.
- **Sound blocks**: They are used to control sound and play audio files.
- **Pen blocks**: They are used to draw by controlling pen width, colour, and shade.
- **Data blocks**: They contain variable blocks and list blocks. The variable blocks are used to hold values and strings in variables as well as displaying them using stage monitors or watchers while list blocks are used to manipulate lists.
- **Events blocks**: They contain event handlers which are placed on top of each group of blocks to activate scripts to run.
- **Control blocks**: They are used to direct scripts, for example, *forever*, *if then*, *wait until* and *repeat until* among other conditions.
- **Sensing**: They are used to interact with the surrounding of a project.
• **Operators**: They contain mathematical operators and strings that compare sprite positions.
• **More Blocks**: They contain custom procedures (blocks) and extensions for the selected sprite. It includes Make a Block and Add an Extension buttons that allow the user to create more blocks.

4. **Scripts area**: It is located at the right side of the Scratch window and it is where blocks are combined to form scripts which in turn form a project.

Other tabs in Scratch user interface window include Costumes, Sounds, and Help.

(a) **Costumes tab**: This tab contains a list of costumes for the selected sprite. A costume is a frame or other appearance of the sprite. Sprites can change their appearance to any of their costumes. They can be created, named and edited in the Paint Editor and are commonly used in making animations for games or projects. Clicking on frame switches the sprite to the selected costume. It contains the name of the selected costume, costume as a thumbnail and tools to manipulate the costume as shown in figure 9.7.

![Costumes tab displaying Paint Editor](image)

**Fig. 9.7: Costumes tab displaying Paint Editor**
To add new costumes, click one of the following:

(i) **Giga button**. It opens the built-in costume library on sprites from which a costume can be chosen. Figure 9.8 shows part of the Costume Library.

![Costume Library](image)

**Fig. 9.8: Part of the Costume Library**

(ii) **Paintbrush button**. It opens the paint editor and is used to paint new costumes. Figure 9.9 shows Paint editor window.

![Paint editor window](image)

**Fig. 9.9: Paint editor window showing a new costume**
(iii) **Import/ Folder button**: It opens a file browser and is used to upload sprite or image from a file.

(iv) **Camera button**: It opens a camera and is used to create new costume from camera.

Three options are displayed when a costume thumbnail is Right-clicked, that is, Duplicate, Delete, and Save to Local File.

- **Duplicate**: Creates a copy of the costume.
- **Delete**: Erases the costume.
- **Save to Local File**: Saves the costume in any location as desired.

---

### Learning Activity 9.2

| (i) | Open the Scratch program. |
| (ii) | Click on the Giga button below the stage area. |
| (iii) | From the Things folder, add Sprites named **Bananas**, **Apples**, **Muffin** and **Oranges2**. |
| (iv) | Save the project as **Activity3a** on the desktop. |
| (v) | Click on the **Duplicate** button and click on each sprite to create a duplicate. The duplicate appears as a thumbnail at the sprite list but appears as one sprite at the stage area. |
| (vi) | Click on each sprite and drag the duplicate to the desired location at the stage area. |
| (vii) | Click on the **Delete** button then click on **Sprite1** either from the stage area or from the sprite list. The sprite is deleted. |
| (viii) | Save the changes as **Activity3b**. |
| (ix) | Click on the **Grow/ Shrink** buttons then randomly click on the sprites. The sprite increases or decreases in size. |
| (x) | Save the changes as **Activity3c**. |

---

(b) **Sounds tab**: This tab contains a list of audio clips and is used to insert sounds and music to a sprite. It contains the name of the selected sound and a speaker as a thumbnail. For example, the sound name in Figure 9.10 is **bird**.
To add new sound, click one of the following:

(i) **Speaker icon** : It opens the sounds library. Figure 9.11 shows a sound library.
(ii) **Record button** 🎧: It opens the sound recorder that enables sound to be recorded from an external device.

(iii) **Folder/Import button** 📁: It opens a file browser and is used to upload sound from file.

(c) **Help**: This is an expandable bar at the right side of the Scratch user interface window that contains tips on Scratch 2.0. It also displays Help information about a particular block.

To get information about a particular block:

- Right-click on it and click on the **Help** command that pops up.
- Click on the **Help** button. Its icon is a question mark 🎧 to expand.
- Click on the **Close** button 📁 to minimize. Figure 9.12 on page 213 shows the Help bar.
(d) **Stage backdrop pane:** The term backdrop refers to a frame or background of the stage. The backdrops pane is located at the bottom left, next to sprite list area. It is used to choose a backdrop from the library, paint new backdrop, upload backdrop from file and add new backdrop from camera.

**The Scratch Toolbar**

The toolbar appears at the top of the Scratch program window and is used to carry out very important functions.

The word “Scratch” appears on the left upper part of the window followed by an image of globe or sphere. Clicking on the globe displays a drop-down list with all the languages in Scratch, for example, English.

The toolbar also contains menu options, that is, File, Edit, Tips and About as shown in figure 9.13 on page 214:
Fig. 9.13: The Scratch Offline Editor Toolbar

(a) **File menu option**: Clicking on the drop-down arrow next to “File” displays the following menu options:
- **New**: Creates a new project.
- **Open**: Displays a dialog box that allows opening a project from file.
- **Save As and Save**: Discussed earlier in other programs.
- **Share to Website**: It is an online feature that allows sharing of a project onto the Scratch website.
- **Check for Updates**: It is an online feature that allows checking for updates for the offline editor.
- **Quit**: Exits the Scratch application.

(b) **Edit menu option**: Clicking on the drop-down arrow next to “Edit” displays the following menu options:
- **Undelete**: Cancels any deletion that had been recently performed.
- **Small stage layout**: Reduces the size of the stage area.
- **Turbo Mode**: Makes the code execution very fast.

(c) **Tips**: Opens the help area.

(d) **About**: It is an online feature that connects the user to the Scratch website.

*Other cursor tools on the toolbar include:*

- **Stamp Tool/ Duplicate button** 🎨**: It creates a copy of the selected sprite, script or any other selected project resource. To create a copy, click on the button and then click on the sprite, script or any other project resource.**
- **Delete button** 🗑**: It erases the selected sprite, script or any other selected project resource. To delete, click on the button and then click on the sprite, script or any other project resource.**
- **Grow button** 📦**: It increases the size of a sprite.**
- **Shrink button** 📦**: It decreases the size of a sprite.**
- **Block help button** 🧵**: Clicking this button and then clicking any scratch block opens a Help window that provides assistance focused on that block’s usage.
**Create/ Import a sprite**

Importing refers to the processes of transferring an existing image into a program. The user can import sprites, backdrops, sounds, projects, costumes, scripts, and lists among others.

**9.2.1 Create a new sprite or import the existing image**

There are four buttons used to create a new sprite or import an existing image, namely Giga button, paintbrush button, folder button and camera button. The buttons appear just above the Sprites area as shown in figure 9.14.

![Sprite creation buttons](image)

**Fig. 9.14: Sprites area of the Scratch user interface**

(a) The Giga button opens the built-in sprites and enables the user to choose a sprite from the library. To create a sprite using the Giga option, do the following:

(i) Click on the Giga button. A sprite library window appears as shown in figure 9.15.
(ii) Double-click on the desired sprite or select the desired sprite and click OK. The selected sprite appears on the stage area.

(b) The Paintbrush button opens the paint editor and is used to manually draw the sprite with colour tools provided by Scratch. Figure 9.16 shows a paint editor in a Scratch window.
The **Folder** button opens a file browser and is used to upload a sprite or image. Figure 9.17 shows a file browser. Select the location from where to upload the sprite, select the file name then click **Open**.

![File browser to upload sprite](image)

**Fig. 9.17: File browser to upload sprite**

The **Camera** button opens a camera which would be used to create a new sprite. A computer with a Web camera can be used to capture an image. When the **Camera** button in the Scratch program is clicked, the web camera is activated ready to capture a photograph. Figure 9.18 shows a computer with a web camera that can be used to capture images for use as sprites. A dialog box is displayed for saving the captured image.

![A web camera](image)

**Fig. 9.18: A web camera**
Learning Activity 9.3

1. Open Scratch program.
2. With the guidance of the teacher, draw and combine the various body parts to form a girl-like sprite as shown in figure 9.19(a).
3. Save the project as paint on the desktop.

In the Learning Activity 9.3 above, proceed as follows:

(i) Open Scratch program.
(ii) Paint a new sprite.
(iii) From the Drawing tools, click Ellipse tool. Clicking this tool displays hollow mode and solid mode ellipses next to the colour palette. Click on Hollow mode and draw three circles as shown in figure 9.3(a).

(iv) Click Solid mode and draw a little dark solid circle inside the medium circle to form the eye. Use the Eraser tool from the drawing tools to trim the smallest circle to form the ear as shown in figure 9.3(c).
(v) Use the Fill tool \( \text{ Fill } \) then choose the preferred colour from the colour palette and click on the largest circle to form the face.

(vi) Click the Duplicate tool button, select the eyeball to copy and drag the eyeball copy to make two eyes. Repeat the procedure for the ear to make two ears as shown in figure 9.19(d).

![Fig. 9.19(d): Using the Fill and Duplicate tools](image)

(vii) Use Select tool \( \text{ Select } \) button to do the following as shown in figure 9.19(e).

- Select and move the eyes to the face. Fill both eyes with white colour by clicking the Fill tool; choose the colour from the colour palette and click on the eyeball.

![Fig. 9.19(e): Using the Select tool](image)

- Select right ear and drag it to its position.
- Select the left ear and click Flip left-right \( \text{ Flip } \) button to flip it. Drag the right ear to its position.

(viii) Draw the mouth using the Erase tool \( \text{ Erase } \), other body parts and the dress using the Line tool \( \text{ Line } \).

![Fig. 9.19(e): Using the Select tool](image)
(ix) Fill the dress colour using the Fill tool as shown in Figure 9.19(f) shown below.

![Image of a sprite created using Paint Editor](image1)

**Fig. 9.19(f): Sprite created using Paint Editor**

### 9.2.2 Practical Activity: Using combo blocks to play sounds

Combo sprite blocks are formed by combining single sprite blocks. The default sound in the `play sound... until done` block is *meow*. In the activity below, we will learn how to play sounds using combo blocks. Proceed as follows:

(i) Click on **Sounds** tab to display the **Sound Library**. Select the preferred sound from the library or any other source.

![Image of the sounds tab and a combo block](image2)

**Fig. 9.20: The sounds tab**
(ii) Double-click the preferred sound or click on the sound then click OK. The selected sound appears as a thumbnail under Sounds tab or in the Play Sound Block under the Scripts tab.

(ii) To select any other sound, click the drop-down arrow in the play sound block as shown in figure 9.21.

(iii) Drag the blocks under the Sound tool kit and click the drop down arrow to select the sound. Figure 9.22 shows how you can combine sound combo blocks for playing the different sounds as follows:

- Playing the sound of a car passing until done.
- Playing a drum until done.
- Playing dance celebrate until done.
- Playing dance funky until done.

Fig. 9.22: Sound combo block
(iv) Click the Control Tool Kit, drag Forever block to enclose the Sound Blocks.
(v) Click the Events Tool Kit, drag the When () clicked to the top of Forever Block.
(vi) Click the Green Flag to play the sound.

Note: To play a script, the user can click on the Green flag button or on the script.

Learning Activity 9.4

Create a project named **combosound1** on the desktop that plays the following sounds **Forever** when the **Green Flag** button is clicked.

(i) Singer2  (ii) Singer1  (iii) Horse gallop  (iv) Ya

9.2.3 **Choose the sprite especially from the Things folder**

The Things folder refers to the folders in Scratch that contain Sprites. They can be created by the user and are also inbuilt. These folders ensure that Sprites are organised in groups.

The **Sprite Library** contains various folders with different names, for example, Letters, People, and Things among others. To choose a Sprite from the things folder:

(i) Click on the Giga button to open the sprite library.
(ii) Click on the Things folder to open. A window opens and displays the various items in the folder as shown in Figure 9.23.
(iii) Select the desired Sprite.

**Sprite Library**

<table>
<thead>
<tr>
<th>Category</th>
</tr>
</thead>
<tbody>
<tr>
<td>All</td>
</tr>
<tr>
<td>Animals</td>
</tr>
<tr>
<td>Fantasy</td>
</tr>
<tr>
<td>Letters</td>
</tr>
<tr>
<td>People</td>
</tr>
<tr>
<td>Things</td>
</tr>
<tr>
<td>Transportation</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Theme</th>
</tr>
</thead>
<tbody>
<tr>
<td>Castle</td>
</tr>
<tr>
<td>City</td>
</tr>
<tr>
<td>Flying</td>
</tr>
</tbody>
</table>

Apple  Arrow1  Arrow2
Basketball  Beachball  Bell

Fig. 9.23: Things folder
9.2.4 Manipulation of variables to program switch on and switch off

A variable is a changeable value that can only hold one value at a time. The value can be either a number or string (text). Variables enable one to see and manipulate numbers and text in the program.

It is created from the Data blocks on the Script Tab using the Make a Variable button. Clicking on this button displays the New Variable dialog box that enables the user to name the variable and specify its scope as shown in figure 9.24.

![New Variable dialog box](image)

Type the name of the variable

- For all sprites
- For this sprite only

OK Cancel

*Fig. 9.24: Creating a Global variable named score*

Types (Scope) of Variables

There are three types of variables in Scratch 2.0, namely local (private), global (public) and cloud.

(i) **Local Variable**: This is a variable that can only be changed by the sprite that owns it. It can be read by other sprites using the Change (by) block but they cannot change it.

For example: ![change block](image)

A local variable is created by selecting For this sprite only option button in the New Variable dialog box.

![New Variable dialog box](image)

Variable name: Variable

- For all sprites
- For this sprite only

OK Cancel

*Fig. 9.25: Creating a local variable*

(ii) **Global Variable**: This is a variable that can be read and changed by any sprite in
the project. By default, For all sprites option button is selected meaning that it is a global variable.

(iii) **Cloud Variable:** This is a variable that is stored in the cloud (on the Scratch server). It can be accessed by all users viewing the project shared on the Scratch website.

![Variable blocks](image)

**Fig. 9.26: Variable blocks**

- **Variable name block:** It contains the name of the variable (for example switch in figure 9.27) and shows or hides the variable’s monitor on the stage.
- **Set block:** It sets the variable to a specified value.
- **Change block:** It changes the variable by a specified amount either positive or negative.
- **Show variable block:** It shows the variable’s monitor on the stage while the script is running.
- **Hide variable block:** It makes the variable’s monitor invisible on the stage while the script is running.

To manipulate variables in order to program switch on and switch off, a virtual switch is created. A virtual switch is similar to a real switch with on and off buttons. The virtual
switch is simply a sprite and must provide two costumes, one to represent when switch is on, and the other to represent when the switch is off.

It works by combining blocks from different tool kits available in Scratch program and may be useful when making a project that has music or sound that can be stopped or muted.

**Example**

A sprite can be programmed such that clicking on it turns the switch on and off. Two costumes for the sprite are needed such that one costume represents on (1) and the other represents off (0). The switch is on when the music is playing and the switch is off when the music is off.

The following steps are followed when creating a Switch as shown in figure 9.26:

(i) Create a new sprite and add two costumes to the sprite. Costume1 represents on and Costume2 represents off.

(ii) Under Scripts tab click Data tool kit.

(iii) Click the Make a Variable button and name the variable as Switch.

(iv) This example uses blocks from six tool kits namely Sound, Looks, Data, Operators, Events and Control tool kits. Select and combine blocks from the tool kits to create the scripts in figure 9.28.

![Switch.png](image)

**Fig. 9.28: Switch that turns music on and off**

### 9.3 Create a tune using the Sound Tool Kit
The Sound toolkit is displayed by clicking on the Sound block under the Scripts tab. This tool kit is used to add a music script to a sprite.

**9.3.1 Practical Activity: Creating a tune using the sound kit**

In this practical activity, you will learn how to create a tune using the Sound Tool Kit. To add a music script to a sprite, do the following:

(i) Select the Sprite to which you want to add music.
(ii) Click the Sounds Tab block under Scripts tab.
(iii) Add the desired music using the blocks under the Sound block as shown in figure 9.29.

(iv) You could, for example, drag the block shown in figure 9.30 to the scripts area to...
play a soh-fa notation.

\[\text{Fig. 9.30: Keyboard Sol-fa Notation Do}\]

\[(v)\] Click the drop-down arrow on the block to display the keyboard.

\[(vi)\] To create a tune using the Sound tool kit that will play the tune is Do, Re, Mi, Fa, So, La, Ti, Do and pauses for 0.25 seconds between the notations, make a script combo block as shown in the figure below. Double click on the blocks to play the sounds.

\[\text{Fig. 9.31: Script block for the Sol-fa Notation}\]

\[(v)\] To add pause between notes, use the block that reads, “Rest for 0.2 beats.”
The script shown below plays the birthday bells sound in a sprite. The tune plays 3 times, rests for 1 beat between them, and reduces volume by -20% until it stops then resets volume to 100%.

9.3.2 Practical Activity: Creating a Sound Clip using Audacity

Audacity is a free, open source software that is used for recording and editing sounds. In Scratch, creating a sound clip or song using Sound Tool Kit can be time-consuming. The Audacity software provides the Scratch user with several features that can be used to create Scratch sound clips or songs. This program must be installed in the computer.
for it to be used.

The following activity gives you the steps to follow when creating a sound clip using Audacity.

To use the Audacity program, do the following:

(i) Open the Audacity program. The window shown in the figure below is displayed.

(ii) Start playing the preferred sound clip or song using any of the players on the computer.

(iii) Select **Stereo Recording**.

(iv) Click the **Record button** to start recording. This displays sound waves as shown in figure 9.35.

---

**Fig. 9.34: Audacity application window**

- **Recording volume**
- **Playback volume**
- **Record button**
- **Stereo Recording**
Fig. 9.35: Audacity window showing a wave

(v) Click the Stop button to stop recording.
(vi) To save the recorded sound clip or song, click File then select Export Audio. Save the file as type WAV, for example, RwandaNationalAnthem.wav.
(vii) To import the recorded sound clip or song to a sprite, select the Sounds tab and click Import button to upload sound from file. The block below shows a sound clip created using Audacity.

Fig. 9.36: A sound clip created using Audacity

9.3.3 Practical Activity: Creating a song using Sound Tool Kit (Practice)

To create a song, do the following:
(i) Click Sounds tab.
(ii) Create a new sound(s) as discussed under Sounds tab above.
(iii) The created sound is added to the play sound and play sound until done blocks.
(iv) Click on Scripts tab and select Sound.
(v) Drag play sound or play sound until done blocks into the scripts area.
(vi) Click the drop-down arrow on the block and select the preferred song.
Learning Activity 9.5

Open the Audacity program and carry out the following:
(i) Turn on Rwanda National Anthem using any of the players on the computer. If connected to the internet, play online streaming National Anthem.
(ii) Select (Stereo) Recording and Click the Record button to start recording.
(iii) Stop recording when through.
(iv) Save the recorded song as Anthem on the desktop.
(v) Import the recorded sound clip to a sprite so that it plays until done.

To achieve the expected result in Learning Activity 9.5, proceed as follows:
(i) Turn on Rwanda National Anthem using any of the players on the computer. If connected to the internet, play online streaming National Anthem.

![Wuje Imisozi Ibyaga n' Ibirunga](image)
Rwandan National Anthem With Lyrics - RWANDA NZIZA

Fig. 9.37: Online streaming of Rwandan National Anthem

(ii) Select (Stereo) Recording and Click the Record button to start recording.
(iii) Click Stop button when through.

(iv) Save the recorded song as Anthem on the desktop.

(v) Click Sounds tab and click Import button to upload sound from file.
Fig. 9.40: Uploading Anthem from Desktop

(vi) Clicking on Open uploads the anthem as shown in Figure 9.5(e) below:

Fig. 9.41: Recorded Anthem uploaded under Sounds tab
To import the recorded anthem to a sprite so that it plays until done:

- Click the Scripts tab and select the Sound toolkit.
- Click on the and drag it to the Scripts area.
- Click the block to play until done.

**Projects**

**Projects in Scratch and Music Sprite**

**Project 1: Happy Birthday Card Animation**

Use Sprite to create a birthday card for your friend.

Add animations to the card.

**Project 2: Emotion Faces**

1. Use Sprites to create a face that can show different emotions such as happy, sad, surprised, or other emotions you choose.
2. Use different sprites for the eyes, nose, eyebrows, and mouth.
3. Change movement and shape to convey emotion.

**Project 3: The Goal Keeper**

Create a sprite with the following requirements:

1. A soccer ball that falls down from the left side of the screen to the right side of the screen.
2. When Ball touches the edge of stage, a goal keeper catches it.

Ensure that the ball moves at a realistic speed in relation to gravity.

**Project 4: Growing Plants**

Create a sprite with the following requirements:

1. A Sprite that creates a stem, leaves and flowers when clicked.
2. Use Pen and colour change to create coloured flowers

**Project 5: Quiz**

Create a Sprite with the following requirements:

1. Choose a quiz topic (Examples: parts of a plant, Parts of the digestive system, vocabulary words, or any other topic that interests you)
2. Create a list of possible answers
3. Create a Sprite to “ask the question.”
4. Allow user to type in an answer.
5. Compare the user’s answer to question.
6. Provide user feedback to tell the user if they are correct or incorrect.

**Your Sprite must:**
1. Keep score of correct answers.
2. Give a final percentage of correct answers.
3. Use movement and sounds to make game entertaining.

**Project 6: Animation of a short story**

Create a Sprite with the following Requirements:
1. Select a short story.
2. Design Sprites that represent the characters in your story.
3. Use costume changes to simulate animation and movement.
4. Select musical sound clips for each characters. Record speaking parts for each character.
5. Use movement, hide, direction, and broadcast commands to animate a scene from the story.

**Revision Exercise 9**

1. Explain the four main areas in Scratch 2.0 user interface.
2. Define the following terms as used in Scratch programming.
   (a) Blocks  (b) Script  (c) Thumbnails.
   (d) Animations  (e) Backdrop
3. Explain the difference between the following terms:
   (a) Sprites and costumes;  (b) Variables and lists;
   (c) Local Variables and Global Variables.
4. State any four block palettes under the Scripts tab.
5. Identify any four blocks that are found in Sound tool kit.
6. Describe how you would change the amount of time Scratch waits between switching costumes.
7. Outline the procedure of creating a variable in Scratch 2.0
Alignment: It refers to the arrangement of text relative to the left or right margin of a page.

Animations: Animation is the process of displaying motionless images in a rapid sequence to create the appearance of movement. Examples of animations are cartoons on Televisions.

Applications: These are programs that are designed to perform specific task for the user.

Application software: They are programs that are designed to enable the user accomplish a given task.

ArcCatalog: This component organizes spatial data contained on the computer and various other locations and allows search, preview and addition of data to ArcMap as well as managing metadata and set up address locator services (geocoding).

ArcGIS: This is a geographic system designed to capture, store, manipulate, analyze, manage and present all types of geographically referenced data, that is, data identified according to their location.

ArcMap: This is the main mapping application that allows the creation of maps and query attributes. It also analyzes spatial relationships and layout of the final projects.

ArcToolbox: This is a Geographic Information System (GIS) component. It contains tools for Geoprocessing, data conversion, coordinate systems and projections among other functions.

Artificial Intelligence: It is the science of developing machines that mimic human behaviour such as reasoning, learning, hearing, seeing and communicating.

Attribute: This is a defined characteristic of a theme.

Autocomplete: It is a feature that enables phrases to be automatically completed on pressing the enter key, after they have been written midway.

AutoFormat: Refers to a range of predefined formatting templates.

Basemap: This is a map portraying background orientated information such as landforms, landmarks, roads and political boundaries, onto which other thematic information is placed.

Bitmap: A graphic image made up of many tiny dots.

Blocks: These are shapes that connect to each other and are used to create code. They determine how sprites interact with each other.
Blower: It is a portable electric device used to remove dust and dirt from computers.

Bookmark: This is an electronic marker in a map identifying the geography of the map for future reference or retrieval.

Break: It is inserted in order to demarcate the end of a part and beginning of another.

Broadband: This is a high capacity transmission technique that uses a wide range of frequencies to enable a large number of messages to be communicated simultaneously.

Bullets: They are small solid shapes used just before a line of text such as an item in a list. They are used to mark the beginning of a point.

Cache memory: This is a high speed storage location that enables the CPU to perform its functions faster.

Case: This is the representation of text in a document, lower or upper case. Other cases available are Capitalize Each Word, tOGGLE and Sentence cases.

Cc (Carbon Copy): This is used to send the same message to a number of people. When Cc is used, the list of all the recipients appears in each recipient’s mail.

Central Processing Unit: It is also known as a processor. It is commonly referred to as the “brain” of a computer system. The processor is a programmable device that controls the retrieval, interpretation and execution of instructions in a computer.

Clipboard: It is a temporary location for storing copied or cut data waiting to be pasted.

Columns: It is a feature that is used to divide content in a page into two or more columns.

Command: It is an instruction given for action to be taken. It represents an authorizing rule, power, or reason for some actions to be performed.

Computer Buses: These are a group of electronic wires that provide a path way through which bits of data are transmitted between the various computer components.

Computer laboratory: It is a special room set aside for safe installation and use of computer equipment.

Computer system: It is a collection of components that work together to process data and manage information in a computer in order to achieve a desired goal.

Connector: It is a part of a cable that plugs into a port or interface to connect two devices.

Costume: An image or visual representation that affects the appearance of a sprite. A sprite can be programmed to switch to a different costume to change its appearance.
CPU: Abbreviation for the Central Processing Unit. Also called the processor, and makes up the brain of a computer.

Customise: It refers to personalizing or modifying something to suit the user’s needs and tastes.

Customised software: They are tailor-made to solve a specific problem at hand or to meet a specific need of the user.

Data gathering: It is the systematic collection of data for a specific purpose from various sources.

Desktop computers: These are computers designed to be used while placed on top of a desk or a table.

Dialog box: This is a graphic interface which displays a section of the screen to be viewed. It gives the user several options to be choose from.

Distance Learning: It is also known as distance education. It is a mode of study where students do not physically attend learning centres.

Document: This is a written text, manuscript, paper, essay or article organized and saved as a file.

Drop cap: It is a large capital letter usually at the beginning of a block of text that has the depth of more than one line of regular text.

E-Business: Conducting business through the Internet.

E-Mail: This refers to a system of exchanging messages electronically over a computer network.

Edit: This is changing the content of a file.

File: It consists of a group of related records and is used for storing data in a secondary storage media. It is also called tables.

Fire extinguisher: It is a metallic cylinder usually red in colour containing a substance or agent that put out a small fire.

Firmware: These are software programs that are stored in computers Read Only Memory (ROM) where they are available for immediate use.

Font: It refers to the way text appear on the screen and when printed. It includes font type, style and size.

Footers: They are lines of text or graphics that appear below the bottom margin of a page or selected pages.

Formatting: It is the process of improving the appearance of a document to make it attractive and appealing to look at.
Geocoding: This is a GIS procedure for converting street addresses into spatial data that can be displayed as features on a map, usually by referencing address information from a street segment data layer.

Geodatabase: This is a collection of geographic datasets of various types held in a common file or folder such as Microsoft Access database, or a multiuser relational DBMS (such as Oracle, Microsoft SQL Server, PostgreSQL, Informix, or IBM DB2).

GIS: This is a system designed to capture, store, manipulate, analyze, manage and present all types of geographically referenced data, that is, data identified according to their location.

Hard disk: It consists of one or several inflexible circular disks called platters which are coated with a magnetic material normally Iron II Oxide.

Hardware: It is defined as any physical and tangible component of a computer which could either be mechanical, electrical or electronic.

Headers: They are lines of text or graphics that appear above the top margin of a page or selected pages.

Highlight: This is selecting text or object for the purposes of formatting and editing.

Indent: It is pushing text away from the margin.

Input: This is data entered in a computer for processing.

Input Devices: These are hardware components that are used to enter data and instructions into a computer.

Integrated software: These are software that combines several standard software into a package.

Internet: It stands for International Network. It is a worldwide network of computers connecting millions of computer networks through a combination of public and private communication lines such as telephone lines, wireless connection and fiber optic.

ISP: This is the abbreviation for Internet Service Provider. It is a licensed organization or company that provides access to the Internet usually at a fee.

Label: It is a heading which describes the content of a row or column.

LAN: This stands for Local Area Network. It covers a small geographical area for example, an office, a building, an institution, or an organization.

Landscape: This is where text and graphics are printed with the longest side placed horizontally and the shortest placed vertically.
**Laptop computers:** This is a portable computer that looks like a briefcase and has all input/output, processing and memory devices inside the system unit.

**Layer:** This is a method used to display geographic data sets in ArcMap with each layer pointing to a data set and specifying how the data set is represented using symbols and text labels.

**Layout:** This is a presentation or an outline which designates a design, or arrangement of data or information.

**Lists:** It is also known as an array in other programming languages. It refers to a variable that stores multiple pieces of information at once.

**MAN:** This stands for Metropolitan Area Network covers a city or town. It can be made up of many LANs and can provide Internet connectivity in a Metropolitan region.

**Menu:** It is a list of options or commands presented to the user of an application to help find information or execute a program function.

**Metadata:** This is part of an ArcGIS item. Whenever an item is copied in ArcGIS, its metadata also gets copied and when the item is imported into a geodatabase, its metadata is also imported. Metadata is stored in the same location as the item’s data in a manner that is appropriate for its data type.

**Microcomputers:** They are popularly known as Personal Computers (PCs) since they are designed to be used by one person at a time.

**Network:** is a set of interconnected computing nodes which communicate with one another through a transmission medium using a set of rules.

**Networking software:** It is system software that is used for configuration and enhancement of interactions in a computer network.

**Numbering:** This is the use of numbers to list different points. They may be set in Arabic or Roman.

**Offline:** Does not require Internet connection.

**Off-the-Shelf software:** They are software written by a software engineer or programmer, packaged and then made available through a vendor, distributor or the developer

**Online:** Requires Internet connection.

**OpenGL:** It is the computer industry standard Application Program Interface (API) that is used to define 2D and 3D graphic images. API interacts with a Graphics Processing Unit (GPU) to achieve hardware accelerated rendering.
**Operating System:** This is a group of programs that provide a platform for loading other programs known as application programs and act as an interface between the hardware and the application programs.

**Orientation:** This refers to the positioning of the page in relation to the text or graphics. There are two types of page orientation, namely landscape and portrait.

**Output:** It is the information produced after processing is complete.

**Output devices:** These are devices used for displaying data and information.

**Page margins:** They are the blank spaces around the edges of a page.

**Page numbering:** This is a formatting feature that organises a large document for ease of reference and makes it easy to track by inserting numbers beginning with the first page.

**Palmtop computers:** They are designed to fit in the palm of the user and easily fit in pockets.

**PAN:** It is also known as [Wireless Personal Area Network (WPAN)](https://en.wikipedia.org/wiki/Wireless_Personal_Area_Network). It is the smallest network used for data transmission among devices within the environment of an individual user.

**Pan:** This is to move an image horizontally or vertically from a stationary point in order to view from different angles.

**Password:** is a string of characters entered to log-in or sign-in so as to allow one get authentication.

**Peripheral devices:** They are computer components that are connected to the ports in the system unit through cables or wireless media.

**Port:** It is an interface on a computer on which a device can be connected.

**Portrait:** This is where text and graphics are printed with the longest side placed vertically and the shortest placed horizontally.

**Processing:** This is the conversion of data into information.

**Programs:** Also known as software. It is a collection of instructions that enable the computer to perform specific tasks or help the user to interact with a computer.

**Project:** This is a creation made in the Scratch Program. A project can be about anything, from music to animations, art, games, and simulations among others.

**Python:** This is the free, open-source scripting language that has been integrated with ArcGIS 10.
Query: This is a request that examines features or tabular attributes based on user-selected criteria and displays only those features or records that satisfy the given criteria.

Raster Data: These are items, usually images that are composed of pixels.

Register: They are temporary storage location found inside the processor that is used to hold data, instructions or information awaiting processing or output.

Screen: It is also known as the monitor or Visual Display Unit. It is an output device that displays information from the computer.

Script: A collection of connected blocks that perform a task.

Scrolling: It is the processes of moving around a document without changing the position of the cursor.

Search Engines: These are programs that help a user to look for and identify items that corresponds to keywords or phrases specified from the World Wide Web. Examples include; Yahoo, Google, WiseGeek, and Inforseek.

Server: Is a computer or device on a network that manages network resources.

Shapefiles: This is an Esri vector data storage format for storing the location, shape, and attributes of geographic features and it stores a set of related files.

Signals: It is an electrical impulse transmitted or received.

Software: It is a collection of instructions (programs) that enable the computer to perform specific tasks or help the user to interact with a computer.

Software: It is a set of instructions that either enable the computer hardware to perform their assigned tasks or help the user to accomplish specific tasks.

Sorting: Arranging data alphabetically or numerically in a descending or ascending order.

Spatial: These are features related to or existing within space.

Sprite: A sprite is an object that can be manipulated through a script to perform actions in a project. A project can contain multiple sprites that interact with one another. The default Sprite is a cat but it can be changed to a different sprite.

Storage: A computer can store a large amount of data within it. It has primary and secondary storage devices that are used for this purpose.

Storage Devices: These are devices that are used for storage of data, information and instructions.

Styles: They are specially packaged sets that apply many formats at once. They are available to the user for formatting the document.
Suite: A collection of programs with related functionality sold together as a package.

Surf/Browse: To surf or to browse is to view or access data from the Internet.

Telecommuting: Telecommuting is working from a remote location, usually one’s home by electronically linking to the workplace.

Thesaurus: This feature displays synonyms and antonyms of a selected word.

Thumbnail: An image of a large document or graphic that is reduced in size to allow multiple documents or images to be viewed on the screen at the same time.

TINs: This is a vector data structure that partitions graphic space into connecting non-overlapping triangles. They are used to store and display service models.

Toolbar: A strip with buttons and options used to carry out commands.

Toolbars: This is a graphical user interface (GUI) with buttons that allow users to execute software commands.

Track Changes: It is a feature that enables the user to view all the changes that have been made on a document.

URL: is an abbreviation for Uniform Resource Locator. It is a unique address of each web page in a website which identifies the location of a specific web page on the Internet.

Username: It is a name that identifies the owner of the e-mail address. It also refers to the identity one uses to log in to a computer network.

Utility software: They are system software that is used to perform routine functions aimed at optimizing, analysing and maintaining the operations of a computer.

Vector Data: These are drawings that represent features such as streets, rivers, railway lines, lakes, city blocks and any other feature that can be drawn on a map.

Virtual memory: It is the use of part of the hard disk as main memory for storing tasks from or to the processor.

WAN: This stands for a Wide Area Network. It interconnects LANs and MANs within a very large geographical area and may span across regions, country, continents or even the whole world.

Watermarks: They are text or pictures that appear behind text in a document.

Web browse: These are programs used for displaying and viewing web pages on the World Wide Web (WWW), for example, Mosaic, Netscape Navigator, Internet Explorer, Mozilla Firefox, Opera and Google Chrome amongst others. The web pages can be accessed using a web browser.
Webpage: It is Hypertext and hypermedia documents containing information about an individual or organisation.

Wi-Fi: is a wireless networking technology that uses radio waves to provide high-speed Internet and networking connections.

Windows Accessories: These are built-in programs found in Windows operating system, for example, calculator, notepad and paint among others.

Word Count: It is a feature that is used to count all characters, words, paragraphs and pages including textboxes, footnotes and endnotes.

WWW: It is commonly referred to as the Web. WWW refers to a large virtual space of the Internet where information pages called web pages are installed.
Detailed Index

Adding a comment, 138
Address Book, 201
Advantages of ICT, , 17
Analog data, 1
ArcCatalog: Data Management, 167
Arithmetic and Logic Unit (ALU), 24
Assistive Technology, 7
Audacity, 230
Background, 135
Basic Text Formatting, 111
Billing Machines, 12
Bookmarks in GIS, 165
Broadband, 189
Central Processing Unit (CPU), 24
Cloud Variable, 226
Columns and Breaks, 141
Comments, 138
Communication, 4
Components of ArcGIS, 153
Computer, 11
Computer Aided Assessment (CAA), 15
Computer Aided Instruction (CAI), 15
Computer Aided Learning (CAL), 14
Computer Components, 24
Computer Family, 52
Computer Network Concepts, 179
Computer Peripherals, 26
Computer Simulation, 15
Connecting to the Internet, 189
Control Unit (CU), 25
Copying text, 125
Create sprite, 115
Creating a Document, 107
Creating an Email Account, 197
Current use of ICT in Rwanda, 18
Data gathering, 3
Deciphering search results, 193
Definition of Data, 1
Deleting a comment, 139
Desktop, 70
Desktop background and theme, 78
Desktop Icons, 70
Desktop Icons and Gadgets, 79
Development of the Internet, 186
Dial up, 189
Digital data, 1
Disadvantages of ICT, , 17
Downloading documents, 204
Drop caps, 149
E-learning, 15
Electrical safety, 96
Electronic Mail (E-Mail), 196
Elements of Communication, 4
Find and Replace, 127
Finding Locations, 172
Fire Extinguisher, 98
Fire extinguishers, 97
Fire safety, 97
Flat screen monitors, 39
General safety, 94
Generations of Computers, 57
Geographic Information Systems, 152
Global Variable, 226
Hardcopy output devices, 35
Hardware, 24
Headers and footers, 150
Health safety, 95
History (Evolution) of Computers, 55
History of the Internet, 184
ICT (Information and Communication Technology), 8
ICT Equipment, 8
Impact printers, 35
Importance of ICT, 14
Import a sprite, 215
Information, 3
Information Technology (IT), 7
Interface of ArcMap, 156
Internet Concepts, 184
Keying Devices, 26
Layers in a Map, 175
Linear Referencing, 172
Local Area Network (LAN), 182
Local Variable, 225
Mainframe computers, 54
Maintenance precautions, 100
Manipulating a document, 131
Margins, 131
Medical Technology, 7
Memory Units, 25
Metropolitan Area Network (MAN), 183
Microcomputers, 52
Microsoft Word 2013, 103
Minicomputers, 54
Mobile Phones, 10
Mouse pointer, 79
Moving a text, 124
Ms Word 2013, 103
Nested lists, 147
Non-impact printers, 37
Non-verbal Communication, 5
Open an existing document, 109
Orientation, 132
Page borders, 133
Page Numbering, 150
Page Setup Group, 131
Personal Area Network (PAN), 181
Pointing Devices, 28
Ports and Connectors, 42
Projector, 13
Proofing features, 137
Query Methods, 171
Query Using Identify Tool, 172
Radio, 8
Random Access Memory (RAM), 46
Rasta data, 154
Read Only Memory (ROM), 46
Recycle bin, 75
Renaming a document, 109
Safe Lab Procedure, 94
Satellite, 12
Saving a Document, 108
Scratch 2.0 User interface, 206
Scratch Toolbar, 215
Screen Resolution, 81
Search Engines, 190
Software, 50
Sound Tool Kit, 228
Styles, 145
Stylus, 11
Supercomputers, 54
System tray/Notification area, 71
Tablet, 11
Technology, 6
Technology of Teaching, 6
Television, 9
Text Selection, 110
The Control Panel, 77
Things folder, 224
Track changes, 137
Types of Communicating, 5
Types of data, 1
Types of Networks, 181
Types of Technology, 6
Typing Modes, 126
Undo and Redo commands, 127
Uploading documents, 204
Use combo blocks to play sounds, 222
Use of ICT, 14
Vector Data, 154
Verbal communication, 5
Voice Input Devices, 34
Watermarks, 136
Ways of Communicating, 5
Web Address, 191
Web browser, 189
Wi-Fi, 189
Wide Area Network (WAN), 183
Word count, 139
Word Processing, 102